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In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions before performing 
the required procedures.

The data saved in the hard disk of the machine may be lost if there is any problem in the hard disk. Fuji Xerox is not responsible 
for any direct and indirect damages arising from or caused by such data loss.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer hacking.

IMPORTANT: 
1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied or modified in 

whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized operation can 
cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized operation of the equipment.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and Foreign Trade of 
Japan and/or the export control regulations of the United States.
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Preface
Thank you for purchasing the DocuPrint CM405 df.
This guide is intended for users who use the printer for the first time, and provides all the necessary operating 
information about the print, copy, scan, and fax functions.
Please read this guide to achieve the best performance from this printer.
This guide assumes you are familiar with computers and the basics of network operation and configuration.
After reading this guide, keep it safe and handy for future reference.

WARNING: 
This equipment will be inoperable when mains power fails.
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Types of Manuals

Manuals included with the printer
The following manuals are provided with the DocuPrint CM405 df.

Manuals included with an optional accessory
The following manual is provided with the optional accessories (sold separately).

Lifting Your Printer Describes how to lift and hold your printer.

Safety Guide Describes the information you need to know before using the printer and to operate the 
printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

Operator Panel Guide Describes the icons assigned to the buttons or indicators on the operator panel.

User Guide (this guide) Describes how to get ready to print and set various features. It also covers the operator 
panel menus, troubleshooting tips, and maintenance information.

This guide is on the Driver CD Kit.

Quick Reference Guide Describes how to operate the printer and the precautions that must be followed during 
operation.

This guide is on the Driver CD Kit.

PostScript User Guide Describes how to set up your printer as a PostScript® printer and the features that can 
be configured on your print driver.

This guide is on the PostScript Driver Library CD.

Installation Guide Optional accessories that require an installation at the customer's site are provided 
with an Installation Guide.
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Using This Guide
This section includes:

• "Organization" on page 14
• "Conventions" on page 14

Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

Conventions
1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 
• Important information that must be read and followed.

NOTE: 
• Additional information that merits emphasis.

See also: 
• References within this guide.

3 Orientation of paper is described in this guide as follows:
, , Long Edge Feed (LEF): Loading the paper in landscape orientation.

, , Short Edge Feed (SEF): Loading the paper in portrait orientation.

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, 
and the preparation of the printer to use.

3 Printer Management Software Describes the software available for the printer.

4 Printer Connection and Software 
Installation

Describes the basic information about how to connect the printer to your 
computer via the network or USB and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print data 
using various print features.

6 Copying Describes how to copy documents and the adjustment features.

7 Scanning Describes how to install a scan driver, and how to set and use the Scan 
features.

8 Faxing Describes how to set and use the Fax features.

9 Using the Operator Panel Menus and 
Keypad

Describes the setting items available on the operator panel, their setup 
procedures, and how to use the keyboard displayed on the LCD panel 
and number pad.

10Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

11 Maintenance Describes how to clean the printer, how to replace consumables, and how 
to see the printer status.

12Contacting Fuji Xerox Describes support information.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
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Safety Notes
Before using this product, read “Safety Notes” carefully for safety use.
This product and recommended supplies have been tested and found to comply with strict safety requirements 
including safety agency approvals and compliance with environmental standards. Follow the following instructions 
for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:
• Any unauthorized alteration including an addition of new functions or connection to external devices may 

not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or fatal injuries and 
the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal injuries.

Used for items that if not followed strictly, can cause injuries to user or damages to 
machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid any dangerous 
acts.

: A symbol for items that must be performed. Follow instructions carefully to carry 
out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Static 
Sensitive

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
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Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult your local 
power company to check if your power source meets the requirements.

 CAUTION

WARNING:
• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an earthed electrical 
outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an electrician to replace the outlet to 
avoid risk of electric shock. Never use an earthed adapter plug to connect the product to the electrical outlet 
that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire accident, do not 
use an extension cord, a multi-plug adaptor or a multiple connector. Consult your local Fuji Xerox 
representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated ampere and 
voltage of this product. See the data plate on the rear panel of this product for its rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring about minute 
electric current in a connector. It may generate heat and eventually cause a fire accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this product or the 
ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and eventually cause 
electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox representative for 
its replacement. Do not use a damaged or uninsulated cord to avoid the risk of electric shock and a fire 
accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior may cause 
electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live connector may 
deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause electric shock 
or a fire accident.
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Switch off and unplug the product when it (i.e., fax function) is not used over weekends or long holidays. 
Please note that it cannot receive fax message during switch-off.

Once a month, switch off this product and check if
• the power cord is plugged firmly into an electrical outlet;
• the plug is not excessively heated, rusted or bent;
• the plug and electrical outlet are free of dust; and
• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your local Fuji 
Xerox representative.
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Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or excessive 
pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:
• Near radiators or any other heat sources
• Near volatile flammable materials such as curtains
• In the hot, humid, dusty or poorly ventilated environment
• In the place receiving direct sunlight
• Near cookers or humidifiers

Never put this product close to fire such as candles and cigarettes. Otherwise, it may cause a fire accident.

This product weighs 32.0 Kg (the main unit with consumables). When moving it, always carry it by a team of 
three or more persons to avoid mishandling or injury.

When lifting this product, hold the handholds on both sides and the rear of the product by two people, and the 
front of the product by a person. Never lift it by gripping any other areas. It will prevent you from dropping the 
product and getting back ache or injuries.

Locate this product on a level and sturdy surface that can withstand a weight of 47.9 Kg. Otherwise, if tilted, 
the product may fall over and cause injuries.
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Others

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the product.

Keep the minimum clearance as follows for ventilation and an access to the power plug. Unplug the product if 
an abnormal condition is noted.

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause injuries.

Always lock the wheels of this product after installation. Otherwise, it may fall over or slide and cause injuries.

Always locate the output unit inside the rack under the scanning unit. 

To keep this product in a good performance and condition, always use it in the following environment: 
• Temperature: 10 – 32 °C
• Humidity: 10 – 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew condensation may 
form inside the product and cause a partial deletion on printing.

930 mm

880 mm

100 mm

320 mm

600 mm 528 mm 400 mm

600 mm 528 mm 400 mm

400 mm

430 mm

197 mm

197 mm 560 mm

Right Left Right Left

Front Back Front Back

10° 10°

10° 10°
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Operational Safety

 WARNING

 CAUTION

The operator's product maintenance procedures are described in the customer documentation supplied with 
this product. Do not carry out any other maintenance procedures not described in the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard areas are 
isolated from operators by covers or protectors which require a tool to remove. To prevent electric shock and 
injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product promptly in the 
following conditions, then contact your local Fuji Xerox representative.
• The product emits smoke or its surface is unusually hot.
• The product emits unusual noise or odor.
• The power cord is cracked or worn down.
• A circuit breaker, fuse or any other safety device becomes activated.
• Any liquid is spilled into the product.
• The product is soaked in water.
• Any part of the product is damaged.

Do not insert any object into slots or openings of this product. 
Do not put any of the followings on the product:
• Liquid container such as flower vases or coffee cups
• Metal parts such as staples or clips
• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When 
paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning materials 
may result in poor performance of the product. Never use aerosol cleaners to avoid catching fire and 
explosion.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM player. 
Otherwise, large sound may damage audio players or your ears.

Laser Safety
CAUTION: 
• Any operations or adjustments not stated in the operation manual may cause hazardous light 

exposure and eventually burn injuries or loss of eyesight.
This product has been tested and found to comply with the Class 1 Laser Equipment requirements defined by 
the international standard IEC60825 and has no light exposure hazard. The product has no hazardous light 
emission as it features light protection components and covers to shut in all light beam during operation and 
maintenance.

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the "High Temperature" or "High 
Voltage" marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from magnetic 
materials. Magnetic materials may accidentally activate the product and cause injuries or electric shock.

Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped around the 
fusing unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the product immediately and 
contact your local Fuji Xerox representative.
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Do not apply excessive force to hold thick document on the document glass. It may break the glass and cause 
injuries.

Ventilate well during extended operation or mass copying. It may affect the office air environment due to odor 
such as ozone in a poorly ventilated room. Provide proper ventilation to ensure the comfortable and safe 
environment.
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Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. It may catch 
fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large volume of toner, 
contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and cause 
burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for its 
disposal.

Never throw a waste toner bottle into an open flame. Toner may catch fire and cause burn injuries or 
explosion.

If you have a used waste toner bottle no longer needed, contact your local Fuji Xerox representative for its 
disposal.

CAUTION: RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT TYPE. DISPOSE OF 
USED BATTERIES ACCORDING TO THE INSTRUCTIONS.

Keep drum cartridges and toner cartridges out of the reach of children. If a child accidentally swallows toner, 
spit it out, rinse mouth with water, drink water and consult a physician immediately.

When replacing drum cartridges and toner cartridges, be careful not to spill the toner. In case of any toner 
spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until irritation is 
gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a physician 
immediately.
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Warning and Caution Labels
Be sure to follow the warning and caution labels placed on the machine. Do not touch areas with labels indicating 
high voltage or temperature. This can cause an electric shock or burn.

CAUTION:
• Always follow all warning instructions marked on or supplied with this product. To avoid the risk of burn injuries 

and electric shock, never touch the area with the "High Temperature" or "High Voltage" marks on.
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Environment
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 

drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges and drums (photoreceptors) no longer needed. Do not open 

toner cartridges and drums (photoreceptors). Return them to your local Fuji Xerox representative.
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Regulation

Radio Frequency Emissions (Class B)

Product Safety Certification (UL, CB)

This product is certified by the following agency using the safety standards listed.

Fax Regulations

General warning
The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item 
complies with minimum conditions for connection to its network. It indicates no endorsement of the product by 
Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work 
correctly in all respects with another item of Telepermitted equipment of a different make or model, nor does it imply 
that any product is compatible with all of Telecom’s network services Warnings taken from Specification text

Compliance testing (Functional tests)
"This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for which it 
is designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

Off-hook line impedance
"This equipment does not fully meet Telecom's impedance requirements. Performance limitations may occur when 
used in conjunction with some parts of the network. Telecom will accept no responsibility should difficulties arise in 
such circumstances"

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to the 
International Standard for Electromagnetic Interference (CISPR Publ. 22) and Radiocommunications Act 1992 
in Australia/New Zealand. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This product generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular installation. If 
this product does cause harmful interference to radio or television reception, which can be determined by 
turning this product off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

– Reorient or relocate the receiving antenna.
– Increase the separation between this product and the receiver.
– Connect this product into an outlet on a circuit different from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the user’s 
authority to operate this product.

Standard

IEC60950-1:ed. 2
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General requirements (automatic dialling devices)

User Instructions (automatic call set-up)
"This equipment shall not be set up to make automatic calls to the Telecom ‘111’ Emergency Service"

User instructions
If a charge for local calls is unacceptable, the ‘Dial’ button should NOT be used for local calls. Only the 7-digits of the 
local number should be dialled from your telephone. DO NOT dial the area code digit or the ‘0’ prefix
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About License

RSA BSAFE
This product includes RSA BSAFE® Cryptographic software from EMC Corporation.

DES
This product includes software developed by Eric Young.
(eay@mincom.oz.au)

AES
Copyright© 2003, Dr BrianGladman, Worcester, UK. All rights reserved. This product uses published AES software 
provided by Dr Brian Gladmanunder BSD licensing terms.

TIFF(libtiff)
LibTIFFCopyright© 1988-1997 SamLeffler
Copyright© 1991-1997 Silicon Graphics, Inc.

ICC Profile (Little cms)
LittlecmsCopyright© 1998-2004 Marti Maria

JPEG
Our printer software uses some of the codes defined by the Independent JPEG Group.
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Illegal Copies and Printouts
Copying or printing certain documents may be illegal in your country. Penalties of fines or imprisonment may be 
imposed on those found guilty. The following are examples of items that may be illegal to copy or print in your 
country. 

• Currency
• Banknotes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact 
your legal counsel.
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Product Features
This section describes the product features and indicates their links.

USB Direct Print

The Print From USB Memory feature allows you to print 
directly from your USB storage device without requiring 
you to start your computer and an application.

For more information, see "Direct Print Using the USB 
Storage Device" on page 163.

Stored Print

The Stored Print feature allows you to temporarily store 
your print data in the printer memory and output it later. 
You can effectively manage your time when you print 
confidential data or large-volume data at off-peak hours.

For more information, see "Using the Stored Print Feature" 
on page 160.

Pages Per Sheet (N-Up) Print

The Pages Per Sheet (N-Up) feature allows you to print 
multiple pages on a single sheet of paper. This feature 
helps reduce the paper consumption.

For more information, see the print driver's help.

2-in-1 Copy

You can copy two original pages onto one sheet of paper 
by selecting Pages Per Side on the operator panel when 
you make a copy. This feature helps save paper.

For more information, see "Pages Per Side" on page 208.

ID Card Copy

You can copy both sides of an ID card on one side of a 
single sheet of paper in its original size by selecting ID 
Card Copy on the operator panel. This feature helps to 
show both sides of an ID card in one page in its original 
size.

For more information, see "Using the ID Card Copy" on 
page 210.

Duplex Copy

You can copy documents on both sides of a sheet of paper 
by selecting 2 Sided Copying on the operator panel when 
you make a copy. This feature helps save paper.

For more information, see "2 Sided Copying" on page 204.
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Scan to E-mail

When you want to send scanned data by e-mail, use the 
Scan to E-mail feature. You can directly send the data 
scanned as an e-mail attachment. You can choose 
destination e-mail addresses from the address book on the 
printer or server. Or, you can enter the address using the 
keyboard displayed on the LCD panel.

For more information, see "Sending an E-Mail With the 
Scanned Image" on page 248.

Scan to SMB/FTP Server

You can transfer data scanned to a computer or a server 
via SMB or FTP without service software. Although prior 
registration of the destination FTP server or computer on 
the address book is required, it helps save your time.

For more information, see "Using a Scanner on the 
Network" on page 224.

Scanning to USB Storage Device

You don't need a computer to connect your USB storage 
device to save the scanned data. Insert your USB storage 
device in the port on the printer, and save the scanned 
data directly to your USB storage device.

For more information, see "Scanning to a USB Storage 
Device" on page 246.

Scan From Document Glass

You can scan the pages of a book or a brochure from the 
document glass. When you scan documents using the 
document glass, place them face down.

For more information, see "Making Copies From the 
Document Glass" on page 199.

Scan From DADF

You can scan pieces of unbound paper using the duplex 
automatic document feeder (DADF). When you scan 
documents using the DADF, load them face up.

For more information, see "Making Copies From the 
DADF" on page 201.

Direct Fax from Computer

You can directly send faxes from your computer using the 
fax driver. You can specify the fax settings like the normal 
fax. Also, you can specify the recipient's fax number using 
the number pad, or the address book.

For more information, see "Sending a Fax from the Driver 
(Direct Fax)" on page 269.
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Address Book

Address Book simplifies the recipient specification. You 
can use the address book on the printer as well as on the 
server. Select the desired address or fax number from the 
address book when using the Scan to E-mail or Scan to 
Network feature, or sending faxes.

For more information, see "Address Book Editor" on 
page 87.
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may change 
without prior notice.
This chapter includes:

• "Copy Function" on page 34
• "Print Function" on page 36
• "Scan Function" on page 37
• "Fax Function" on page 38
• "Direct Fax Function" on page 39
• "Duplex Automatic Document Feeder" on page 40
• "Duplex Output Unit" on page 41
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Copy Function

Type Desktop

Memory 512 MB (Maximum 1024 MB)

IMPORTANT: 
• Depending on the function, the optional 512 MB memory is required.

HDD Optional: 160 GB or larger

IMPORTANT: 
• Depending on the function, the optional hard disk unit is required.

Color Capability Full color

Scanning Resolution 600 × 600 dpi

Printing Resolution 600 × 600 dpi, 1,200 × 1,200 dpi (half speed)

Halftone/Printable Colors 256 color gradation for each color (16,700,000 colors)

Warm-up Time 19.9 seconds or less*
*: The values are based on a room temperature of 20 °C and on the factory default setting.

IMPORTANT: 
• It may take longer due to the image quality adjustment.

Original Paper Size Books: Maximum 215.9 × 297 mm (A4)

Sheets: Maximum 215.9 × 355.6 mm (Legal, when the duplex automatic document 
feeder (DADF) is used)

Output Paper Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Minimum: 3 × 5", 76.2 × 127 mm

Image loss width: Top edge, 4.1 mm or less; bottom edge, 4.1 mm or less; 
left and right edges, 4.1 mm or less

Output Paper Weight 60 – 216 gsm

IMPORTANT: 
• Use paper recommended by Fuji Xerox. Copying may not be performed correctly 

depending on the conditions.

First Copy Output Time Color: 20 seconds or less (for A4 /color priority mode)

Monochrome: 16 seconds or less (for A4 /monochrome priority mode)

Reduction/Enlargement Preset %: 1:0.50, 1:0.70, 1:0.81, 1:1.00, 1:1.22, 1:1.41, 1:2.00

Variable %: 1:0.25 - 1:4.00 (1% increments)

Continuous Copy Speed Monochrome:
A4: 35 or more sheets/minute

Color:
A4: 35 or more sheets/minute

IMPORTANT: 
• The speed may be reduced due to image quality adjustment.
• The performance may be reduced depending on the paper type.

Paper Tray Capacity Standard:
550 sheets (Standard 550 Sheet Tray) + 150 sheets (Bypass Tray)

Optional:
550 sheets (Optional 550 Sheet Feeder)

Maximum paper capacity:
1250 sheets (standard + Optional 550 Sheet Feeder)

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Continuous Copy 99 images

NOTE: 
• The machine may pause temporarily to perform image quality adjustment.



Specifications 35

Output Tray Capacity Approximately 250 sheets (A4 )

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Power Supply AC 110 - 127 V ± 10%; 12 A or less; both 50/60 Hz ± 3%

AC 220 - 240 V ± 10%; 6 A or less; both 50/60 Hz ± 3%

Power Consumption Maximum power consumption:
1390 W or less

Running mode:
750 W (Average)

Ready:
82 W (Average)

Low Power mode:
19.5 W or less 

Sleep mode:
6.0 W or less

Dimensions Width 430 × Depth 528 × Height 560 mm

Machine Weight 32 kg

IMPORTANT: 
• The weight of paper is not included.
• The weight of the consumables is included.

Space Requirement Width 930 × Depth 1528 mm
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Print Function

Type Built-in

Continuous Print Speed Same as the Copy Function

IMPORTANT: 
• The speed may be reduced due to image quality adjustment.
• The performance may be reduced depending on the paper type.

Print Resolution Output resolution: 600 × 600 dpi, 1,200 × 1,200 dpi

PDL PCL 6, PostScript® 3™, FX-PDF, TIFF, JPEG

Protocol TCP/IP (LPD, Port9100, WSD, HTTP, HTTPS, SMTP, RARP, AutoIP, WINS, FTP, 
Telnet, DNS, DDNS, IPP, IPPS, SNTP, SMB), SNMP, DHCP, BOOTP, Bonjour® 
(mDNS)

NOTE: 
• To use IPPS protocol, you need to install the optional hard disk unit.
• WSD stands for Web Services on Devices.
• WSD is available only on Windows Vista®, Windows Server® 2008, Windows® 7, 

Windows Server® 2008 R2, Windows® 8 or Windows Server® 2012.

Operating System Standard: PCL 6 and PostScript® drivers
Microsoft® Windows® XP x86,
Microsoft® Windows Server® 2003 x86,
Microsoft® Windows Vista® x86,
Microsoft® Windows Server® 2008 x86,
Microsoft® Windows® 7 x86,
Microsoft® Windows® 8 x86,
Microsoft® Windows® XP x64,
Microsoft® Windows Server® 2003 x64,
Microsoft® Windows Vista® x64,
Microsoft® Windows Server® 2008 x64,
Microsoft® Windows® 7 x64,
Microsoft® Windows Server® 2008 R2 x64,
Microsoft® Windows® 8 x64,
Microsoft® Windows Server® 2012,
Mac OS® X 10.3.9
Mac OS® X 10.4
Mac OS® X 10.5
Mac OS® X 10.6
Mac OS® X 10.7
Mac OS® X 10.8
Red Hat® Enterprise Linux® 5 Desktop x86
Red Hat® Enterprise Linux® 6 Desktop x86
SUSE® Linux Enterprise Desktop 10 x86
SUSE® Linux Enterprise Desktop 11 x86

IMPORTANT: 
• For information about the latest supported OS, contact your local Fuji Xerox 

representative.

Fonts Built-in fonts

PCL 5 and PCL 6 fonts: 81 fonts and 36 symbol sets

PostScript® 3™: 136 fonts

PDF Font: 14 fonts

Connectivity Standard: Ethernet (1000BASE-T/100BASE-TX/10BASE-T), USB 2.0

Optional: IEEE802.11 b/g/n
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Scan Function

Type Color scanner

Original Paper Size Same as the Copy Function

Scanning Resolution 200/300/400/600 dpi

TWAIN: 50 to 9600 dpi

WIA: 75/100/150/200/300/400/600 dpi

Scanning Halftone Color: 16 bit × 3 ch (R/G/B)

Monochrome: 16 bit × 2 ch (CDD/EVEN)

Scanning Speed Color: 8 sheets/minute

Monochrome: 16 sheets/minute

IMPORTANT: 
• The scanning speed varies depending on documents.

Connectivity Standard: Ethernet (1000BASE-T/100BASE-TX/10BASE-T), USB 2.0

Optional: IEEE802.11 b/g/n

Scan to PC Protocol: TCP/IP (SMB, FTP)

Operating System:
Microsoft® Windows® XP x86
Microsoft® Windows Vista® x86
Microsoft® Windows Server® 2003 x86
Microsoft® Windows Server® 2008 x86
Microsoft® Windows® 7 x86
Microsoft® Windows® 8 x86
Microsoft® Windows® XP x64
Microsoft® Windows Vista® x64
Microsoft® Windows Server® 2003 x64
Microsoft® Windows Server® 2008 x64
Microsoft® Windows Server® 2008 R2 x64
Microsoft® Windows® 7 x64
Microsoft® Windows® 8 x64
Microsoft® Windows Server® 2012
Mac OS® X 10.3.9
Mac OS® X 10.4
Mac OS® X 10.5
Mac OS® X 10.6
Mac OS® X 10.7
Mac OS® X 10.8

IMPORTANT: 
• For information about the latest supported OS, refer to the Fuji Xerox Web site.

File Format:
PDF / JPEG (JFIF format) / TIFF (multi page 1 file) / TIFF (1 page 1 file) / XDW

Scan to E-mail Protocol: TCP/IP (SMTP, POP3)

File Format:
PDF / JPEG (JFIF format) / TIFF (multi page 1 file) / TIFF (1 page 1 file) / XDW
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Fax Function

Send Document Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Recording Paper Size Maximum: Legal

Minimum: A5

Transmission Time 2 seconds or less

IMPORTANT: 
• When transmitting an A4 size 700-character document in the standard quality (8 

x 3.85 lines/mm) and high speed mode (33.6 kbps or above: JBIG). This is only 
the transmission speed for image information and does not include the controlling 
time for the communication. Note that the actual transmission time depends on 
the content of documents, the machine that the recipient uses, and the status of 
the communication line.

Transmission Mode ITU-T Super G3, ITU-T G3 ECM, ITU-T G3

Scanning Resolution Standard: 200 × 100 pixel/25.4 mm (R8 × 3.85 line/mm)

Fine/Photo: 200 × 200 pixel/25.4 mm (R8 × 7.7 line/mm)

Super Fine: 400 × 400 pixel/25.4 mm (R16 × 15.4 line/mm)

Coding Method Color: Not supported.

Monochrome: 1bit, JBIG, MMR, MR, MH encoding

Transmission Speed V.34 (33.6/31.2/28.8/26.4/24/21.6/19.2/16.8/14.4/12/9.6/7.2/4.8/2.4 kbps)

V.17 (14.4/12/9.6/7.2 kbps)

V.29 (9.6/7.2 kbps)

V.27ter (4.8/2.4 kbps)

No. of Fax Lines PSTN, PBX, Leased line (3.4 kHz/2-wire)
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Direct Fax Function

Document Size A4, Letter, Folio (8.5 × 13"), Legal (8.5 × 14")

Scanning Resolution Same as the Fax Function

Transmission Speed Same as the Fax Function

Applicable Lines Same as the Fax Function

Operating System Microsoft® Windows® XP x86

Microsoft® Windows Server® 2003 x86

Microsoft® Windows Vista® x86

Microsoft® Windows Server® 2008 x86

Microsoft® Windows® 7 x86

Microsoft® Windows® 8 x86

Microsoft® Windows® XP x64

Microsoft® Windows Server® 2003 x64

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x64

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x64

Microsoft® Windows® 8 x64

Microsoft® Windows Server® 2012

Mac OS® X 10.3.9

Mac OS® X 10.4

Mac OS® X 10.5

Mac OS® X 10.6

Mac OS® X 10.7

Mac OS® X 10.8

IMPORTANT: 
• For information about the latest supported OS, refer to the Fuji Xerox Web site.
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Duplex Automatic Document Feeder

Type Duplex automatic document feeder

Original Paper Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Minimum: 5.5 × 5.5", 139.7 × 139.7 mm

Capacity 50 sheets (A4  1 sided)

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Feeding Speed When copying multiple sets of copies of single-sheet document:
Color: 35 sheets/minute (A4  1 sided)
Monochrome: 35 sheets/minute (A4  1 sided)

When copying one set of copies of multiple-sheet document:
Color 1 Sided: 13 sheets/minute; 2 Sided: 4 pages/minute (A4 )
Monochrome 1 Sided: 22 sheets/minute; 2 Sided: 7 pages/minute (A4 )
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Duplex Output Unit

Applicable Paper Size Maximum: Legal (8.5 × 14"), 215.9 × 355.6 mm

Minimum: A5, 148 × 210 mm

Paper Weight 64 - 163 gsm
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2
Basic Operation

This chapter includes:
• "Main Components" on page 44
• "Installing Optional Accessories" on page 49
• "Turning on the Printer" on page 78
• "Setting Initial Settings on the Operator Panel" on page 79
• "Printing a Panel Settings Page" on page 80
• "Power Saver Mode" on page 81
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Main Components
This section provides an overview of your printer.
This section includes:

• "Front View" on page 44
• "Rear View" on page 45
• "Duplex Automatic Document Feeder (DADF)" on page 45
• "Operator Panel" on page 46

Front View

IMPORTANT: 
• To avoid irregular screen image or malfunctioning of your printer, avoid placing the printer in direct sunlight with the bypass 

tray opened.

1 Duplex Automatic Document Feeder 
(DADF)

7 Optional 550 Sheet Feeder (Tray2)

2 Belt Unit 8 Standard 550 Sheet Tray (Tray1)

3 Drum Cartridge 9 Bypass Tray

4 Waste Toner Box 10 Toner Cartridge

5 Side Cover 11 Front Cover

6 Power Switch 12 Operator Panel

112

4

6 5

2

3

9 8 71011
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Rear View

Duplex Automatic Document Feeder (DADF)

1 Control Board 7 Wall Jack Connector

2 Control Board Cover 8 Duplexer

3 Ethernet Port 9 2nd BTR

4 USB Port 10 Fusing Unit

5 Wireless Adapter Socket 11 Power Connector

6 Phone Connector 12 Rear Cover

1 DADF Cover 5 Document Feeder Tray

2 Document Guides 6 Document Stopper

3 DADF Glass 7 Front USB Port

4 Document Glass 8 DADF Feed Roller

1

2

3

4

5

6

7

8

9

10

11

12

18

2

4

5

7

3

6
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Operator Panel
The operator panel has a LCD panel, light-emitting diodes (LED), control buttons, and number pad, which allow you 
to control the printer.

1  (Services) button
• Moves to the top service screen.

2 LCD Panel
• Specifies the settings by directly touching the screen.
• Displays various settings, instructions, and error messages.

3 Number Pad
• Enters numbers.

4 CA (Clear All) button
• Resets the current setting, and returns to the top level of each menu.

5  (Wake Up) button
• Lights up in the Power Saver mode. Press this button to exit the Power Saver mode.

6  (Stop) button
• Cancels the current processing or pending job.

7  (Start) button
• Starts a job.

8  (Error) LED
• Lights up when the printer has an error.

9  (Data) LED
• Flashes when data for Fax, Scan, Print job, or Stored job is being received.

10 C (Clear) button
• Deletes characters and numbers.

11  (Redial / Pause) button
• Re-dials a telephone number.
• Inserts a pause during dialing.

1 2 3 5

6

4

78910111213
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12  (System) button
• Moves to the top level of the System menu.

13  (Job Status) button
• Moves to the top level of the Job Status menu.

NOTE: 
• Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to save the 

current entry or setting.
• For details on how to use the number pad to enter numbers, see "Using the Number Pad" on page 354.

Touch Panel - Top Service Menu Screen
This section describes the fields and buttons on the top service screen which is displayed by pressing the  
(Services) button. This is the default screen that appears when the printer is turned on.

• Message Field
Displays the printer status, error message, and IP address assigned to the printer.

• Toner Status Icon
Displays the condition of toner in 6 levels. (The toner level for each color: 100%, 80%, 60%, 40%, 20%, 0%) 
Selecting this icon moves to the Supplies tab.

• Wireless LAN Connection Status Icon
Displays the intensity of wireless signal when the wireless printer adapter is connected to the printer.

• Function Buttons
Allows you to set the features for functions such as Copy, E-mail, Scan To, Fax, Print from, and ID 
Card Copy.

NOTE: 
• If the Panel Lock setting for a function is set to Enable, the function is disabled and the menu for the function does not 

appear on the screen. For details, see "Enabling the Panel Lock" on page 348.

• Copy
You can set the features for the Copy function.

See also: 
• "Copying" on page 195

• E-mail
You can scan documents and send the scanned data as an e-mail attachment.

See also: 
• "Sending an E-Mail With the Scanned Image" on page 248

Message Field

Function Buttons

Wireless LAN Connection
Status Icon

Toner Status Icon
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• Scan To
You can set the features for the Scan To function.

See also: 
• "Scanning" on page 213

• Fax
You can set the features for the Fax function.

See also: 
• "Faxing" on page 257

• Print from
You can set the features for the Print from function.

See also: 
• "Printing" on page 158

• ID Card Copy
You can set the features for the ID Card Copy function.

See also: 
• "Using the ID Card Copy" on page 210
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Installing Optional Accessories
You can make the printer more functional by installing the optional accessories such as the 512MB Memory, the 550 
sheet feeder, Cabinet, Wireless Network Kit b/g/n, and the hard disk unit. This section describes how to install these 
printer's options.
This section includes:

• "Installing the Optional 512MB Memory" on page 49
• "Installing the Optional 550 Sheet Feeder and the Cabinet" on page 54
• "Installing the Optional 550 Sheet Feeder (without the Cabinet)" on page 64
• "Installing the Optional Wireless Printer Adapter" on page 68
• "Installing the Optional Hard Disk Unit" on page 73

Installing the Optional 512MB Memory
NOTE: 
• Your printer supports additional 512 MB memory module.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 
• Loosen the screw. You do not need to remove the screw.
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3 Slide the control board cover towards the rear of the printer.

4 Open the control board cover completely.

5 Hold the edge of the memory module with the labeled side down and the connector toward the control board, 
and then insert it into the slot.

6 Push the memory module firmly into the slot.

NOTE: 
• Ensure that the memory module is firmly fixed in the slot and does not move easily.
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7 Close the control board cover, and slide it towards the front of the printer.

8 Turn the screw clockwise.

9 Turn on the printer.

10 Print the System Settings page to confirm that the newly installed memory module is detected by the printer.
a Press the  (System) button.
b Select Report / List.
c Select System Settings.
d Select Print.

The System Settings page is printed.

11 Confirm the amount of Memory Capacity listed under General in the System Settings page.
If the memory capacity has not increased, turn off the printer, unplug the power cord, and re-install the memory 
module.

12 If you installed the optional 512MB memory after installing the print driver, update your driver by following the 
instructions for the operating system you are using. If the printer is on a network, update the driver for each 
client.
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Updating Your Driver to Detect Optional 512MB Memory
The following procedure uses Microsoft® Windows® and the PCL 6/PS driver.

NOTE: 
• When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select RAM Disk in the Items list box.

3 Select Installed in the RAM Disk drop-down menu under Setting for.

4 Select Memory Capacity in the Items list box.

5 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu under 
Setting for.

6 Click OK.

Windows 8/
Windows 8 x64/
Windows Server® 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then 
click Control Panel → Hardware and Sound (Hardware for Windows Server 
2012) → Devices and Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Printer 
properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows 7/
Windows 7 x64/
Windows Server 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Printer 
properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista®/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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7 Click Apply, and then click OK.

8 Close the Devices and Printers (, Printers, or Printers and Faxes) dialog box.
The following procedure uses Mac OS® X and the PS driver.

Mac OS X 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 
Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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Installing the Optional 550 Sheet Feeder and the Cabinet
IMPORTANT: 
• If you install the optional 550 sheet feeder and the cabinet after setting up the printer, be sure to turn off the printer, unplug the 

power cord, and disconnect all cables from the rear of the printer before installing the feeder and the cabinet.

1 Lock the two caster stoppers at the front of the cabinet.

2 Attach the four feet to the cabinet by inserting feet into the slots until they lock into position.
Make sure that all four feet are firmly inserted into the slots, and that they do not fall off. If these feet are not 
inserted properly, they do not stay inserted firmly, or they do not lock into position.

3 Turn the dials of the four feet to the clockwise direction until the bottom of the feet have contact with the floor.

CAUTION:
• Always lock the wheels of this product after installation. Otherwise, it may fall over or slide and cause injuries.
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4 Remove the tape and the bag holding the screws on the front of the optional 550 sheet feeder, and then 
remove the screws from the bag.

5 Hold the optional 550 sheet feeder with one hand, and remove the tray from the feeder with the other hand.

6 Attach the two pins "Pin A" to holes "A" on the cabinet.

NOTE: 
• Use holes "A" for this product. Holes "B" are for other products.
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7 Lift the optional 550 sheet feeder and align the two pins of the cabinet with the holes at the bottom of the 
feeder. Gently lower the optional 550 sheet feeder onto the cabinet.

IMPORTANT: 
• Be careful not to pinch your fingers when lowering the optional 550 sheet feeder onto the cabinet.

8 Secure the optional 550 sheet feeder to the cabinet by tightening the two screws provided with the cabinet, with 
a coin or similar object.

9 Insert the tray into the optional 550 sheet feeder, and push until it stops.
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10 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

11 Disconnect all cables from the rear of the printer.

12 Pull the standard 550 sheet tray out of the printer about 200 mm.
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13 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

14 Lift the printer and align the five guide pins of the optional 550 sheet feeder with the holes at the bottom of the 
printer. Gently lower the printer onto the optional 550 sheet feeder.

IMPORTANT: 
• When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18.
• Be careful not to pinch your fingers when lowering the printer onto the optional 550 sheet feeder.
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15 Secure the optional 550 sheet feeder to the printer by tightening the two screws provided with the feeder, with a 
coin or similar object.

NOTE: 
• The screw hole is located in 216 mm recess from the front of the printer.

16 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or inside of the printer.

17 Attach the cable hook on the cabinet using the two screws provided with the cabinet.
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18 Re-connect the power cord to the power connector on the rear of the printer, and wind the power cord onto the 
cable hook.

19 Lightly pull the power cord to take up the slack of the cable.

20 Connect the other end of the power cord into the power source.

21 Connect other cables into the rear of the printer and turn on the printer.
NOTE: 
• The printer will automatically detect the attached tray but will not detect the paper type.

22 Print the System Settings page to confirm the optional 550 sheet feeder is installed correctly.
a Press the  (System) button.
b Select Report / List.
c Select System Settings.
d Select Print.

The System Settings page is printed.

23 Confirm Tray 2 (550 Sheet Feeder) is listed under Printer Options in the System Settings page.
If the feeder is not listed, turn off the printer, unplug the power cord, and re-install the optional 550 sheet feeder.

24 After loading paper in the optional 550 sheet feeder, specify the paper type from the printer operator panel.
a Press the  (System) button.
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b Select the Tools tab, and then select Tray Management.
c Select Tray Settings.
d Select Tray 2.
e Select Size.
f Select the desired paper size.
g Select Type.
h Select the desired paper type.
i Select OK.

25 If you installed the optional 550 sheet feeder after installing the print driver, update your driver by following the 
instructions for each operating system. If the printer is on a network, update the driver for each client.
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Updating Your Driver to Detect Optional 550 Sheet Feeder
The following procedure uses Windows and the PCL 6/PS driver.

NOTE: 
• When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Paper Tray Configuration in the Items list box.

3 Select 2 Trays in the Paper Tray Configuration drop-down menu under Setting for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers (, Printers, or Printers and Faxes) dialog box.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then 
click Control Panel → Hardware and Sound (Hardware for Windows Server 
2012) → Devices and Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Printer 
properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows 7/
Windows 7 x64/
Windows Server 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Printer 
properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS X and the PS driver.

Mac OS X 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 
Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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Installing the Optional 550 Sheet Feeder (without the 
Cabinet)

IMPORTANT: 
• If you install the optional 550 sheet feeder after setting up the printer, be sure to turn off the printer, unplug the power cord, 

and disconnect all cables from the rear of the printer before installing the feeder.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Disconnect all cables from the rear of the printer.

3 Remove the tape and the bag holding the screws on the front of the optional 550 sheet feeder, and then 
remove the screws from the bag.
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4 Place the optional 550 sheet feeder in the location that the printer is located.

5 Pull the standard 550 sheet tray out of the printer about 200 mm. 

6 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

7 Lift the printer and align the five guide pins of the optional 550 sheet feeder with the holes at the bottom of the 
printer. Gently lower the printer onto the optional 550 sheet feeder.

IMPORTANT: 
• When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18.
• Be careful not to pinch your fingers when lowering the printer onto the optional 550 sheet feeder.
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8 Secure the optional 550 sheet feeder to the printer by tightening the two screws provided with the feeder, with a 
coin or similar object.

NOTE: 
• The screw hole is located in 216 mm recess from the front of the printer.

9 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or inside of the printer.

10 Reconnect all cables into the rear of the printer and turn on the printer.

NOTE: 
• The printer will automatically detect the attached tray but will not detect the paper type.

11 Print the System Settings page to confirm the optional 550 sheet feeder is installed correctly.
a Press the  (System) button.
b Select Report / List.
c Select System Settings, and select that report or list.
d Select Print.

The System Settings page is printed.

12 Confirm Tray 2 (550 Sheet Feeder) is listed under Printer Options in the System Settings page.
If the feeder is not listed, turn off the printer, unplug the power cord, and re-install the optional 550 sheet feeder.
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13 After loading paper in the optional 550 sheet feeder, specify the paper type from the printer operator panel.
a Press the  (System) button.
b Select the Tools tab, and then select Tray Management.
c Select Tray Settings.
d Select Tray 2.
e Select Size.
f Select the desired paper size.
g Select Type.
h Select the desired paper type.
i Select OK.

14 If you installed the optional 550 sheet feeder after installing the print driver, update your driver by following the 
instructions for each operating system. If the printer is on a network, update the driver for each client.

Updating Your Driver to Detect Optional 550 Sheet Feeder
For details, see "Updating Your Driver to Detect Optional 550 Sheet Feeder" on page 62.
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Installing the Optional Wireless Printer Adapter
The wireless printer adapter allows you to use the printer with wireless network connection.
The specifications of the wireless printer adapter are described below.

*:WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK AES, WPA2-PSK AES, 
WPA-PSK TKIP, Open (No Security)

NOTE: 
• WPA-Enterprise (TKIP, AES) and WPA2-Enterprise (AES) are available when the optional hard disk unit is installed.
• When the wireless printer adapter is installed, you cannot use IEEE 802.1x authentication and/or the Ethernet port for a wired 

connection.

Verifying the Contents of the Box

NOTE: 
• To complete wireless installation, you require the corresponding Driver CD Kit that comes with your printer, which can also be 

downloaded from http://www.fujixerox.com/support/docuprint/.

Item Specification

Connectivity Technology Wireless

Compliant Standards IEEE 802.11b, 802.11g, and 802.11n

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11n: 65 Mbps

IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps

IEEE 802.11b: 11, 5.5, 2, and 1 Mbps

Security 64 (40-bit key)/128 (104-bit key) WEP,

WPA- PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES),
WPA2-Enterprise (AES)

Wi-Fi Protected Setup® (WPS)*: Push-Button Configuration (PBC),

Personal Identification Number (PIN)

Fuji Xerox Co., Ltd.

XXXX XXXXX / DE4942Z4-1
(Edition 1) June 2012

Printed in China
Copyright © 2012 by Fuji Xerox Co., Ltd. XXXX XXXXX

Thank you for purchasing the Wireless Network Kit b/g/n. 
To ensure the safe operation of the printer, be sure to read through the "Safety Guide" before starting 
the installation. For more details such as how to configure the wireless settings for the printer, refer to 
"Configuring Wireless Settings (Windows & Mac OS X)" in "User Guide" available on the Driver CD Kit.

Installing the Wireless Printer Adapter
Important
• Ensure that the printer is turned off before installing the wireless printer adapter.

Align the connector and the three protrusions of the wireless printer adapter with the four holes on the rear of the 
printer, and insert the adapter as shown in the illustration.

•

•

Wireless Network Kit b/g/n Installation Guide

Wireless Printer Adapter 
Installation Guide

Wireless 
Printer Adapter
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Installing the Optional Wireless Printer Adapter Using Video 
Instructions (Recommended)
To install the wireless printer adapter using the video instructions on the Windows computer perform the following 
method.

1 Insert the Driver CD Kit in your computer. The Easy Install Navi file launches automatically.

2 Select Optional Accessories Setup on the Easy Install Navi window.
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3 Click Wireless Network Kit b/g/n.

4 Click the procedure you want confirm to start the video instruction.

Follow the on-screen instructions to install the wireless printer adapter.
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Installing the Optional Wireless Printer Adapter
NOTE: 
• You can also install the wireless printer adapter by following the instructions described in Wireless Printer Adapter Installation 

Guide provided with the wireless printer adapter.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Align the connector and the three protrusions of the wireless printer adapter with the four holes and insert the 
adapter.

NOTE: 
• Ensure that the adapter is fully inserted and secured.
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3 Turn on the printer.
If a message displays telling you to make initial setup on the operator panel, always do as instructed.

4 Print the System Settings page to confirm that the wireless printer adapter is installed correctly.
Confirm that the Network (Wireless) section exists.

NOTE: 
• For more information on configuring the wireless printer adapter, see "Configuring Wireless Settings (Windows & Mac 

OS X)" on page 129.
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Installing the Optional Hard Disk Unit
1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Turn the screw on the control board cover counterclockwise.

3 Slide the control board cover towards the rear of the printer.

4 Open the control board cover completely.
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5 Insert the two plastic pins on the hard disk unit into the metal casing holes.

6 Attaching the protrusion and the connector to the control board, push the hard disk unit firmly into place.

7 Close the control board cover, and then slide it towards the front of the printer.

8 Turn the screw clockwise.

9 Turn on the printer.

10 Print the System Settings page to confirm the optional hard disk unit is installed correctly.
a Press the  (System) button.
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b Select Report / List.
c Select System Settings, and select that report or list.
d Select Print.
The System Settings page is printed.

11 Confirm the amount of Hard Disk listed under Printer Options in the System Settings page.
If the Hard Disk is not listed, turn off the printer, unplug the power cord, and re-install the hard disk unit.

12 If you installed the hard disk unit after installing the print driver, update your driver by following the instructions 
for the operating system you are using. If the printer is on a network, update the driver for each client.
hard disk unit can be specified on the print driver only when Hard Disk or RAM Disk is available on the print 
driver.
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Updating Your Driver to Detect Optional Hard Disk Unit
The following procedure uses Windows and the PCL 6/PS driver.

NOTE: 
• When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Hard Disk in the Items list box.

3 Select Installed in the Hard Disk drop-down menu under Setting for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers (, Printers, or Printers and Faxes) dialog box.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then 
click Control Panel → Hardware and Sound (Hardware for Windows Server 
2012) → Devices and Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Printer 
properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows 7/
Windows 7 x64/
Windows Server 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Printer 
properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint CM405 df and select Properties.

3 Click the Configuration tab, and then select Bi- Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS X and the PS driver.

Mac OS X 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list box, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list box, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 
Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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Turning on the Printer
IMPORTANT: 
• Do not use extension cords or power strips.
• The printer should not be connected to an uninterrupted power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer.

2 Connect the other end of the power cord to the power source.

3 Turn on the printer.

4 Follow the on-screen instructions on the LCD panel to configure the initial settings of your printer.
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Setting Initial Settings on the Operator Panel
You need to set the printer language, region, clock date, and time when you turn on printer for the first time.
When you turn on the printer, a wizard appears on the LCD panel. Follow the steps below to set the initial settings.

1 Turn on the printer.
The Select Your Language screen of Power On Wizard appears.

NOTE: 
• If you do not start configuring the initial settings, Ready appears on the LCD panel in three minutes. After that, you can 

set the following initial setup by enabling Power On Wizard on the LCD panel or CentreWare Internet Services if 
needed.
For more information on operator panel, see "Understanding the Printer Menus" on page 290.
For more information on CentreWare Internet Services, see "CentreWare Internet Services" on page 85. 

2 Select the desired language.

3 Select Next.
The Date/Time screen appears.

4 Select Time Zone.

5 Select the desired geographic region.

6 Select the desired time zone, and then select OK.

7 Select Date.

8 Select a data format from the menu displayed by selecting Format.

9 After selecting the box under Year, select  or , or use the number pad to enter the desired value.
Repeat this step to enter the desired value for Month and Day.

10 Select OK.

11 Select Time.

12 Select the time format from 12 Hour or 24 Hour. If you select 12 Hour, select AM or PM.

13 After selecting the box under Hour, use the number pad to enter the desired value.
Repeat this step to enter the desired value for Minute.
The Fax (Do you want to setup Fax Now?) screen appears.
To set Fax settings, select Yes, Setup Fax and follow the procedure below. To end the settings, select No, 
I'll Do It Later and proceed to Step 18.

14 Enter the fax number of the printer using the number pad.

15 Select Region.

16 Select the desired region.
The default paper size is automatically set when you select a region.

17 Select Next.
The Setup Complete (Congratulation, setup is complete) screen appears.

18 Select Done.
The printer automatically restarts after selecting Done.

English
Simplified Chinese
Traditional Chinese
Korean
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Printing a Panel Settings Page
The Panel Settings page shows current settings for the operator panel menus. 

1 Press the  (System) button.

2 Select Report / List.

3 Select Panel Settings.

4 Select Print.
The Panel Settings page is printed.
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Power Saver Mode
The printer has an energy saving feature that reduces power consumption during periods of inactivity. This feature 
operates in two modes: the Low Power mode and Sleep mode. As delivered, the printer switches to the Low Power 
mode one minute after the last print job is printed. The printer then switches to the Sleep mode after another four 
minutes of inactivity. When the printer is in the Low Power mode, the LCD backlight turns off. In the Sleep mode, the 

 (Wake Up) button lights up, and the LCD backlight turns off. In the Sleep mode, the display also goes blank and 
displays nothing.
The factory default settings are changeable within the range of 1 to 60 minutes (Low Power Timer) and 1 to 6 
minutes (Sleep Timer). The printer returns to the ready-to-print state in about 20 seconds when re-activated.

NOTE: 
• The functions of Low Power Timer and Sleep Timer cannot be disabled.

See also: 
• "Setting the Energy Saver Option" on page 351

Exiting the Power Saver Mode
The printer automatically exits the Power Saver mode when it receives a print job from a computer. To manually exit 
the Low Power mode, press the  (Wake Up) button on the operator panel. To exit the Sleep mode, press the  
(Wake Up) button. 

NOTE: 
• Opening and closing a cover will cause the printer to exit the Low Power mode and the Sleep mode.
• Opening and closing the DADF cover will cause the printer to exit the Sleep mode.
• When the printer is in the Sleep mode, all buttons on the operator panel except for the  (Wake Up) button do not function. 

To use the buttons on the operator panel, press the  (Wake Up) button to exit the Sleep mode.

See also: 
• "Setting the Energy Saver Option" on page 351
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3
Printer Management Software

Use the CD-ROMs shipped with your printer to install a combination of software programs, depending on your 
operating system.
This chapter includes:

• "Print and Scan Drivers" on page 84
• "CentreWare Internet Services" on page 85
• "SimpleMonitor (Windows Only)" on page 86
• "Address Book Editor" on page 87
• "Express Scan Manager" on page 88
• "Setup Disk Creation Tool (Windows Only)" on page 89
• "DocuWorks (Windows Only)" on page 90
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Print and Scan Drivers
To access all of your printer’s features, install the print and scan drivers from the Driver CD Kit or PostScript Driver 
Library CD.

• The print drivers enable your computer and printer to communicate and provide access to your printer features. 
• The scan drivers enable you to scan images directly to your personal computer and place scanned images 

directly into an application via USB or the network.

See also: 
• "Installing the Scan Driver" on page 215
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CentreWare Internet Services
This section provides information on CentreWare Internet Services, a hyper text transfer protocol (HTTP)-based web 
page service that is built into the printer. 
These pages give you instant access to printer status, and printer configuration options. Anyone on your network 
can access the printer using their web browser software. In administrative mode you can change the configuration of 
the printer, set up your fax directories, and manage your printer settings without leaving your computer.

NOTE: 
• Users who are not given passwords by the administrator can still view the configuration settings and options in user mode. 

They will not be able to save or apply any changes to the current configuration.

Creating an Administrative Password
1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 
• The default ID and password are “11111” and “x-admin”, respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

9 Click Apply.
Your new password has been set and anyone with the administrator name and password can log in and 
change the printer configuration and settings.
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SimpleMonitor (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon  on the taskbar 
at the bottom right of the screen. The Select Printer window appears, which displays the printer name, printer 
connection ports, and printer status. Check the Status column to know the current status of your printer. You can 
also check the amount of toner remaining. 
Status Settings button: Displays the Status Settings dialog box and allows you to modify the SimpleMonitor 
settings.
Click the name of the desired printer listed on the Select Printer window. The Status Monitor window appears.
The Status Monitor window alerts you when there is a warning or when an error occurs, for example, when a paper 
jam occurs or toner is running low.
By default, the Status Monitor window launches when printing and an error occurs. When an error occurs, the error 
message appears on the Status Monitor window. You can specify the conditions for starting the Status Monitor 
window in Auto start setup.

To change the pop-up settings for the Status Monitor window:
The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate SimpleMonitor.
The Select Printer window appears.

2 Click Status Settings.
The Status Settings dialog box appears.

3 Select the Pop-up Settings tab, and then select the type of the pop-up from Auto start setup.

SimpleMonitor can be installed from the Driver CD Kit. It is available only for Windows.
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Address Book Editor 
The Address Book Editor provides a convenient interface for modifying the printer’s address book entries. With it 
you can create:

• Fax entries
• Email entries
• Server entries

When you start the software, if the printer is connected to your computer via USB or to a network, the Address Book 
Editor reads the printer’s address book. You can create, edit, and delete entries. After making changes, you can then 
save the updated address book to the printer or to your computer. 

To open the Address Book Editor:
The following procedure uses Windows 7 as an example.
Click Start → All Programs → Fuji Xerox → DocuPrint CM405 df → Address Book Editor.

The Address Book Editor can be installed from the Driver CD Kit. It is available for Windows and Mac OS® X.



88 Printer Management Software

Express Scan Manager 
The Express Scan Manager handles scan jobs sent from the printer to your computer via USB. When a scan job is 
sent from the printer to the computer, Express Scan Manager automatically manages the scan job.
Before scanning to your computer, start Express Scan Manager and configure the scan settings. You can specify 
settings for output destination.

To open the Express Scan Manager:
The following procedure uses Windows 7 as an example.
Click Start → All Programs → Fuji Xerox → DocuPrint CM405 df → Express Scan Manager.

The Express Scan Manager can be installed from the Driver CD Kit It is available for Windows and Mac OS X.

See also: 
• "Scanning" on page 213
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Setup Disk Creation Tool (Windows Only)
The Setup Disk Creation Tool on the Driver CD Kit and the print drivers on the Driver CD Kit and PostScript Driver 
Library CD are used to create driver installation packages that contain custom driver settings. A driver installation 
package can contain a group of saved print driver settings and other data for things such as:

• Print orientation and Multiple Up (document settings)
• Watermarks
• Font references

If you want to install the print driver with the same settings on multiple computers running the same operating 
system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created 
will reduce the amount of work required when installing the print driver.

• Install the print driver in the computer on which the setup disk is to be created.
• The setup disk can only be used on the operating system on which the disk was created or computers running 

the same operating system. Create a separate setup disk for each of the operating systems.
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DocuWorks (Windows Only)
When installing DocuWorks, run the appropriate EXE file in the DocuWorks CD.
Windows supports DocuWorks and DocuWorks Viewer Light.
DocuWorks is available only for Windows.

NOTE: 
• For more information on DocuWorks, refer to the readme file on the DocuWorks CD.
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4
Printer Connection and Software 
Installation

This chapter includes:
• "Overview of Network Setup and Configuration" on page 92
• "Connecting Your Printer" on page 93
• "Setting the IP Address" on page 96
• "Installing Print Driver on Computers Running Windows" on page 100
• "Installing Print Driver on Computers Running Mac OS X" on page 122
• "Installing Print Driver on Computers Running Linux (CUPS)" on page 123
• "Configuring Wireless Settings (Windows & Mac OS X)" on page 129
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Overview of Network Setup and Configuration
To set up and configure the network:

1 Connect the printer to the network using the recommended hardware and cables.

2 Turn on the printer and the computer.

3 Print the System Settings page and keep it for referencing network settings. 

4 Install the driver software on the computer from the Driver CD Kit or PostScript Driver Library CD. For 
information on driver installation, see the section in this chapter for the specific operating system you are using.

5 Configure the printer’s TCP/IP address, which is required to identify the printer on the network. 
• Microsoft® Windows® operating systems: Run the IP address setting tool on the Driver CD Kit to set the 

printer’s IP address if the printer is connected to an established TCP/IP network. You can also manually set 
the printer’s IP address on the operator panel.

• Mac OS® X and Linux® systems: Manually set the printer’s TCP/IP address on the operator panel.

See also: 
• "Setting the IP Address" on page 96

6 Print a System Settings page to verify the new settings.

NOTE: 
• If the Driver CD Kit or PostScript Driver Library CD is not available, you can download the latest driver from the Fuji Xerox 

Web Site: http://www.fujixeroxprinters.com/

See also: 
• "Printing a System Settings Page" on page 177

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/
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Connecting Your Printer
Your printer interconnection cables must meet the following requirements:

Connection Type Connection Specifications
USB USB 2.0

Ethernet 10 Base-T/100 Base-TX/1000 Base-T

Wireless (optional) IEEE 802.11b/802.11g/802.11n

Wall jack connector RJ11

Phone connector RJ11

1 Ethernet port

2 USB port

3 Wireless adapter socket

4 Phone connector

5 Wall jack connector

1

2

4
5

3
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Connecting Printer to Computer or Network
Connect the printer via USB, Ethernet or wireless (optional). An USB connection is a direct connection and is not 
used for networking. An Ethernet and wireless connections are used for networking. Hardware and cabling 
requirements vary for the different connection methods. Ethernet and USB cables are not included with your printer 
and must be purchased separately.
The available features for each connection type are shown in the following table.

Connection Type Available Features
USB When connected via USB you can:

• Send print jobs from a computer.
• Scan and print an image into an application.
• Scan and print an image to a folder on the computer.
• Use the Address Book Editor.
• Use the SimpleMonitor to check the printer status.
• Use the Express Scan Manager to handle scan jobs sent from the printer to your 

computer.

Ethernet When connected via Ethernet you can:
• Send print jobs from a computer on the network.
• Scan and print an image into an application.
• Scan and print an image to a folder on the computer on the network.
• Scan to a computer on the network.
• Scan to an FTP server.
• Scan to email.
• Use CentreWare Internet Services.
• Use the Address Book Editor to manage address book entries.
• Use the SimpleMonitor to check the printer status.

Wireless (optional) When connected via wireless you can:
• Send print jobs from a computer on the network.
• Scan and print an image into an application.
• Scan and print an image to a folder on the computer on the network.
• Scan to a computer on the network.
• Scan to an FTP server.
• Scan to email.
• Use CentreWare Internet Services.
• Use the Address Book Editor to manage address book entries.
• Use the SimpleMonitor to check the printer status.
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USB Connection
A local printer is directly connected to your computer using the USB cable. If your printer is connected to a network 
instead of your computer, skip this section and go to "Wired Network Connection" on page 95.
To connect the printer to a computer:

1 Connect the smaller USB connector into the USB port on the rear of the printer, and the other end of the cable 
into a USB port of the computer.

NOTE: 
• Ensure that you match the USB symbol on the cable to the USB symbol on the printer.
• Do not connect the printer USB cable to the USB port available on the keyboard.

Wired Network Connection
To connect the printer to a network:

1 Connect one end of the Ethernet cable into the Ethernet port on the rear of the printer, and the other end to a 
LAN drop or hub.

Wireless Network Connection
To set up a wireless connection, insert the optional wireless printer adapter into the wireless adapter socket on the 
rear of the printer. For details about wireless connection, see "Installing the Optional Wireless Printer Adapter" on 
page 68.

NOTE: 
• To use the wireless printer adapter, be sure to disconnect the Ethernet cable.
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Setting the IP Address
This section includes:

• "TCP/IP and IP Addresses" on page 96
• "Setting the Printer’s IP Address through the Driver CD Kit" on page 96
• "Dynamic Methods of Setting the Printer’s IP Address" on page 97
• "Assigning an IP Address (for IPv4 Mode)" on page 98
• "Verifying the IP Settings" on page 99
• "Printing and Checking the System Settings Page" on page 99

TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP addresses and 
additional system settings information. 
If you are creating your own small Local Area Network or connecting the printer directly to your computer using 
Ethernet, follow the procedure for automatically setting the printer’s IP address. 
Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. With TCP/IP 
protocols, each printer and computer must have a unique IP address. It is important that the addresses are similar, 
but not the same; only the last digit needs to be different. For example, your printer can have the address 
192.168.1.2 while your computer has the address 192.168.1.3. Another device can have the address 192.168.1.4.
Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically 
programs an IP address into every computer and printer on the network that is configured to use DHCP. A DHCP 
server is built into most cable and Digital Subscriber Line (DSL) routers. If you use a cable or DSL router, see your 
router’s documentation for information on IP addressing.

Setting the Printer’s IP Address through the Driver CD Kit
If the printer is connected to a small established TCP/IP network without a DHCP server, use the IP address setting 
tool on the Driver CD Kit to detect or assign an IP address to your printer. For further instructions, insert the Driver 
CD Kit into your computer’s CD-ROM drive. After the IP address setting tool launches, click Install Driver and 
Software. Start IP address setting tool on the Admin Tools tab, and follow the displayed instructions.

NOTE: 
• For the IP address setting tool to function, the printer must be connected to an established TCP/IP network.



Printer Connection and Software Installation 97

Dynamic Methods of Setting the Printer’s IP Address
There are two protocols available for dynamically setting the printer’s IP address: 

• DHCP (enabled by default)
• AutoIP

You can turn on/off both protocols using the operator panel or CentreWare Internet Services.

NOTE: 
• You can print a report that includes the printer’s IP address. On the operator panel, press the  (System) button, select 

Report / List, select System Settings, and then select Print. The IP address is listed on the System Settings page.

Using the Operator Panel
To turn on/off either the DHCP or AutoIP protocol:

1 On the operator panel, press the  (System) button.

2 Select Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Ethernet.

6 Select TCP/IP.

7 Select Get IP Address.

8 Select DHCP / AutoIP, and then select OK.

Using CentreWare Internet Services
To turn on/off either the DHCP or AutoIP protocol:

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

3 Select Properties.

4 Select the Protocol Settings folder on the left navigation panel.

5 Select TCP/IP.

6 In the Get IP Address field, select the DHCP / Autonet option.

7 Click the Apply button.
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Assigning an IP Address (for IPv4 Mode)
NOTE: 
• When you assign an IP address manually in IPv6 mode, use the CentreWare Internet Services. To display the CentreWare 

Internet Services, use the link local address. To check a link local address, see "Printing and Checking the System Settings 
Page" on page 99.

• Assigning an IP address is considered as an advanced function and is normally done by a system administrator.
• Depending on the address class, the range of the IP address assigned may be different. On Class A, for example, an IP 

address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment of IP addresses, contact 
your system administrator. 

You can assign the IP address by using the operator panel.

1 Turn on the printer.

2 Ensure that Ready message appears on the LCD panel.

3 On the operator panel, press the  (System) button.

4 Select Tools tab.

5 Select Admin Settings.

6 Select Network.

7 Select Ethernet.

8 Select TCP/IP.

9 Select Get IP Address.

10 Select Panel, and then select OK.

11 Ensure that the message This Settings Becomes Effective after Restart. appears, and then 
select Close.

12 Select IP Address.
The cursor is located at the first octet of the IP address.

13 Enter the value of the IP address using the number pad.

14 Select .
The cursor moves to the next octet.

15 Repeat steps 13 to 14 to set all of the digits in the IP address, and then select OK.

16 Ensure that the message This Settings Becomes Effective after Restart. appears, and then 
select Close.

17 Select Subnet Mask.
The cursor is located at the first octet of the subnet mask.

18 Enter the value of the subnet mask using the number pad.

19 Select .
The cursor moves to the next octet.

20 Repeat steps 18 to 19 to set the subnet mask, and then select OK.

21 Ensure that the message This Settings Becomes Effective after Restart. appears, and then 
select Close.

22 Select Gateway Address.
The cursor is located at the first octet of the gateway address.
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23 Enter the value of the gateway address using the number pad.

24 Select .
The cursor moves to the next octet.

25 Repeat steps 23 to 24 to set the gateway address, and then select OK.

26 Ensure that the message This Settings Becomes Effective after Restart. appears, and then 
select Close.

27 Turn off and turn on the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

See also: 
• "Operator Panel" on page 46

Verifying the IP Settings
You can confirm the settings by printing the system settings report or using the ping command.
The following procedure uses Windows 7 as an example.

1 Print the System Settings page.

2 Look under the IPv4 heading on the System Settings page to ensure that the IP address, subnet mask, and 
gateway address are appropriate.

To verify if the printer is active on the network, run the ping command in your computer:

1 Click Start → All Programs → Accessories → Run.

2 Enter cmd, and then click OK.
A black window is displayed.

3 Enter ping xx.xx.xx.xx (where xx.xx.xx.xx is the IP address of your printer), and then press the Enter key.
Reply from the IP address denotes printer is active on the network.

See also: 
• "Printing and Checking the System Settings Page" on page 99

Printing and Checking the System Settings Page
Print the System Settings page and check your printer's IP address by using the operator panel.

1 On the operator panel, press the  (System) button.

2 Select Report / List.

3 Select System Settings, and then select Print.
The System Settings page is printed.

4 Confirm the IP address next to IP Address under Network Setup on the System Settings page. If the IP 
address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the System 
Settings page again.
If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on page 98.
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Installing Print Driver on Computers Running 
Windows
This section includes:

• "Identifying Print Driver Pre-install Status (For Network Connection Setup)" on page 100
• "Inserting the CD-ROM" on page 102
• "USB Connection Setup" on page 102
• "Network Connection Setup" on page 105
• "Setting Up for Shared Printing" on page 111

NOTE: 
• The fax driver is installed with the PCL 6 driver.

Identifying Print Driver Pre-install Status (For Network 
Connection Setup)

Before installing the print driver on your computer, print the System Settings page to check the IP address of your 
printer.
This section includes:

• "The Operator Panel" on page 100
• "Changing the Firewall Settings Before Installing Your Printer" on page 101

The Operator Panel
1 Press the  (System) button.

2 Select Report / List.

3 Select System Settings, and then select Print.
The System Settings page is printed.

4 Find the IP address next to IP Address under Network Setup on the System Settings page.
If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the 
System Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on page 98.
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Changing the Firewall Settings Before Installing Your Printer
If you are running one of the following operating systems, you must change the firewall settings before installing the 
Fuji Xerox printer software:

• Windows 8
• Windows Server® 2012
• Windows 7
• Windows Vista®

• Windows Server 2008 R2
• Windows Server 2008
• Windows XP

NOTE: 
• For Windows XP, Service Pack 2 or 3 must be installed.

The following procedure uses Windows 7 as an example.

1 Insert the Driver CD Kit into your computer.

2 Click Start → Control Panel.

3 Click System and Security.

4 Click Windows Firewall.

5 Click Allow a program or feature through Windows Firewall.

6 Click Change settings.

7 Click Allow another program.

8 Click Browse.

9 Click D:\setup.exe (where D is the drive letter of the optical drive) in the File name text box, and then click 
Open.

10 Click Add.

11 Click OK.
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Inserting the CD-ROM

• For Installing PCL 6 and Fax Driver

1 Insert the Driver CD Kit into your computer to start Easy Install Navi.

NOTE: 
• If the CD does not automatically launch, click Start (start for Windows XP) → All Programs (for Windows Vista and 

Windows 7) → Accessories (for Windows Vista and Windows 7) → Run, and then enter D:\setup.exe (where D is the 
drive letter of the optical drive), and then click OK.
For Windows 8 and Windows Server 2012

Point to the top or bottom right corner of the screen, and then click Search → Enter Run in the search box, click Apps, 
and then click Run → Enter D:\setup.exe (where D is the drive letter of the optical drive), and then click OK.

• For Installing PS Driver

1 Insert the PostScript Driver Library CD into your computer.

• For Installing XML Paper Specification (XPS) Print Driver

1 Extract the following zip file to your desired location.
D:\Eng\XPS (where D is the drive letter of the optical drive)

USB Connection Setup
NOTE: 
A personal printer is a printer attached to your computer or a print server using a USB. If your printer is attached to a 
network and not your computer, see "Network Connection Setup" on page 105.

• For Installing PCL 6 and Fax Driver

1 On the top screen of Easy Install Navi, click Installing Driver and Software.

2 Click Print/Fax Driver. 

3 Click Connect via USB.

4 Follow the procedures described in the Help to install the print driver.

• For Installing PS Driver
For information on how to install the PS driver, refer to the PostScript User Guide.
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• For Installing XML Paper Specification (XPS) Print Driver
NOTE: 
• XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit 

Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-bit 
Edition, Windows 8, Windows 8 64-bit Edition, and Windows Server 2012.

Windows Vista or Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.
To use this printer as the default printer, select the Set as the default printer check box displayed under the 
Printer name.

11 Click Next.
Installation starts.

If the User Account Control dialog box appears, click Continue.

NOTE: 
• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 

action.

12 As the driver installation is completed, click Print a test page to print a test page.

13 Click Finish.

Windows Server 2008 or Windows Server 2008 64-bit Edition
NOTE: 
• You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

7 Click Open.
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8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.
To use this printer as the default printer, select the Set as the default printer check box.

11 Click Next.
Installation starts.

12 If you do not share your printer, select Do not share this printer.
If you share your printer, select Share this printer so that others on your network can find and use it.

13 Click Next.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.
If the User Account Control dialog box appears, click Yes.

NOTE: 
• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 

action.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.
Installation starts.

11 If you do not share your printer, select Do not share this printer.
If you share your printer, select Share this printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Click Add a printer.

3 Select your printer.

4 Click Have Disk to display the Install From Disk dialog box.

5 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

6 Click Open.

7 Click OK.

8 Select your printer name and click Next.

9 To change the printer name, enter the printer name in the Printer name box, and then click Next.
Installation starts.

10 If you do not share your printer, select Do not share this printer.
If you share your printer, select Share this printer so that others on your network can find and use it.

11 Click Next.

12 To use this printer as the default printer, select the Set as the default printer check box.

13 As the driver installation is completed, click Print a test page to print a test page.

14 Click Finish.

Network Connection Setup
NOTE: 
• To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to install and use 

these, see also "Installing Print Driver on Computers Running Linux (CUPS)" on page 123.

Network Printer Setup on a Local Network

• For installing PCL 6 and Fax Driver

1 On the top screen of Easy Install Navi, click Installing Driver and Software.

2 Click Print/Fax Driver. 

3 Select Standard or Custom setup.

4 Follow the on-screen instructions to install the print driver.

• For Installing PS Driver
For information on how to install the PS driver, refer to the PostScript User Guide.
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• For Installing XML Paper Specification (XPS) Print Driver
NOTE: 
• XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit 

Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-bit 
Edition, Windows 8, Windows 8 64-bit Edition, and Windows Server 2012.

Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.
When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.
If the User Account Control dialog box appears, click Continue.

NOTE: 
• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 

action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.
To use this printer as the default printer, select the Set as the default printer check box.

Installation starts.

13 Click Next.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows Server 2008 and Windows Server 2008 64-bit Edition
NOTE: 
• You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.
When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.
If the User Account Control dialog box appears, click Continue.

NOTE: 
• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 

action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.
To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.
Installation starts.

14 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 
printer so that others on your network can find and use it.

15 Click Next.

16 As the driver installation is completed, click Print a test page to print a test page.

17 Click Finish.
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Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

NOTE: 
• When you click The printer that I want isn't listed, Find a printer by name or TCP/IP address screen appears. Find 

your printer on the screen.

If the User Account Control dialog box appears, click Continue.

NOTE: 
• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 

action.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.
Installation starts.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 
printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows 7 and Windows 7 64-bit Edition

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.
When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.
If the User Account Control dialog box appears, click Yes.

NOTE: 
• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 

action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.
Installation starts.

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 
printer so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

16 As the driver installation is completed, click Print a test page to print a test page.

17 Click Finish.
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Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Click Add a printer.

3 Select printer or click The printer that I want isn't listed.
When you  select your printer, go to step 6.

When you  click The printer that I want isn't listed, go to step 4.

4 Select Add a printer using a TCP/IP address or host name, and then click Next.

5 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.
If the User Account Control dialog box appears, click Yes.

NOTE: 
• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 

action.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 102.

8 Click Open.

9 Click OK.

10 Select your printer name and click Next.

11 To change the printer name, enter the printer name in the Printer name box, and then click Next.
Installation starts.

12 If you do not share your printer, select Do not share this printer.
If you share your printer, select Share this printer so that others on your network can find and use it.

13 Click Next.

14 To use this printer as the default printer, select the Set as the default printer check box.

15 As the driver installation is completed, click Print a test page to print a test page.

16 Click Finish.

Use CentreWare Internet Services to monitor the status of your network printer without leaving your desk. You can 
view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering replacement 
consumables. You can click our web site link for ordering supplies.

NOTE: 
• CentreWare Internet Services is not available when the printer is directly connected to a computer or a print server.

To launch CentreWare Internet Services, type the printer's IP address in your web browser. The printer configuration 
appears on the screen.
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Setting Up for Shared Printing
You can share your new printer on the network using the Driver CD Kit that comes with your printer, or using 
Microsoft peer-to-peer method. However, if you use the Microsoft method, some features, such as the 
SimpleMonitor and other printer utilities, installed with the Driver CD Kit, may not be available.
If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 
and Windows Server 2003 64-bit Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon and select Properties.

3 On the Sharing tab, select the Share this printer radio button, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.
If you are missing files, you are prompted to insert the server operating system CD.

6 Click Apply, and then click OK.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options.
The message Windows needs your permission to continue appears.

4 Click Continue.

5 Select the Share this printer check box, and then enter a name in Share name.

6 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

7 Click OK.

8 Click Apply, and then click OK.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in Share name.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.
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• For Windows 7, Windows 7 64-bit Edition, and Windows Server 
2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 8, Windows 8 64-bit Edition, and Windows Server 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.
To confirm that the printer is properly shared:

• Ensure that the printer object in the Printers, Printers and Faxes or Devices and Printers folder is shared. 
The shared icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and the shared name you assigned 
to the printer.

Now that the printer is shared, you can install the printer on network clients using the peer-to-peer method.
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Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the print driver.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 
and Windows Server 2003 64-bit Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers and Faxes folder. The copy time varies, based on network traffic and 
other factors.

4 Close My Network Places.

5 Print a test page to verify installation.
a Click start (Start for Windows Server 2003 and Windows Server 2003 64-bit Edition) → Printers and 

Faxes.
b Select the printer you just created.
c Click File → Properties.
d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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• For Windows Vista and Windows Vista 64-bit Edition

1 On the Windows desktop of the client computer, click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.

6 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other 
factors.

7 Print a test page to verify installation.
a Click Start → Control Panel → Hardware and Sound.
b Select Printers.
c Right-click the printer you just created and click Properties.
d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 On the Windows desktop of the client computer, click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other 
factors.

6 Print a test page to verify installation.
a Click Start → Control Panel.
b Select Printers.
c Right-click the printer you just created and select Properties.
d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and Windows Server 
2008 R2

1 On the Windows desktop of the client computer, click Start → your user name → Network (Start → Network 
for Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Devices and Printers folder. The time this takes varies, based on network 
traffic and other factors.

6 Print a test page to verify installation.
a Click Start → Devices and Printers.
b Right-click the printer you just created and select Printer properties.
c On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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• For Windows 8, Windows 8 64-bit Edition, and Windows Server 2012

1 Point to the top or bottom right corner of the screen, and then click Search → Enter Network in the search box, 
click Apps, and then click Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Devices and Printers folder. The time this takes varies, based on network 
traffic and other factors.

6 Print a test page to verify installation.
a On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 

Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.
b Right-click the printer you just created and select Printer properties.
c On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.



Printer Connection and Software Installation 117

Peer-to-Peer
If you use the peer-to-peer method, the print driver is fully installed on each client computer. Network clients retain 
control of driver modifications. The client computer handles the print job processing.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 
and Windows Server 2003 64-bit Edition

1 Click start (Start for Windows Server 2003 / Windows Server 2003 64-bit Edition) → Printers and Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003 / Windows Server 2003 64-bit Edition) to launch 
the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next.
If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Connect to this printer (or to browse for a printer, select this option and click Next).
b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network.

The shared printer name is the name assigned during the server installation process.

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next.
If this is a new printer, you may be prompted to install a print driver.

If no system driver is available, you need to specify the path to available drivers.

7 Specify the following settings if you want, and then click Next.
• Click Yes to set this printer as the default printer.
• Click Yes to print a test page for verifying installation.

8 Click Finish.
When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next. 
If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.
b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network.

The shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you 
need to specify the path to available drivers.

4 Specify the following settings if you want, and then click Next.
• Click Yes to set this printer as the default printer.
• Click Print a test page to print a test page for verifying installation.

5 Click Finish.
When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.
If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.
b Enter the path of the printer in the text box, and then click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide a path to available drivers.

4 Specify the following settings if you want, and then click Next.
• Click Yes to set this printer as the default printer.
• Click Print a test page to print a test page for verifying installation.

5 Click Finish.
When a test page prints successfully, installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and Windows Server 
2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer. 
If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.
b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it to the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide the path to the available driver.

4 Confirm the printer name, and then click Next.

5 Specify the following settings if you want, and then click Finish.
• Click Set as the default printer to set this printer as the default printer.
• Click Print a test page to print a test page for verifying installation.
When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows 8, Windows 8 64-bit Edition, and Windows Server 2012

1 On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 If the printer is listed, select the printer.
If the printer is not listed, click The printer that I want isn't listed.

a Click Add a network, wireless or Bluetooth printer → Select a shared printer by name.
b Enter the path of the printer in the text box, and then click Next.
For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide a path to available drivers.

4 Confirm the printer name, and then click Next.

5 Specify the following settings if you want, and then click Finish.
• Click Set as the default printer to set this printer as the default printer.
• Click Print a test page to print a test page for verifying installation.
When a test page prints successfully, installation is complete.
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Installing Print Driver on Computers Running 
Mac OS X
For information on how to install the print driver, refer to the PostScript User Guide.
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Installing Print Driver on Computers Running Linux 
(CUPS)
This section provides information for installing or setting up the print driver with CUPS (Common UNIX Printing 
System) on Red Hat® Enterprise Linux® 5/6 Desktop (x86) or SUSE® Linux Enterprise Desktop 10/11 (x86).

NOTE: 
•  When using a CD drive in a Linux environment, you need to mount the CD according to your system environment. The 

command strings are mount/media/CD-ROM.

This section includes:
• "Installing the Print Driver" on page 123
• "Setting Up the Queue" on page 124
• "Setting the Default Queue" on page 125
• "Specifying the Printing Options" on page 126
• "Setting the Password for Authority as the Printer Administrator" on page 127
• "Uninstalling the Print Driver" on page 128

Installing the Print Driver
This section includes:

• "For Red Hat Enterprise Linux 5/6 Desktop (x86)" on page 123
• "For SUSE Linux Enterprise Desktop 10/11 (x86)" on page 123

NOTE: 
• The print driver Fuji_Xerox-DocuPrint_CM405-x.x-x.noarch.rpm is included in the linux folder in the Eng folder on the 

Driver CD Kit.

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop (x86) as an example:

1 Copy the .rpm file in the following path to your desired location.
D:\Eng\linux (where D is the drive letter of the optical drive)

2 Double-click the .rpm file.

3 Click Install.

4 Enter the administrator password, and click Authenticate.
Installation starts. When the installation is complete, the window is automatically closed.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Copy the .rpm file in the following path to your desired location.
D:\Eng\linux (where D is the drive letter of the optical drive)

2 Double-click the .rpm file.

3 Click Install.

4 Enter the administrator password, and click Authenticate.
Installation starts. When the installation is complete, the window is automatically closed.
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Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

NOTE: 
• When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the application, 

and specify the queue in the print dialog box. 
However, you may be able to print only from the default queue depending on the application. In these cases, before you start 
printing, set queue you want to print to as the default queue. For information on specifying the default queue, see also "Setting 
the Default Queue" on page 125.

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop (x86) as an example:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Enter root as the user name, and then enter the administrator password.

5 Click OK.

6 Select either of the following according to the type of your printer connection.
For network connections:

a Select LPD/LPR Host or Printer from the Other Network Printers menu, and then click Continue.
b Enter the IP address of the printer in Connection. 

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

c Click Continue.
d Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

For USB connections:

a Select FUJI XEROX DocuPrint XXX from the Local Printers menu, and then click Continue.
b Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

7 Select FX from the Make menu, and then click Continue.

8 Select FX DocuPrint XXX from the Model menu, and then click Add Printer.
The setup is complete.

You can optionally specify the default options settings of the printer.
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• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications..., and select YaST on Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.
The Printer Configurations dialog box opens.

For network connections:

a Click Add.
The Add New Printer Configuration dialog box opens.

b Click Connection Wizard.
The Connection Wizard dialog box opens.

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver Box via.
d Enter the IP address of the printer in IP Address or Host Name:.
e Select Fuji Xerox in Select the printer manufacturer:.
f Click OK.

The Add New Printer Configuration dialog box appears.

g Select DocuPrint XXX vx.x [FujiXerox/Fuji_Xerox_DocuPrint_XXX.ppd.gz] from the Assign Driver list.

NOTE: 
• You can specify the printer name in Set Name:.
For USB connections:

a Click Add.
The Add New Printer Configuration dialog box opens.

The printer name is displayed in the Determine Connection list.

b Select DocuPrint XXX vx.x. [FujiXerox/Fuji_Xerox_DocuPrint.ppd.gz] from the Assign Driver list.

NOTE: 
• You can specify the printer name in Set Name:.

4 Confirm the settings, and then click OK.

Setting the Default Queue

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop (x86) as an example:

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window.

su

(Enter the administrator password)

lpadmin -d (Enter the queue name)
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• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications..., and select YaST on Application Browser.

2 Enter the administrator password.
YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.
The Printer Configurations dialog box opens.

4 Click Edit.
A dialog box to modify the specified queue opens.

5 Confirm that the printer you want to set is selected in the Connection list.

6 Select the Default Printer check box.

7 Confirm the settings, and click OK.

Specifying the Printing Options
You can specify the printing options such as the color mode or 2-sided printing.

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop (x86) as an example:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify the printing options.

5 Enter root as the user name, and enter the administrator password.

6 Click the Administration drop-down list box, and then select Modify Printer.

7 Specify the required settings, and click Continue or Modify Printer.
The message Printer xxx has been modified successfully. appears.

The setting is complete. 
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• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Open a web browser.

2 Enter http://localhost:631/admin in the address bar, and press the Enter key.

3 Enter root as the user name, and enter the administrator password.
The CUPS window appears.

NOTE: 
• Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 

"Setting the Password for Authority as the Printer Administrator" on page 127.

4 Click Manage Printers.

5 Click Modify Printer on the printer.

6 Specify the required settings, and click Continue.

7 Enter root as the user name, enter administrator password and click OK.
The message Printer xxx has been modified successfully. appears.

The setting is complete. Execute printing from the application.

Setting the Password for Authority as the Printer 
Administrator

For SUSE Linux Enterprise Desktop 10 and 11, you must set the password for authority as the printer administrator 
to do operations as the printer administrator.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications... and select GNOME Terminal on Application Browser.

2 Enter the following command in the terminal window.

su

(Enter the administrator password)

lppasswd -g sys -a root

(Enter the password for authority as the printer 
administrator after the Enter password prompt.)

(Reenter the password for authority as the printer 
administrator after the Enter password again prompt.)
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Uninstalling the Print Driver

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop (x86) as an example:

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications... and select GNOME Terminal on Application Browser.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

rpm -e Fuji_Xerox-DocuPrint_CM405-x.x-x.noarch

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

rpm -e Fuji_Xerox-DocuPrint_CM405-x.x-x
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Configuring Wireless Settings (Windows & Mac OS X)
This section includes:

• "Determining the Wireless Network Settings" on page 129
• "Configuring the Optional Wireless Printer Adapter" on page 130
• "Reconfiguring the Wireless Settings" on page 139

Determining the Wireless Network Settings
You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, 
contact your network administrator.

Wireless Settings SSID Specifies the name that identifies the wireless network with up to 32 
alphanumeric characters.

Network Mode Specifies the network mode from Ad-hoc or Infrastructure.

Security Settings Security Selects the encryption method from No Security, Mixed mode PSK*, 
WPA-PSK-TKIP, WPA2-PSK-AES, and WEP.

Transmit Key Specifies the transmit WEP key from the list.

WEP Key Specifies the WEP key used through the wireless network only when 
WEP is selected as the encryption method.

Pass Phrase Specifies the pass phrase of alphanumeric characters from 8 to 63 
bytes long only when Mixed mode PSK*, WPA-PSK-TKIP, or 
WPA2-PSK-AES is selected as the encryption method.

* Mixed mode PSK automatically selects an available encryption method from WPA-PSK-TKIP, WPA-PSK-AES, or 
WPA2-PSK-AES.
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Configuring the Optional Wireless Printer Adapter
This section describes how to configure a wireless printer adapter through Easy Install Navi, operator panel and 
CentreWare Internet Services.
You can select a method to configure a wireless printer adapter from the following:

IMPORTANT: 
• Ensure that the Ethernet cable has been disconnected from the printer before you configure the wireless settings other than 

through Ethernet cable and CentreWare Internet Services.

NOTE: 
• Before you configure the wireless settings on the operator panel, you need to set up the wireless network settings on your 

computer. For details, refer to the manuals provided with the wireless LAN access point or if your computer provides a 
wireless adapter tool, configure the wireless settings using that tool.

• If the Panel Lock Set is set to Enable, you need to enter the four digit passcode to enter the Admin Settings menu.

• Using Wizard Setup to Configure a Wireless Printer Adapter (Windows 
Only)

You can configure the wireless adapter with the following connection methods:
• USB cable
• WPS-PBC
• WPS-PIN
• Operator Panel
• Ethernet Cable
• CentreWare Internet Services

Wizard Setup through
(Windows only)

USB Cable (recommended)

WPS-PBC*1

WPS-PIN*2*3

Operator Panel*3

Ethernet Cable

CentreWare Internet Services

Non-Wizard Setup through WPS-PBC*3

WPS-PIN*2*3

Operator Panel

CentreWare Internet Services

*1 WPS-PBC (Wi-Fi® Protected Setup-Push Button Configuration) is a method to authenticate and register devices 
required for wireless configuration, by pressing the button provided on the access point via wireless routers, and 
then performing WPS-PBC setting on the operator panel. This setting is available only when the access point 
supports WPS.

*2 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register 
devices required for wireless configuration, by entering PIN assignments in the printer and computer. This 
setting, performed through access point, is available only when the access points of your wireless router supports 
WPS.

*3 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, 
WPA-PSK AES, WPA2-PSK-AES, WPA-PSK-TKIP, Open (No Security).
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The following procedure uses USB cable for connection method as an example.

1 Insert the Driver CD Kit provided with the printer in your computer. Easy Install Navi launches automatically.

2 Click Optional Accessories Setup.

3 Click Wireless Network Kit b/g/n.
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4 Click Start wireless settings.

5 Click Wireless Configuration.
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6 Select Wizard, and then click Next.

7 Click Connect the wireless printer adapter.

The instruction video starts.

Follow the on-screen instructions to configure wireless settings.
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• Using Non-Wizard Setup to Configure a Wireless Printer Adapter
For Mac OS X, you can configure a wireless settings only through non-wizard setup.

NOTE: 
• The optional wireless printer adapter must be installed on the printer. For details about installing a wireless printer adapter, 

see "Installing the Optional Wireless Printer Adapter" on page 68.

You can configure the wireless printer adapter with the following connection methods:
• WPS-PBC
• WPS-PIN
• Operator Panel
• CentreWare Internet Services

WPS-PBC
You can start Push Button Control only from the operator panel.

NOTE: 
• WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for 

wireless configuration by pressing the button provided on the access point via wireless routers, and then performing 
WPS-PBC setting on the operator panel. This setting is available only when the access point supports WPS.

1 Press the  (System) button.

2 Select Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select WPS Setup.

7 Select Push Button Control.

8 Select Start Configuration.

9 Ensure that the message Setting WPS is displayed, and start pressing the button on the wireless LAN access 
point, within two minutes of the step 8 operation.

NOTE: 
• For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 

access point.
When the WPS operation is successful and the printer is rebooted, wireless settings are correctly configured.
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WPS-PIN
The PIN code of WPS-PIN can only be configured from the operator panel.

NOTE: 
• WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required 

for wireless configuration by entering PIN assignments to a printer and computer. This setting, performed through an access 
point, is available only when the access points of your wireless router supports WPS.

• Before WPS-PIN starts, you will need to enter your PIN code at the web page of the wireless LAN access point. For details, 
refer to the manuals provided with the wireless LAN access point.

1 Press the  (System) button.

2 Select Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select WPS Setup.

7 Select PIN Code.

8 Write down the displayed 8-digit PIN code or select Print PIN Code. The PIN code is printed.

9 Select Start Configuration.

10 Ensure that the message Setting WPS is displayed, and enter the PIN code displayed on step 8 into the web 
page of the wireless LAN access point.

NOTE: 
• For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 

access point.
When the WPS operation is successful and the printer is rebooted, wireless settings are correctly configured.
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Operator Panel
Auto SSID Setup 

1 Press the  (System) button.

2 Select Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select Wireless Setup Wizard.
The printer automatically searches the access points on wireless network.

7 Select the desired access point.
If the desired access point does not appear, see "Manual SSID Setup" on page 137.

NOTE: 
• Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the router.

8 Select Next.

9 Enter the WEP key or pass phrase.
When the encryption method of the selected access point is WEP in step 7:

a Select the Enter Key text box, and then enter the WEP key.
b Select OK.
When the encryption method of the selected access point is WPA, WPA2 or Mixed in step 7:

a Select the Enter Password text box, and then enter the pass phrase.
b Select OK.
The Restart System message appears.

10 Turn off the printer, and turn it on again to apply the settings.
Wireless settings are correctly configured.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.
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Manual SSID Setup

1 Press the  (System) button.

2 Select Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select Wireless Setup Wizard.

7 Select the Manual SSID Setup check box, and then select Next.

8 Enter the SSID, and then select Next.

9 Select the network mode from Infrastructure or Ad-hoc depending on your environment, and then select 
Next.
When you select Infrastructure, proceed to step 10.

When you select Ad-hoc, proceed to step 11.

10 Select the encryption method from Mixed mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or WEP.

IMPORTANT: 
• Be sure to use one of the supported encryption methods to protect your network traffic.
To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:

a Select the desired encryption method.
b Select the Enter Password text box, and then enter the pass phrase.
c Select OK.
To use WEP encryption:

a Select WEP.
b Select the Enter WEP Key text box, and then enter the WEP key.
c Select Transmit Key, and then select the desired transmit key from Auto or WEP Key 1 to WEP Key 4.
d Select OK twice.
The Restart System message appears.

Proceed to step 12.

11 Select WEP for encryption method.

IMPORTANT: 
• Be sure to use one of the supported encryption methods to protect your network traffic.

12 Select the Enter WEP Key text box, and then enter the WEP key.

13 Select OK.

14 Select Transmit Key, and then select the desired transmit key from WEP Key 1 to WEP Key 4.

15 Select OK.
The Restart System message appears.

16 Turn off the printer, and turn it on again to apply the settings.
Wireless settings are correctly configured.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.
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CentreWare Internet Services

1 Ensure that the printer is turned off and the wireless printer adapter is connected to the printer.

2 Connect the printer to the network with an Ethernet cable.
For details about connecting the Ethernet cable, see "Connecting Printer to Computer or Network" on page 94.

3 Turn on the printer.

4 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

5 Click the Properties tab.

6 Click Wireless.

7 Enter the SSID in the SSID text box.

8 Select Ad hoc or Infrastructure in the Network Type drop-down menu.

9 Select the encryption method from WEP 128-bit HEX (26 Bytes), WEP 128-bit ASCII (13 Bytes), WEP 64-bit 
HEX (10 Bytes), WEP 64-bit ASCII (5 Bytes), WPA-PSK AES/WPA2-PSK AES, WPA-PSK TKIP, and Mixed 
Mode PSK in the Encryption drop-down menu, and then set each item for the encryption method selected.

IMPORTANT: 
• Be sure to use one of the supported encryption methods to protect your network traffic.

NOTE: 
• For details on each item, see the Help on CentreWare Internet Services.

10 Click Apply to apply the settings.

11 Turn off the printer, disconnect the Ethernet cable and turn it on again.
Wireless LAN connection setting is complete.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.
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Reconfiguring the Wireless Settings
To change the wireless setting through the wireless connection from your computer, perform the following.

NOTE: 
• Ensure that the wireless connection setting is completed in "Configuring the Optional Wireless Printer Adapter" on page 130.
• The following settings are available when the network mode is set to infrastructure in "Configuring the Optional Wireless 

Printer Adapter" on page 130.

1 Check the IP address of the printer.
a On the operator panel, press the  (System) button.
b Select Report / List.
c Select System Settings, and then select Print.

The System Settings page is printed.

d Confirm the IP address next to IP Address under Network Setup on the System Settings page.

2 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

3 Click the Properties tab.

4 Click Wireless.

5 Change the wireless settings of the printer.

6 Click Apply to apply the settings.

7 Reboot the printer.

8 Change the wireless settings on your computer or access point accordingly.

NOTE: 
• To change the wireless settings on your computer, refer to the manuals provided with the wireless LAN access point or if your 

computer provides a wireless adapter tool, change the wireless settings using that tool.
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5
Printing Basics

This chapter includes:
• "About Print Media" on page 142
• "Supported Print Media" on page 145
• "Loading Print Media" on page 149
• "Setting Paper Sizes and Types" on page 157
• "Printing" on page 158
• "Printing With Web Services on Devices (WSD)" on page 179
• "Using Digital Certificates" on page 181
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About Print Media
This section includes:

• "Print Media Usage Guidelines" on page 142
• "Print Media That Can Damage Your Printer" on page 143
• "Print Media Storage Guidelines" on page 143
• "Duplex Automatic Document Feeder (DADF) Guidelines" on page 144

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or printer failure. 
To achieve the best performance from your printer, we recommend you to use only the paper described in this 
section.
When using paper other than that recommended, contact the Fuji Xerox local representative office or an authorised 
dealer.

Print Media Usage Guidelines
The printer tray accommodates various sizes and types of paper and other specialty media. Follow these guidelines 
when loading paper and media in the tray:

• Envelopes can be printed from the bypass tray.
• Fan paper or other specialty media before loading in the paper tray.
• Labels can be printed from the bypass tray.
• Do not print on label stock once a label has been removed from a sheet.
• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.
• Print all envelopes single-sided only. 
• Some wrinkling and embossing may occur when printing envelopes.
• Do not overload the paper tray. Do not load print media above the fill line on the inside of the width guides.
• Adjust the width guides to fit the paper size.
• If excessive jams or wrinkles occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 150
• "Loading Print Media in the Bypass Tray" on page 153
• "Loading Envelope in the Bypass Tray" on page 154
• "Printing on Custom Size Paper" on page 173

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 

occurs, it may cause short-circuit and eventually a fire accident.
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Print Media That Can Damage Your Printer
The following paper types are not recommended for use with the printer:

• Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, 
carbonless copy paper (CCP), or no carbon required (NCR) paper.

• Preprinted paper with chemicals that may contaminate the printer.
• Preprinted paper that can be affected by the temperature in the fusing unit.
• Preprinted paper that requires a registration (the precise print location on the page) greater than ±0.09 inches, 

such as optical character recognition (OCR) forms.
In some cases, you can adjust registration with your software program to successfully print on these forms.

• Coated paper (erasable bond), synthetic paper, thermal paper, and short grain paper.
• Rough-edged, rough or heavily textured surface paper, or curled paper.
• Recycled paper containing more than 25% post-consumer waste that does not meet DIN 19 309.
• Multiple-part forms or documents.
• Print quality may deteriorate (blank spaces or blotches may appear in the text) when you print on talc or acid 

paper.

Print Media Storage Guidelines
For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print 
quality.

• Store print media in an environment where the temperature is approximately 70 °F/21 °C and the relative 
humidity is 40%.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to damage from 
ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is particularly 
damaging to paper items. The intensity and length of exposure to visible light on paper items should be 
reduced as much as possible.

• Maintain constant temperature and relative humidity.
• Avoid attics, kitchens, garages, and basements for storing print media. 
• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.
• Avoid having food or drinks in the area where print media is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the 

original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that 
protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag and reseal it for 
protection. Some specialty media is packaged inside resealable plastic bags.

• Do not place anything on top of the print media packages.

WARNING:
• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 

occurs, it may cause short-circuit and eventually a fire accident.
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Duplex Automatic Document Feeder (DADF) Guidelines
The DADF accommodates the following original sizes:

• Width: 139.7–215.9 mm (5.5–8.5 inches)
• Length: 139.7–355.6 mm (5.5–14 inches)

The weight range includes 60–125 gsm.
Follow these guidelines when loading original documents into the DADF:

• Load documents face up so that the top of the document enters the printer first.
• Place only loose sheets of paper in the DADF.
• Adjust the document guides so that they fit against the documents.
• Insert paper in the document feeder tray only when the ink on the paper is completely dry.
• Do not load documents above the MAX fill line. You can load up to 50 sheets of 75 gsm (20 lb) documents.

NOTE: 
• You cannot load the following documents in the DADF. Be sure to place them on the document glass.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Supported Print Media
Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to your printer. To 
use the features of this printer effectively, use the suggested print media that is recommended here.

IMPORTANT: 
• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the Fuji Xerox local 

representative office or an authorised dealer.

Usable Print Media
The types of print media that can be used on this printer are as follows:

Bypass Tray

*:XML Paper Specification (XPS) driver does not support custom size paper.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Com 10 Envelope SEF (4.125 × 9.5 inches)

Monarch Envelope SEF (3.875 × 7.5 inches)

DL Envelope SEF (110 × 220 mm)

C5 Envelope SEF (162 × 229 mm)

Custom size*:
Width: 76.2–215.9 mm (3–8.5 inches)
Length: 127–355.6 mm (5 –14 inches)

Paper Type Plain (Lightweight)

Plain (Heavyweight)

Other Type

Lightweight Cardstock

Heavyweight Cardstock

Light Glossy Cardstock

Heavy Glossy Cardstock

Labels (Lightweight)

Labels (Heavyweight)

Envelope

Letterhead

Hole Punched

Colored

Loading Capacity 150 sheets of standard paper
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Standard 550 Sheet Tray and Optional 550 Sheet Feeder

*:XML Paper Specification (XPS) driver does not support custom size paper.

NOTE: 
• SEF indicates the paper feed direction; SEF stands for short-edge feed.
• For Plain and Label paper, you can set the paper density by selecting Adjust Paper Type (Lightweight or 

Heavyweight) under Maintenance from the operator panel. Once you set the Adjust Paper Type settings, the 
printer uses the settings for Plain and Label paper.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 150
• "Loading Letterhead in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 152
• "Loading Print Media in the Bypass Tray" on page 153
• "Loading Envelope in the Bypass Tray" on page 154
• "Loading Letterhead in the Bypass Tray" on page 155

Printing on print media that differs from the paper size or paper type selected on the print driver, or loading print 
media into an unsuitable paper tray for printing, may lead to paper jams. To ensure that printing is correctly done, 
select the correct paper size, paper type, and paper tray.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Custom size*:
Width: 148–215.9 mm (5.83–8.5 inches)
Length: 210–355.6 mm (8.27 –14 inches)

Paper Type Plain (Lightweight)

Plain (Heavyweight)

Other Type

Lightweight Cardstock

Heavyweight Cardstock

Light Glossy Cardstock

Heavy Glossy Cardstock

Letterhead

Hole Punched

Colored

Loading Capacity 550 sheets of standard paper



Printing Basics 147

Standard Paper and Tested Paper
The following paper and media are standard or usable for the printer.
When you print a generally used paper (which called general paper), please use a paper that suits the standard. To 
print clearly, Fuji Xerox recommends the standard paper shown in the following table. For information about the 
other paper and media, contact Fuji Xerox Customer Support Center.

Paper Name Size Weight Paper Type Notes
Standard 
Paper

Fuji Xerox P A4 64 gsm Plain (Lightweight) Medium-thickness paper 
for in-house documents 
and general office use.

Fuji Xerox C2 A4 70 gsm Plain (Lightweight) Paper for general office 
use with minimum 
see-through.

XeroxBusiness4200 Letter 20 lb Plain (Heavyweight)

Xerox Color Xpressions 
Select

Letter 24 lb Plain (Heavyweight)

Supported 
Paper

XeroxBusiness4200 Legal 20 lb Plain (Heavyweight)

Hammermill Tidal MP 
20lb 8.5 x 11

Letter Plain (Heavyweight)

Cascade X-9000 Folio Plain (Heavyweight)

Cascade X-9000 Letter Plain (Heavyweight)

Xerox Color Xpressions 
Select

Legal 24 lb Plain (Heavyweight)

XeroxBusiness4200 Letter Plain (Heavyweight)

Hammermill Writing 
Bond

Letter Plain (Heavyweight)

Hammermill Laser Print Letter Plain (Heavyweight)

Weyerhaeuser First 
Choice (No. 1 bond acid 
free)

Letter Plain (Heavyweight)

GP Laser1000 Executive Plain (Heavyweight)

Xerox Color Xpressions 
Elite

Letter 28 lb Plain (Heavyweight)

XeroxBusiness4200 Letter Plain (Heavyweight)

Fuji Xerox P B5 64 gsm Plain (Lightweight) Medium-thickness paper 
for in-house documents 
and general office use.

Fuji Xerox P A5 Plain (Lightweight)

Fuji Xerox FR A4 64 gsm Plain (Lightweight) Environmentally-consciou
s paper (50% of pulp 
sourced from 
plantation-grown trees + 
50% of recycled pulp).

Fuji Xerox G70 A4 67 gsm Plain (Lightweight) Recycled copy/printer 
paper compounded 70% 
of recycled pulp.

Fuji Xerox C2R A4 70 gsm Plain (Lightweight) 70% recycled pulp paper.

Xerox Premier 80 A4 80 gsm Plain (Heavyweight)

Xerox Business 80 Plain (Heavyweight)

Data Copy Plain (Heavyweight)

Steinbeis Recycling 
Copy

Plain (Heavyweight)

Yes Bronze Plain (Heavyweight)

Xerox Premier A5 Plain (Heavyweight)



148 Printing Basics

Supported 
Paper

Fuji Xerox J A4 82 gsm Plain (Heavyweight) Hi-quality paper suitable 
for a variety of uses, 
including project 
proposals and color 
samples.

Fuji Xerox J B5 Plain (Heavyweight)

Xerox Premier 90 A4 90 gsm Plain (Heavyweight)

Xerox-90 Colotech A4 Plain (Heavyweight)

Fuji Xerox J coat A4 95 gsm Lightweight Glossy 
Cardstock

Print one sheet at a time 
using the bypass tray.

Fuji Xerox JD A4 98 gsm Double-sided paper 
suitable for a variety of 
uses, including brochures 
and booklet.

Fuji Xerox JD B5

JD coat 104.7 A4 105 gsm Lightweight Glossy 
Cardstock

Print one sheet at a time 
using the bypass tray.

Chuan Mei 70 gsm A4 70 gsm Plain (Lightweight)

EXCEL A4 A4 80 gsm Plain (Heavyweight)

Special 
Paper

Label No cut A4 Label Labels (Lightweight)

Label No cut A4 Labels (Lightweight)

Avery Labels 5165 Letter Labels (Lightweight)

Columbia C0131/C0125 Com-10 Envelope Envelope

Monroe Brand Monarch 
(98.4 × 
190.5)

Envelope

River Series DL (110 × 
220)

Envelope

River Series C5 (162 × 
229)

Envelope

Colorpaper Cream A4 64 gsm Plain (Lightweight)

Colorpaper Light Blue Plain (Lightweight)

Colorpaper Pink Plain (Lightweight)

Colorpaper Light Green Plain (Lightweight)

Premier TFC 160 A4 160 gsm Lightweight 
Cardstock

Xerox Color Xpression 
Planet 20

Letter 65 lb Heavyweight 
Cardtstock

Recycled Business Card 
White

A4 190 gsm Heavyweight 
Cardtstock

Classic Crest Super 
Smooth Cover 80lb

Letter 216 gsm Heavyweight 
Cardtstock

Paper Name Size Weight Paper Type Notes



Printing Basics 149

Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.
Before loading any print media, identify the recommended print side of the print media. This information is usually 
indicated on the print media package.

Capacity
The standard 550 sheet tray and the optional 550 sheet feeder can hold:

• 550 sheets of the standard paper.
The bypass tray can hold:

• 150 sheets of the standard paper.

Print Media Dimensions
The maximum dimensions of print media that the standard 550 sheet tray and the optional 550 sheet feeder can 
handle are:

• Width: 148 mm (5.83 inches) to 215.9 mm (8.5 inches)
• Length: 210 mm (8.27 inches) to 355.6 mm (14 inches)

The maximum dimensions of print media that the bypass tray can handle are:
• Width: 76.2 mm (3 inches) to 215.9 mm (8.5 inches)
• Length: 127 mm (5 inches) to 355.6 mm (14 inches)
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Loading Print Media in the Standard 550 Sheet Tray and 
the Optional 550 Sheet Feeder
NOTE: 
• To avoid paper jams, do not remove the tray while printing is in progress.
• Use only laser print media. Do not use ink jet print media in your printer.

1 Pull the tray out of the printer about 200 mm.

2 Hold the tray with both hands, and remove it from the printer.

3 Adjust the paper guides.

NOTE: 
• When loading Legal size or user-specified print media, slide the extendable part of the tray while pinching the lever.
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4 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level 
surface.

5 Load the print media into the tray with the recommended print side facing up.

NOTE: 
• Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.
• When loading coated paper, load coated paper one sheet at a time.

6 Align the width guides and length guide against the edges of the print media.

7 After confirming that the guides are securely adjusted, insert the tray into the printer.

NOTE: 
• If the front side of the tray is extended, the tray protrudes when it is inserted into the printer.

8 On the prompt screen displayed on the LCD panel, select Size.

9 Select the appropriate paper size.
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10 Select Type.

11 Select the appropriate paper type.

12 Select OK.

Loading Letterhead in the Standard 550 Sheet Tray and the 
Optional 550 Sheet Feeder
When you use the standard 550 sheet tray and the optional 550 sheet feeder, letterhead and hole punched paper 
must be inserted top edge first with the print side facing up.
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Loading Print Media in the Bypass Tray
1 Gently pull open the bypass tray cover.

2 Extend the extension tray as necessary.

3 Slide the width guides to the edge of the tray. The width guides should be fully extended.

4 Insert all media face up and top edge first into the bypass tray.

NOTE: 
• Do not force the print media into the bypass tray.
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5 Slide both width guides until they rest lightly against the edge of the print media stack.

NOTE: 
• Do not force the print media into the bypass tray.

6 On the prompt screen displayed on the LCD panel, specify whether to use the driver setting for the paper size 
and type.
To use the driver setting, ensure that the Use Driver Settings for Print Job check box is selected 
and go to step 11.

To specify the setting on the operator panel, clear the Use Driver Settings for Print Job check box 
and go to step 7.

7 Select Size.

8 Select the appropriate paper size.

9 Select Type.

10 Select the appropriate paper type.

11 Select OK.

Loading Envelope in the Bypass Tray
Use the following guidelines when loading envelopes in the bypass tray:

IMPORTANT: 
• Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage 

to the printer.

NOTE: 
• The maximum height (quantity) of envelopes that can be loaded in the bypass tray is approximately 15 mm (0.59 inches) (15 

envelopes).
• If you do not load envelopes in the bypass tray right after they have been removed from the packaging, they may bulge. To 

avoid jams, press firmly across the whole envelopes to flatten them as shown below before loading the envelopes in the 
bypass tray.
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• Com 10, Monarch, or DL
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the left 
when you face towards the printer.

• C5
Load the envelopes short edge feed with the flaps open or closed and the print side up.
Ensure that the flaps come at the bottom with the flaps open or at the top with the flaps closed when you face 
towards the printer.

Loading Letterhead in the Bypass Tray
When you use the bypass tray, letterhead and hole punched paper must be inserted top edge first with the print side 
facing up.
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Using the Bypass Tray
• Load only one size and type of print media during a single print job.
• To achieve the best possible print quality, use only high-quality print media that is designed for use in laser 

printer. For more guidelines on print media, see "Print Media Usage Guidelines" on page 142.
• Do not add or remove print media when there is still print media in the bypass tray or when the printer is printing 

from the bypass tray. This may result in a paper jam.
• Print media should be loaded with the recommended print side up and the top of the print media going into the 

bypass tray first.
• Do not place objects on the bypass tray. Also, avoid pressing down or applying excessive force on it.
• The icons on the bypass tray show how to load the bypass tray with print media, and how to turn an envelope 

for printing.

Linking Trays
When the optional 550 sheet feeder is installed on the printer, the printer automatically links the trays when you load 
the same size and type of print media in them. The first tray will be utilized until the media runs out after which the 
next tray will be used.

NOTE: 
• The print media should be the same size and type in each tray.
• The bypass tray cannot be linked to any of the tray.

After loading the selected trays with the same size and type of print media, select the Type setting in the Tray 
Settings menu for each tray.
To disable tray linking change the paper type in one of the trays to a unique value.

NOTE: 
• If different types of print media of the same size are loaded in each tray, the printer will automatically link them if the paper 

type is not specified in the print driver properties/preferences.
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Setting Paper Sizes and Types
When loading print media in the tray, set the paper size and type on the operator panel before printing.

See also: 
• "Understanding the Printer Menus" on page 290

This section includes:
• "Setting Paper Sizes" on page 157
• "Setting Paper Types" on page 157

Setting Paper Sizes
1 On the operator panel, press the  (System) button.

2 Select the Tools tab, and then select Tray Management.

3 Select Tray Settings.

4 Select the desired tray.

NOTE: 
• When you select Bypass Tray, the Use Driver Settings for Print Job check box is selected by default. To 

change the setting, clear the check box.

5 Select Size.

6 Select the desired paper size.

7 Select OK.

Setting Paper Types
IMPORTANT: 
• Paper type settings must match those of the actual print media loaded in the tray or the feeder. Otherwise, print-quality 

problems can occur.

1 On the operator panel, press the  (System) button.

2 Select the Tools tab, and then select Tray Management.

3 Select Tray Settings.

4 Select the desired tray.

NOTE: 
• When you select Bypass Tray, the Use Driver Settings for Print Job check box is selected by default. To 

change the setting, clear the check box. 

5 Select Type.

6 Select the desired paper type.

7 Select OK.
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Printing
This section covers how to print certain information from your printer and how to cancel a job.
This section includes:

• "Sending a Job to Print" on page 158
• "Canceling a Print Job" on page 159
• "Using the Stored Print Feature" on page 160
• "Direct Print Using the USB Storage Device" on page 163
• "Printing PDF Files Using PDF Bridge (Windows Only)" on page 164
• "Selecting Printing Options" on page 168
• "Printing Custom Size Paper" on page 171
• "Auditron" on page 175
• "Checking Status of Print Data" on page 176
• "Printing With AirPrint" on page 176
• "Printing a Report Page" on page 177
• "Printer Settings" on page 178

Sending a Job to Print
To support all of the printer features, use the print driver. When you choose Print from a software program, a window 
representing the print driver opens. Select the appropriate settings for the specific job that you are sending to print. 
Print settings selected from the driver override the default menu settings selected from the operator panel.
You may need to click Preferences from the initial Print box to see all of the available system settings you can 
change. If you are not familiar with a feature in the print driver window, open the Help for more information.
To print a job from a typical Microsoft® Windows® application:

1 Open the file you want to print.

2 From the application menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as appropriate (such as 
the pages you want to print or the number of copies).

4 Click Preferences to adjust system settings that are not available from the first screen, and then click OK. 

5 Click Print to send the job to the selected printer.

NOTE: 
• When you print on a small size medium such as an envelope, lift the operator panel so that you can easily remove the printed 

media from the output tray.
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Canceling a Print Job
There are several methods for canceling a job.
This section includes:

• "Canceling a Job From the Operator Panel" on page 159
• "Canceling a Job From a Computer Running Windows" on page 159

Canceling a Job From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Stop) button or select Delete.
Printing is canceled only for the current job. All the following jobs will continue to print.

To cancel a job before it has started printing:

1 Press the  (Job Status) button.
A list of print job appears.

2 Select the desired job to cancel.

3 Select Delete.

4 Select Delete Job.

Canceling a Job From a Computer Running Windows

• Canceling a Job From the Taskbar
When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.

1 Double-click the printer icon. 
A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press Delete key on the keyboard.

4 Click Yes on the Printers dialog box to cancel a print job.

• Canceling a Job From the Desktop

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server® 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®).

Click Start → Control Panel → Printers (for Windows Server 2008).

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound → Devices and Printers (for Windows 8).

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware → Devices and Printers (for Windows Server 2012).

A list of available printers appears.

2 Double-click the printer that you selected when you sent the job for print.
A list of print jobs appears in the printer window.
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3 Select the job you want to cancel.

4 Press Delete key on the keyboard.

5 Click Yes on the Printers dialog box to cancel a print job.

Using the Stored Print Feature
When you send a job to the printer, you can specify in the print driver to store the job in the memory or hard disk. 
When you are ready to print the job, go to the printer and use the operator panel menus to identify which job in the 
memory or hard disk you want to print.

NOTE: 
• The Stored Print feature is available when:

- The optional 512MB memory is installed.
- The RAM disk is enabled in the operator panel menu.
- RAM Disk is set to Installed in the print driver.

OR

- The optional hard disk unit is installed.
- Hard Disk is set to Installed in the print driver.

• The data in memory is cleared when the printer is turned off. The data on the optional hard disk unit is not cleared even when 
the printer is turned off.

The stored print feature includes the following job types:
• "Secure Print" on page 160
• "Sample Print" on page 160

Secure Print
You can store print jobs secured with a passcode in the memory or hard disk. Users with the passcode can print 
them from the operator panel. This feature can be used to print confidential documents. You can select whether to 
delete the stored job after printing. Otherwise, the stored jobs remain in the memory until you delete them from the 
operator panel or turn off the printer, or in the hard disk until you delete them from the operator panel.

NOTE: 
• Secure Print is available when you use the PCL 6 or PS driver.

Sample Print
The collated print job is stored in the memory or hard disk, but a single copy is printed automatically so you can 
check the print result. If you do not have problems with the print result, you can choose to print more copies. This 
prevents large number of misprinted copies from being printed at one time.

NOTE: 
• Sample Print is available when you use the PCL 6 or PS driver.

Send confidential data.

Enter the passcode from 
the operator panel.

Print data.

Confidential

Send data.

One set is 
printed.

Check if the print result 
is OK.

Print the rest of sets 
from the operator panel.
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Procedures for Printing Stored Print
The following are procedures for storing and printing jobs.

• Storing Print Jobs
For Secure Print, select Secure Print for Job Type and specify the user ID, passcode and job name by clicking 
Setup in the Paper/Output tab of the print driver. When you send the job to the printer, the job will be stored in the 
memory until you request to print from the operator panel or turn off the printer, or in the hard disk until you request 
to print it from the operator panel.
For Sample Print, select Sample Set for Job Type and specify the user ID and job name by clicking Setup in the 
Paper/Output tab of the print driver. When you send the job to the printer, the first set is printed. The remaining 
copies will be stored in the memory until you select to print them on the operator panel or turn off the printer, or in the 
hard disk until you select to print them on the operator panel. 

NOTE: 
• If a print job is too large for the memory or hard disk available, the printer may display error messages.
• If a document name is not assigned to your print job in the print driver, the job's name will be identified using the printer's time 

and date of submission to distinguish it from other jobs you have stored under your name.

• Printing the Stored Jobs
Once jobs are stored, you can use the operator panel to specify printing. 

Printing the Secure Print Job
Secure Print requires the passcode you specified in the driver when you sent the job.
To print the Secure Print jobs, use the procedure below.

1 Press the  (Job Status) button.

2 Select Secure Print.

3 Select a user ID you specified in the print driver.

4 Enter the passcode you specified in the print driver using the number pad, and select OK.
For details about specifying the passcode, see "Specifying Your Passcode on the Operator Panel (Secure 
Print)" on page 162.

5 Select the document you want to print.

NOTE: 
• By default, the driver setting is used for the number of copies to print. You can select Quantity to change the setting.

6 Select Print.

NOTE: 
• If you want to delete the data in the memory or hard disk after printing, select the Print and Delete check box.

7 Select OK.
The stored document will be printed.

Printing the Sample Print Job
To print the Sample Print jobs, use the procedure below.

1 Press the  (Services) button.
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2 Select Print from.

3 Select a user ID you specified in the print driver.

4 Select the document you want to print.

NOTE: 
• By default, the driver setting is used for the number of copies to print. You can select Quantity to change the setting.

5 Select Print.

NOTE: 
• If you want to delete the data in the memory or hard disk after printing, select the Print and Delete check box.

6 Select OK.
The stored document will be printed.

• Specifying Your Passcode on the Operator Panel (Secure Print)
When you select your user ID for Secure Print, a screen to enter the passcode appears.
Use the number pad to enter the numeric passcode you specified in the print driver. The passcode you entered will 
be displayed as asterisks (*******) to ensure confidentiality.
If you enter an invalid passcode, the message Invalid Passcode Please re-enter 4 digit PIN appears. 
Wait three seconds, or select Close to return to the screen to enter the passcode.
When you enter a valid passcode, you have access to all print jobs matching the user name and passcode you 
entered. The print jobs matching the passcode you entered appear on the screen. You can then choose to print or to 
delete jobs matching the passcode you entered. (See "Printing the Stored Jobs" on page 161 for more information.)

• Deleting Stored Jobs
A job that has been stored will be deleted after printing if selected to do so on the operator panel. Otherwise, the job 
remains stored until you delete them on the operator panel.

NOTE: 
• The data in the memory is cleared when the printer is turned off. The data on the optional hard disk unit is not cleared even 

when the printer is turned off.
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Direct Print Using the USB Storage Device
The Print from USB Memory feature allows you to print files stored in a USB storage device by operating from the 
operator panel.
IMPORTANT: 
• To prevent damage to your printer, DO NOT connect any device other than USB storage device to the front USB port of the 

printer.
• DO NOT remove the USB storage device from the front USB port until the printer has finished printing.

NOTE: 
• If the Service Lock setting for Print from USB is set to Password Locked or Color Password Locked, you need 

to enter the four digit passcode to use the Print from USB Memory feature. If the Service Lock setting for Print from 
USB is set to Disabled, the Print from USB Memory feature is disabled and the menu is not displayed on the screen. For 
details, "Service Lock" on page 327.

The front USB port of the printer is designed for USB 2.0 devices. You must use only an authorised USB storage 
device with an A plug type connector. Use only a metal shielded USB storage device.

To print a file in a USB storage device:

1 Press the  (Services) button.

2 Insert a USB storage device to the front USB port of the printer.

3 Select Print a File.

4 Select the desired file, and then select OK.

NOTE: 
• Only the following characters are displayed on the operator panel:

a b c d e f g h i j k l m n o p q r s t u v w x y z A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9 $ % ’ ‘ - @ {} ~ ! # ( ) & _ ^

5 Select printing options as required.

6 Press the  (Start) button to begin printing.

NOTE: 
• Color printing is secured with a passcode if the Service Lock setting for Print from USB is set to Color 

Password Locked. If you set Output Color to Full Color and the Service Lock setting for Print from USB 
to Color Password Locked, you will need to enter the four digit passcode after pressing the  (Start) button.

• You can print files scanned and stored using the Scan to USB Memory feature. Files saved without using the feature 
such as files created by user may not be printed properly.

IMPORTANT: 
• Before removing the USB storage device, ensure that the printer is not accessing the USB storage device. If you remove the 

USB storage device while the printer is accessing, the data in the USB storage device or the USB storage device itself may be 
destroyed.

A plug type
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Supported File Formats
Files in the following file formats can be printed directly from a USB storage device. (About what you saved in Scan 
to USB function of this printer. Other than that is not guaranteed.)

• PDF
• TIFF
• JPEG

Printing PDF Files Using PDF Bridge (Windows Only)
The printer has the PDF Bridge feature, which enables you to print PDF files directly without a print driver. Printing 
PDF files without a print driver is much easier and faster when compared to printing with a print driver. This section 
describes how to print PDF files using PDF Bridge.
This section includes:

• "Supported PDF Files" on page 164
• "Using the ContentsBridge Utility" on page 164
• "Using the Commands" on page 164

Supported PDF Files
PDF files created on the following versions of Adobe® Acrobat® can be printed using PDF Bridge.

• Adobe Acrobat 5.X (excluding some of the features added to PDF1.4)
• Adobe Acrobat 6.X (excluding some of the features added to PDF1.5)
• Adobe Acrobat 7.X (excluding some of the features added to PDF1.6)

NOTE: 
• Some PDF files cannot be printed depending on how they are created. In such case, open the files and print them using a 

print driver.

Using the ContentsBridge Utility
The ContentsBridge Utility is software that enables direct printing of PDF files by simply dragging and dropping files 
onto the icon. To use the ContentsBridge Utility, refer to the manual included on the Driver CD Kit.

Using the Commands
You can also print PDF files using the lpr or ftp command. When you print using these commands, the following PDF 
settings on the operator panel become effective.

• Quantity
• 2 Sided Print
• Print Mode
• PDF Password
• Collation
• Output Size
• Layout
• Output Color

NOTE: 
• When you print using the lpr command, the print quantity must be set also using lpr command. In such case, the Quantity 

setting on the operator panel becomes invalid. If you do not specify the quantity using the lpr command, the printer recognizes 
the quantity as "1 set".

• To print PDF files using the lpr or ftp command, you must enable the printer's LPD or FTP port using the operator panel or 
CentreWare Internet Services (default: Enable).
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Using the lpr command
NOTE: 
• For Windows Vista or later, enable the lpr command first. The following procedure uses Windows 7 as an example.

a Click Start → Control Panel → Programs → Turn Windows features on or off.
b In the Windows Features dialog box, select the LPR Port Monitor check box under Print and Document 

Services.
In the command prompt, enter the lpr command as described in the following example:
Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

Using the ftp command
In the command prompt, enter the ftp command as described in the following example:
Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

C:\> lpr -S 192.168.1.100 -P lp event.pdf

C:\> ftp 192.168.1.100
Connected to 192.168.1.100.

220 FUJI XEROX DocuPrint XXXX

User (192.168.1.100:(none)):

331 Password required

Password:

230 Logged in

ftp> bin
200 Command successful

ftp> put event.pdf
200 Command successful

150 Opening data connection

226 Transfer complete

ftp: xxxxx bytes sent in xxxSeconds xxxxxkbytes/sec.

ftp>
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Duplex Printing
Duplex printing (or 2-sided printing) allows you to print on both sides of a sheet of paper. A4, A5, B5, Letter, Folio, 
Legal and Executive paper sizes are acceptable.
This section includes:

• "Using 2-Sided Print" on page 166
• "Using Booklet Print" on page 167

Using 2-Sided Print
The following procedure uses the PCL 6 driver as an example.

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound → Devices and Printers (for Windows 8).

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware → Devices and Printers (for Windows Server 2012).

A list of available printers appears. 

2 Right-click the printer and select Printing preferences.
The Paper/Output tab appears.

3 From the drop-down menu of Paper, select Select By Tray and then select Automatically Select, Tray 1, 
Tray 2, or Bypass Tray.
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4 From 2-Sided Print, select 2-Sided Print or 2-Sided Print, Flip on Short Edge.

5 Click OK.

Using Booklet Print
To use the Booklet Print feature, select the Booklet Layout check box in the Layout/Watermark tab of the printer's 
Printing Preferences dialog box. Click Booklet Creation for detailed settings. The binding position is automatically 
set to 2-Sided Print for the 2-Sided Print in the Paper/Output tab.

NOTE: 
• When the XML Paper Specification (XPS) driver or PS driver is used, the Booklet Print feature is not available.
• For details on the 2-Sided Print option, see "2-Sided Print" on page 167.

2-Sided Print Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for 
landscape orientation). The following illustration shows long-edge binding for portrait and landscape 
pages:

2-Sided Print, Flip 
on Short Edge

Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for 
landscape orientation). The following illustration shows short-edge binding for portrait and landscape 
pages:

Portrait Landscape

Portrait Landscape
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Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 168
• "Selecting Options for an Individual Job (Windows)" on page 168
• "Selecting Options for an Individual Job (Mac OS X)" on page 170

Selecting Printing Preferences (Windows)
Printing Preferences control all of your print jobs, unless you override them specifically for a job. For example, if you 
want to use duplex printing for most jobs, set this option in Printing Preferences.
To select Printing Preferences:

1 Click start → Printers and Faxes (for Windows XP).
Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound → Devices and Printers (for Windows 8).

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware → Devices and Printers (for Windows Server 2012).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing preferences.
The printer's Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 
• For more information about Windows print driver options, click Help on the print driver tab to view the help.

Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before sending the job to the 
printer. For example, if you want to use Photo print-quality mode for a particular graphic, select this setting in the 
driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select your printer and click Preferences to open the print driver.

3 Make selections on the driver tabs. 

NOTE: 
• When using the PCL 6 or PS driver, you can save current printing options with a distinctive name and apply them to other 

print jobs. Select either the Paper/Output, Image Options, Color Options, Layout/Watermark, or Advanced tab, 
and then click Save under Saved Settings on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.

5 Print the job.
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See the following table for specific printing options:
The table shown below uses the PCL 6 driver as an example.

Printing Options for Windows

Driver Tab Printing Options
Paper/Output tab • Job Type

• 2-Sided Print
• Paper

– Size
– Type
– Select By Tray
– Advanced Paper Selection
– Covers/Separators

• Output
• Output Color
• Saved Settings
• Envelope/Paper Setup Wizard
• Status
• Defaults
• Default All

Image Options tab • Toner Saver
• Application Reduce/Enlarge
• Image Shift Summary
• Defaults

Color Options tab • Output Color
• Output Recognition
• Image Quality
• Image Adjustment Mode
• Image Types
• Image Auto Correction
• Image Settings
• Color Balance
• Profile Settings
• Defaults

Layout/Watermark tab • Page Layout
– Pages Per Sheet (N-Up)
– Poster
– Booklet Layout

• Page Layout Options
• Background Form
• Watermark
• Annotation
• Defaults

Advanced tab • Advanced Settings
• Document Options
– Specify Font
– Paper/Output
– Image Options
– Layout/Watermark
– Others

• About
• Defaults
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the printer.

1 With the document open in your application, click File, and then click Print.

2 Select your printer from Printer.

3 Select the desired printing options from the menus and drop-down list boxes that are displayed.

NOTE: 
• In Mac OS® X, click Save As on the Presets menu to save the current printer settings. You can create multiple presets 

and save each with its own distinctive name and printer settings. To print jobs using specific printer settings, click the 
applicable saved preset in the Presets menu.

4 Click Print to print the job.
Mac OS X Print Driver Printing Options:
The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options
• Copies
• Collated
• Two-Sided
• Pages
• Paper Size
• Orientation

Layout • Pages per Sheet
• Layout Direction
• Border
• Two-Sided
• Reverse page orientation
• Flip horizontally

Color Matching • ColorSync
– Profile

• In printer

Paper Handling • Pages to Print
• Page Order
• Scale to fit paper size
• Destination Paper Size
• Scale down only

Paper Feed • All pages From
• First Page From
• Remaining From

Cover Page • Print Cover Page
• Cover Page Type
• Billing Info

Scheduler • Print Document
• Priority

Job Accounting • Account Mode
• User Details Setup

Job Type • Job Type
• Setup
• Defaults
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Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.
The way to load custom size paper is the same as the one to load standard size paper.

NOTE: 
• You can use custom size paper between the following ranges:

• For the standard 550 sheet tray and the optional 550 sheet feeder
- Width: 148 mm (5.83 inches) to 215.9 mm (8.5 inches)
- Length: 127 mm (5 inches) to 355.6 mm (14 inches)

• For the bypass tray
- Width: 76.2 mm (3 inches) to 215.9 mm (8.5 inches)
- Length: 210 mm (8.27 inches) to 355.6 mm (14 inches)

• XML Paper Specification (XPS) driver does not support custom size paper.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 150
• "Loading Print Media in the Bypass Tray" on page 153
• "Setting Paper Sizes and Types" on page 157

Image Options • Output Color
• Image Quality
• Brightness
• Basic Features/Advanced Features
• Image Type
• Image Adjustment
• Screen
• Color Balance
• Defaults

Watermark • Watermark
– Edit
– Delete
– New

• Print on Page 1 only
• Defaults

Printer Features • Feature Sets: General
– Gray Guaranteed
– Feed Orientation
– Paper Type
– Substitute Tray
– Custom Paper Auto Orientation
– Image Enhancement
– Draft Mode
– Skip Blank Pages
– Halftone Screen Lock
– High speed for monochrome documents
– Trapping
– Letterhead Duplex Mode

Summary

Item Printing Options
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Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 
• When setting the paper size on the print driver and the operator panel, be sure to specify the same size as the actual print 

media used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a bigger size 
when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section explains the 
procedure using Windows 7 and the PCL 6 driver as an example.
An administrator’s password only allows users with administrator rights to change the settings. Users without the 
rights of administrator can only view the contents.

1 Click Start → Devices and Printers.

2 Right-click the printer, and then select Printer properties.

3 Select the Device Settings tab.

4 Select Custom Paper Size and click Setup.

5 Select the Create a New Form check box.

6 Enter a name for the custom paper size in Name. Up to 31 characters can be used for the paper name.

7 Specify the values for Width and Length either by entering the number directly or using the up arrow and down 
arrow buttons.
The value for Width cannot be greater than that of Length, even if it is within the specified range.

NOTE: 
• You can switch the units by selecting either Millimeters or Inches under Units.
• If you do not want to share the custom paper size with other users, clear the Share it with Other Users check box.

8 Click Save.

9 If necessary, repeat steps 5 to 8 to define another custom size.

10 Click Close.

11 Click OK.
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Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.

• Using the Windows Print Driver
To print on custom size paper using the PCL 6 driver as an example:

NOTE: 
• The way to display the printer Properties/Printing Preferences dialog box differs according to the application software. 

Refer to the manual of each application software.

1 From the application menu, select Print.

2 Select your printer and click Preferences.

3 Select the Paper/Output tab.

4 From the drop-down menu of Paper, select Advanced Paper Selection.

5 Select the desired paper tray from Paper Tray.

NOTE: 
• If you select Bypass Tray, Bypass Feed Orientation appears. Specify the orientation of the paper set on the bypass 

tray.

6 Select the size of the original document from Original Document Size.

7 Specify Scale Options.
If you select the custom paper size from Original Document Size in step 6, select No Scaling and go to step 
9.

If you select the standard paper size from Original Document Size in step 6, select Automatically Scale and 
go to step 8.

8 Select the custom paper size from Output Paper Size.

9 Select the appropriate paper type from Paper Type.

10 Click OK twice.

11 Click Print in the Print dialog box to start printing.



174 Printing Basics

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select your printer from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.
A newly created setting “Untitled” is displayed in the list.

5 Double-click "Untitled" and enter the name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Make sure that your printer is selected in Printer.

12 Click Print to start printing.
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Auditron
Auditron contains an authentication function that can set limits on what processes can be used, as well as an 
account management that can be used to control usage based on authentication.
The following illustration shows how the printer works with Auditron. 

NOTE: 
• You can configure the printer's Auditron settings with CentreWare Internet Services. For more information, refer to the online 

Help of CentreWare Internet Services.
• To print using Auditron, you need to set the print driver. For more information, refer to the Help of the driver.

Registered user A
Registered user B

Can print up to 
10,000 pages in 
black and white

Print account report

Normal user D System administrator C

Can print up to 9,000 
pages in color or black 
and white

Cannot print if not a 
registered user, or if the 
printed pages exceeds the 
limit

Reference account report 
for each registered user
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Checking Status of Print Data
This section includes:

• "Checking Status (Windows Only)" on page 176
• "Checking Status in CentreWare Internet Services (Windows & Mac OS X)" on page 176

Checking Status (Windows Only)
Printer information and status can be checked with SimpleMonitor. By default, the Status Monitor window launches 
when printing and an error occurs. To display the Status Monitor window manually, double-click the SimpleMonitor 
printer icon  on the taskbar at the bottom right of the screen. From the displayed window, click the name of the 
desired printer listed.
For more information about SimpleMonitor, see Help: The following procedure uses Windows 7 as an example:

1 Click Start → All Programs.

2 Select Fuji Xerox.

3 Select SimpleMonitor for Asia-Pacific.

4 Select SimpleMonitor Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 86

Checking Status in CentreWare Internet Services (Windows & Mac 
OS X)
You can check the status of the print job sent to the printer at the Jobs tab of CentreWare Internet Services.

See also: 
• "Printer Management Software" on page 83

Printing With AirPrint
This section provides information for printing with AirPrint. AirPrint allows you to print through a network 
with iPad (all models), iPhone (3GS or  later), and iPod touch (3rd generation or later) running the latest 
version of iOS. AirPrint also allows you to accomplish basic network printing with Macintosh (Mac OS X 
10.7 or later) without installing additional drivers.

Setting Up AirPrint on Your Printer
To use AirPrint, Bonjour (mDNS) and IPP protocols are required on your printer. Make sure that Bonjour (mDNS) 
and IPP are set to Enable on the operator panel menu. For details, see "Protocols" on page 305. Bonjour (mDNS) 
and IPP can also be enabled by clicking Turn on AirPrint from the CentreWare Internet Services. Follow the 
procedure below to configure the environment settings for AirPrint from the CentreWare Internet Services.

1 Ensure that the printer is connected to the network.

2 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

3 When the CentreWare Internet Services opens, go to the page of AirPrint in Protocol Settings under the 
Properties tab. Click Turn on AirPrint in Enable AirPrint. The printer is ready for AirPrint.

NOTE: 
• If the Turn on AirPrint button is not active, it means that both Bonjour (mDNS) and IPP are already set to Enable on the 

operator panel menu and the printer is ready for AirPrint.
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Printing via AirPrint
The following procedure uses the iPhone running iOS 5 as an example.

1 Open your email, photo, web page, or document you want to print.

2 Tap the action icon .

3 Tap Print.

4 Select your printer and set printer options.

5 Tap Print.

NOTE: 
• To cancel the printing job, double click the Home button, tap the Print Center icon . If there are more than one job in 

the queue, select the job you want to cancel, then tap Cancel Printing.

Printing a Report Page
You can print a various types of reports and lists. For details on each report and list, see "Report / List" on page 290.
Taking the System Settings page as an example, this section describes how to print a report page.

Printing a System Settings Page
To verify detailed printer settings, print a System Settings page. A printed System Settings page also allows you to 
verify whether or not options have been installed properly. 

See also: 
• "Understanding the Printer Menus" on page 290

1 Press the  (System) button.

2 Select Report / List.

3 Select System Settings.

4 Select Print.

5 The System Settings page is printed.
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Printer Settings
You can select menu items and corresponding values from the operator panel.
When you first browse through the menus from the operator panel, you see a list of menu items. The values 
displayed on the right of each menu item are the factory default and original system settings.

NOTE: 
• Factory defaults may vary for different regions.

When you select a new value from the operator panel, the value selected is highlighted and is displayed on the right 
of the menu item in the previous screen to identify it as the current user setting.
These settings are active until new ones are selected or the factory defaults are restored.
To select a new value as a setting:

1 Press the  (System) button.

2 Select the Tools tab, and then select the desired menu.

3 Select the desired menu and menu item.
• If the selection is a menu, the menu is opened and the list of menu items appears.
• If the selection is a menu item, the list of setting values appears. (The current user setting is highlighted.)
A value can be:

• A phrase or word to describe a setting
• A numerical value that can be changed
• An On or Off setting

4 Select the desired value.
The selected value is highlighted.

NOTE: 
• Some menu items require you to use the screen keyboard or the number pad to enter the value.

5 Select OK.

6 Select the  button to return to the previous menu.
To continue setting other items, select the desired menu. To quit setting new values, select the  button. 

Driver settings may have precedence over the settings made on the operator panel.
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Printing With Web Services on Devices (WSD)
This section provides information for network printing with WSD, the new Microsoft protocol for Windows Vista, 
Windows Server 2008, Windows Server 2008 R2, Windows 7, Windows 8, and Windows Server 2012.

NOTE: 
• WSD stands for Web Services on Devices.

This section includes:
• "Adding Roles of Print Services" on page 179
• "Printer Setup" on page 180

Adding Roles of Print Services
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print services to the 
Windows Server 2008 or Windows Server 2008 R2 client.

• For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click 
Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, 
and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2012:

1 Click Server Manager of the start screen.

2 Select Add Roles and Features from the Manage menu.

3 Click Next on the Before You Begin window → Select installation type on the Installation Type window → 
Select destination server on the Server Selection window in the Add Roles and Features Wizard.

4 Select the Print and Document Services check box on the Server Roles window, and then click Next.

5 Select features on the Features window → Confirm installation selections on the Confirmation window.

6 Click Install.
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Printer Setup
You can install your new printer on the network using the Driver CD Kit that shipped with your printer, or using 
Microsoft Windows’ Add Printer wizard. The following procedure uses the PCL 6 driver as an example.

Installing a Print Driver Using the Add Printer Wizard
1 Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 

Windows Vista and Windows Server 2008).
For Windows 8 and Windows Server 2012

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel →  
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 
• In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/.
• If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter the 

printer's IP address manually, follow the instructions below.
For Windows Server 2008 R2, to create a WSD printer, you must be a member of Administrators group.
1 Click The printer that I want isn't listed. 
2 Select Add a printer using a TCP/IP address or hostname and click Next. 
3 Select Web Services Device from Device type.
4 Enter the printer's IP address in Hostname or IP address and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of the 
following:
- Establish the Internet connection so that Windows Update can scan your computer.
- Add the print driver to your computer.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator password or 
confirmation, enter the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Configure the option settings and print a test page to verify print installation.
a Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 

Windows Vista and Windows Server 2008).
For Windows 8 and Windows Server 2012

On the Windows desktop, right-click the bottom left corner of the screen, and then click Control Panel  →  
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista 
and Windows Server 2008).
On the Configuration tab, click Installable Options to configure the option settings, and then click Apply.

c On the General tab, click Print Test Page. When a test page prints successfully, installation is complete.
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Using Digital Certificates
The authentication feature using digital certificates upgrades security when sending print data or setting data.
This section describes how to manage digital certificates.

NOTE: 
• For information about digital certificate error, see "Understanding Printer Messages" on page 410 and "Digital Certificate 

Problem" on page 406.

The following is a typical setup flow for using digital certificates.

Managing Certificates
This section describes how to manage digital certificates.
This section includes:

• "Preparing to Manage Certificates" on page 181
• "Importing a Digital Certificate" on page 183
• "Setting a Digital Certificate" on page 184
• "Confirming the Settings of a Digital Certificate" on page 185
• "Deleting a Digital Certificate" on page 185
• "Exporting a Digital Certificate" on page 186

NOTE: 
• The external certificate management described in this section is enabled only when the optional hard disk unit is installed and 

Data Encryption is set to On.

Preparing to Manage Certificates
Before managing digital certificates, the following settings must be applied.

• "Changing the Encryption Setting of the Hard Disk Unit" on page 182
• "Setting HTTPS Communication" on page 182

Prepare to manage digital certificates.
• Change the Encryption Setting of the hard disk unit
• Set HTTPS Communication

Import and set digital certificates.
• Import a Digital Certificate
• Set a Digital Certificate
• Confirm the Settings of a Digital Certificate

Set various security features using digital certificates.
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• Changing the Encryption Setting of the Hard Disk Unit
Some items are effective only when encryption of the optional hard disk unit is set to On. Change the encryption 
setting to On and set a key that is required to encrypt from the operator panel, if necessary.

IMPORTANT: 
• All files stored on the optional hard disk unit are cleared when changing the encryption setting.

NOTE: 
• You can enter only characters from 0 to 9, a to z, A to Z, and NULL values for encryption key.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Secure Settings.

4 Select Data Encryption.

5 Select Encryption.

6 Select On, and then select OK.

7 Use the screen keyboard or the number pad to enter the passphrase for the encryption key, and then select OK.

8 The Encryption (All stored documents will be deleted. Are you sure?) screen appears.
When you confirm that all stored documents will be deleted to change the encryption setting, select Yes, 
Delete to change the setting.

When you quit changing encryption setting, select No, Cancel.

• Setting HTTPS Communication
Before managing certificates, set HTTPS communication with a self-signed certificate using CentreWare Internet 
Services.

NOTE: 
• Set HTTPS communication after changing the Data Encryption setting to On.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.
The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Generate Self-Signed Certificate of Machine Digital Certificate.
If user name and password are required, enter the correct user name and password.

NOTE: 
• The default user name is "11111", and the default password is "x-admin".
The Create New Certificate page is displayed.
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6 Select the public key method from the list of Public Key Method.

7 Select the size of public key from the list of Public Key Size.

8 Confirm the issuer of SSL self-signed certificate.

9 Specify the validity period of the certificate in Validity.

10 Click Generate Signed Certificate.

11 When Settings have been changed. Restart system for new settings to take effect. is displayed, click 
Restart Printer to restart the printer.

12 Enter the IP address of the printer in the address bar, and press the Enter key.

NOTE: 
• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 

"http".
Example: https://192.168.1.100/

The printer's web page appears.

13 Repeat steps 3 to 4 to display the SSL/TLS Server Communication page.

14 Check that Enabled for SSL/TLS Server Communication is selected.

Importing a Digital Certificate
IMPORTANT: 
• Before importing a certificate file, back up the certificate file.

NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.
• Be sure to import the certificate with Internet Explorer®.
• After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 
• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 

"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Upload Signed Certificate of Machine Digital Certificate.
The Upload Signed Certificate page is displayed.

NOTE: 
• The Upload Signed Certificate button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.
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6 Enter a password corresponding to the certificate file to be imported.

7 Re-enter the password again to confirm it.

8 Click Browse of File Name, and select the file to be imported.

9 Click Import to import the certificate.

Setting a Digital Certificate
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 
• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 

"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.

6 When setting a Wireless LAN (Server) certificate, select Trusted Certificate Authorities within Category.
When setting a certificate of SSL Server, SSL Client, IPsec, or Wireless LAN (Client), select Local Device.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 
• If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.

10 Click Certificate Details to display the Certificate Details page.

11 Confirm the content, and click Use this certificate at the upper-right corner.



Printing Basics 185

Confirming the Settings of a Digital Certificate
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 
• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 

"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 
• If the list includes more than 20 certificates, click Next to display the next page.

9 The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with the 
purpose of use and actually used.

Deleting a Digital Certificate
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 
• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 

"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.
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6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 
• If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to be deleted.

10 Click Certificate Details to display the Certificate Details page.

11 To delete the selected certificate, click Delete at the upper-right corner.

12 Click Delete.

NOTE: 
• When a certificate is deleted, the features associated with the deleted certificate are disabled. To delete a certificate 

being used, either disable the feature in advance or switch the association to another certificate, and then switch to 
another operation mode if possible before deleting the certificate.
- For an SSL Server, switch to another certificate such as a self-signed certificate.
- For an SSL Client, disable the LDAP-SSL/TLS and IEEE 802.1x (EAP-TLS) feature.
- For IPsec, change the IKE setting to Preshared Key or disable the feature.
- For Wireless LAN, change the Wireless Security setting to other than WPA-Enterprise before deleting the certificate.

Exporting a Digital Certificate
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.
• Since the secret key is not exported, an imported PKCS#12 format certificate can be exported only as a PKCS#7 certificate.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 
• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 

"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 
• If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to be exported.

10 Click Certificate Details to display the Certificate Details page.

11 To export the selected certificate, click Export this certificate.
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Setting the Features
You can set various security features using digital certificates.
This section includes:

• "Setting the Certificate in the IPsec Digital Signature Mode" on page 187
• "Setting the SSL-use Server Certificate (HTTP/IPP)" on page 188
• "Setting LDAP-SSL/TLS Communication" on page 188
• "Setting Server Certificate Verification for LDAP-SSL/TLS Communication" on page 189
• "Setting Client Certificate for LDAP-SSL/TLS Communication" on page 189
• "Setting for Wireless LAN WPA-Enterprise (EAP-TLS)" on page 190
• "Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, EAP-TTLS CHAP)" on 

page 191

Setting the Certificate in the IPsec Digital Signature Mode
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.

1 Import the certificate to be used with IPsec.

See also: 
• "Importing a Digital Certificate" on page 183

2 Set the certificate to be used with IPsec.

See also: 
• "Setting a Digital Certificate" on page 184

3 Confirm whether the certificate is set correctly in IPsec.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

4 Launch CentreWare Internet Services.

5 Click the Properties tab.

6 In the left navigation panel, scroll down to Security and select IP sec.

7 Select the Enabled check box for Protocol.

8 Select Digital Signature from the IKE Authentication Method list.

9 Set each item, as necessary.

10 Click Apply.

11 After restarting the printer, IPsec communication using digital signatures is enabled. You can execute IPsec 
communication (Digital Signature mode) between the printer and the network device (such as computer) on 
which the certificate and IPsec are set identically as on this device.
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Setting the SSL-use Server Certificate (HTTP/IPP)
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.

1 Import the certificate to be used with the SSL-use server.

See also: 
• "Importing a Digital Certificate" on page 183

2 Set the certificate to be used with the SSL-use server.

See also: 
• "Setting a Digital Certificate" on page 184

3 Confirm whether the certificate is set correctly.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

NOTE: 
• Confirm whether the newly set certificate, not the self-signed certificate, is associated.

4 After restarting the printer, the certificate set as described above is used as the server certificate when 
executing communication with HTTP/IPP-SSL/TLS.

Setting LDAP-SSL/TLS Communication
NOTE: 
• This setting is available only when the optional hard disk unit is installed and Data Encryption is set to On.

1 Launch CentreWare Internet Services.

2 Click the Properties tab.

3 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

4 Select the Enabled check box for LDAP-SSL/TLS Communication.

5 Click Apply.

6 After restarting the printer, LDAP-SSL/TLS Communication is enabled.

NOTE: 
• When executing the certificate validity of the server and the presentation of the client certificate, see "Setting Server 

Certificate Verification for LDAP-SSL/TLS Communication" on page 189 and "Setting Client Certificate for LDAP-SSL/TLS 
Communication" on page 189.
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Setting Server Certificate Verification for LDAP-SSL/TLS 
Communication
NOTE: 
• This setting is available only when the optional hard disk unit is installed and Data Encryption is set to On.
• This feature is enabled only when the Enabled check box for LDAP - SSL/TLS Communication is selected.

1 Import the root certificate (including intermediate certificate) for the LDAP server certificate.

See also: 
• "Importing a Digital Certificate" on page 183

NOTE: 
• In the verification of a certificate of the connected server, to automatically search for an imported certificate and verify the 

path, the certificate does not need to be associated.

2 Confirm whether the root certificate is correctly imported to the LDAP server.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

3 Launch CentreWare Internet Services.

4 Click the Properties tab.

5 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

6 Select the Enabled check box for Verify Remote Server Certificate.

7 Click Apply.

8 After restarting the printer, the certificate presented by the LDAP server is verified when LDAP-SSL/TLS 
communication starts with the LDAP server.

NOTE: 
• When the result of verification is NG, communication is not established and an error results.

Setting Client Certificate for LDAP-SSL/TLS Communication
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.
• This feature is enabled only when the Enabled check box for LDAP - SSL/TLS Communication is selected.

1 Import a certificate to be used with SSL Client.

See also: 
• "Importing a Digital Certificate" on page 183

2 Set a certificate to be used with SSL Client.

See also: 
• "Setting a Digital Certificate" on page 184

3 Confirm whether the certificate is set correctly.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

4 After restarting the printer, the LDAP client certificate is presented when LDAP-SSL/TLS communication with 
the LDAP server starts. When the LDAP server is set to require a client certificate, the client certificate provided 
by the printer is verified by the LDAP server.
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Setting for Wireless LAN WPA-Enterprise (EAP-TLS)
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.
• WPA-Enterprise is available only when infrastructure is selected as the network type.
• Be sure to import the certificate with Internet Explorer.
• After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Import the certificate to be used with Wireless LAN (server or root certificate).

See also: 
• "Importing a Digital Certificate" on page 183

2 Set the digital certificate for Wireless LAN (server or root certificate).
a Launch CentreWare Internet Services.
b Click the Properties tab.
c In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.
d Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.

e Select Trusted Certificate Authorities within Category.
f Select Wireless LAN (Server) from the Certificate Purpose list.
g From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not 

necessary if you do not need to specify the order for the certificates.
h Click Display the List to display the Certificate List page.
i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to 

Valid.
j Click Certificate Details to display the Certificate Details page.
k Confirm the content, and click Use this certificate at the upper-right corner.

3 Confirm whether the certificate is set correctly.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

4 Import the certificate to be used with Wireless LAN (client or client certificate).

See also: 
• "Importing a Digital Certificate" on page 183

5 Set the digital certificate for Wireless LAN (client or client certificate).
a  Launch CentreWare Internet Services.
b Click the Properties tab.
c In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.
d Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.
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e Select Local Device within Category.
f Select Wireless LAN (Client) from the Certificate Purpose list.
g From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not 

necessary if you do not need to specify the order for the certificates.
h Click Display the List to display the Certificate List page.
i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to 

Valid.
j Click Certificate Details to display the Certificate Details page.
k Confirm the content, and click Use this certificate at the upper-right corner.

6 Confirm whether the certificate is set correctly.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

7 Set WPA-Enterprise for EAP-TLS.
a Launch CentreWare Internet Services.
b Click the Properties tab.
c In the left navigation panel, scroll down to Port Settings and select Wireless.

NOTE: 
• This setting is available only when the optional wireless printer adapter is installed.

d Select either of the following from the Encryption list of Security Settings.
• WPA-Enterprise-AES/WPA2-Enterprise-AES
• WPA-Enterprise-TKIP

NOTE: 
• WPA-Enterprise-AES/WPA2-Enterprise-AES or WPA-Enterprise-TKIP becomes available only when the following 

steps are set correctly.
- Importing a Digital Certificate
- Setting a Digital Certificate
- Confirming the Settings of a Digital Certificate

e Set EAP-Identity of WPA-Enterprise.
f Select EAP-TLS from the Authentication Method list of WPA-Enterprise.

8 Click Apply.

Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, 
EAP-TTLS PAP, EAP-TTLS CHAP)
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.
• WPA-Enterprise is available only when infrastructure is selected as the network type.
• Be sure to import the certificate with Internet Explorer.
• After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Import the certificate to be used with Wireless LAN (server or root certificate).

See also: 
• "Importing a Digital Certificate" on page 183

2 Set the digital certificate for Wireless LAN (server or root certificate).
a Launch CentreWare Internet Services.
b Click the Properties tab.



192 Printing Basics

c In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.
d Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.

e Select Trusted Certificate Authorities within Category.
f Select the purpose of use from the Certificate Purpose list.
g Click Display the List to display the Certificate List page.
h Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to 

Valid.
i Click Certificate Details to display the Certificate Details page.
j Confirm the content, and click Use this certificate at the upper-right corner.

3 Confirm whether the certificate is set correctly.
a Launch CentreWare Internet Services.
b Click the Properties tab.
c In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.
d Click Certificate Management to display the Certificate Management page.

NOTE: 
• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 

Encryption is set to On.

e Select the category from the Category list.
f Select Wireless LAN (Server) from the Certificate Purpose list.
g From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not 

necessary if you do not need to specify the order for the certificates.
h Click Display the List to display the Certificate List page.
i The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with 

the use purpose and actually used.

4 Set WPA-Enterprise for PEAPV0-MS-CHAPV2, EAP-TTLS PAP, or EAP-TTLS CHAP.
a Launch CentreWare Internet Services.
b Click the Properties tab.
c In the left navigation panel, scroll down to Port Settings and select Wireless.

NOTE: 
• This setting is available only when the optional wireless printer adapter is installed.

d Select either of the following from the Encryption list of Security Settings.
• WPA-Enterprise-AES/WPA2-Enterprise-AES
• WPA-Enterprise-TKIP

NOTE: 
• WPA-Enterprise-AES/WPA2-Enterprise-AES or WPA-Enterprise-TKIP becomes available only when the following 

steps are set correctly.
- Importing a Digital Certificate
- Setting a Digital Certificate
- Confirming the Settings of a Digital Certificate

e Set EAP-Identity, Login Name, and Password of WPA-Enterprise.
f Select either of the following from the Authentication Method list of WPA-Enterprise:
• PEAPV0 MS-CHAPV2
• EAP-TTLS PAP
• EAP-TTLS CHAP
g Click Apply.
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Setting Client Certificate for IEEE 802.1x (EAP-TLS)
NOTE: 
• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 

communication. For details, see "Preparing to Manage Certificates" on page 181.
• This feature is enabled only when Enable is set for IEEE 802.1x (EAP-TLS).

1 Import a certificate to be used with SSL Client.

See also: 
• "Importing a Digital Certificate" on page 183

2 Set a certificate to be used with SSL Client.

See also: 
• "Setting a Digital Certificate" on page 184

3 Confirm whether the certificate is set correctly.

See also: 
• "Confirming the Settings of a Digital Certificate" on page 185

4 After restarting the printer, the IEEE 802.1x (EAP-TLS) certificate is presented when IEEE 802.1x 
communication with the RADIUS server starts. When the RADIUS server is set to require a client certificate, 
the client certificate provided by the printer is verified by the RADIUS server.
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6
Copying

NOTE: 
• If the Service Lock setting for Copy is set to Password Locked, you need to enter the four digit passcode to use the 

copy function. If the Service Lock setting for Copy is set to Disable, the copy function is disabled and the menu is not 
displayed on the screen. For details, see "Service Lock" on page 327.

This chapter includes:
• "Loading Print Media for Copying" on page 196
• "Selecting Paper Tray" on page 197
• "Preparing a Document" on page 198
• "Making Copies From the Document Glass" on page 199
• "Making Copies From the DADF" on page 201
• "Setting Copy Options" on page 202
• "Using the ID Card Copy" on page 210
• "Changing the Default Settings" on page 211
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Loading Print Media for Copying
The instructions for loading print media are the same whether you are printing, faxing, or copying.

See also: 
• "Loading Print Media" on page 149
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Selecting Paper Tray
After loading the print media for copy output, select the desired paper tray to be used for the copy job.
To select the tray:

1 Press the  (Services) button.

2 Select Copy.

3 Select Select Tray.

4 Select the desired tray, and then select OK.
You can select Bypass Tray, Tray1, or Tray2*.

* Tray2 is only available when the optional 550 sheet feeder (Tray2) is installed.
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Preparing a Document
You can use the document glass or the duplex automatic document feeder (DADF) to load an original document for 
copying, scanning, and sending a fax. You can load up to 50 sheets of 75 gsm (20 lb) documents for one job using 
the DADF or one sheet at a time using the document glass.

IMPORTANT: 
• Avoid loading documents that are smaller than 139.7 mm by 139.7 mm (5.5 in. by 5.5 in.) or larger than 215.9 mm by 355.6 

mm (8.5 in. by 14 in.), different sizes or weights together, or booklets, pamphlets, transparencies, or documents having other 
unusual characteristics in the DADF.

• Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, curled or rolled 
paper, torn paper, photographs, or transparencies cannot be used in the DADF.

• Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such as glue, ink and 
correcting fluid in the DADF.

NOTE: 
• To get the best scan quality, especially for color or gray scale images, use the document glass instead of the DADF.



Copying 199

Making Copies From the Document Glass
NOTE: 
• A computer connection is not required for copying.
• Remove any documents from the DADF before copying from the document glass.
• Contaminants on the document glass may cause black spots on the copy output. For best results, clean the document glass 

before use. For more information, see also "Cleaning the Scanner" on page 420.

To make a copy from the document glass:

1 Lift and open the document cover. 

2 Place the document face down on the document glass and align it with the registration guide on the top left 
corner of the glass.

CAUTION:
• Do not apply excessive force to hold thick document on the document glass. It may break the glass and 

cause injuries.
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3 Close the document cover.

IMPORTANT: 
• Leaving the document cover open while copying may affect the copy quality and increase the toner consumption.

NOTE: 
• If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close 

the cover. If the book or magazine is thicker than 30 mm, start copying with the document cover open.

4 Press the  (Services) button.
To simply make a copy without changing the default copy settings, proceed to step 8.

5 Select Copy.

6 Customize the copy settings including copy size, contrast, and image quality.

See also: 
• "Setting Copy Options" on page 202
To clear the option settings, press the CA (Clear All) button.

NOTE: 
• The copy options automatically return to their default status after the auto clear timer is expired.

7 Enter the number of copies from 1 to 99 using the number pad.

8 Press the  (Start) button to begin copying.

NOTE: 
• Press the  (Stop) button to cancel a copy job at any time while scanning and printing a document.
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Making Copies From the DADF
IMPORTANT: 
• Do not load more than 50 sheets into the DADF or allow more than 50 sheets to be fed to the document output tray. The 

document output tray should be emptied before it exceeds 50 sheets or your original documents may be damaged. 

NOTE: 
• To get the best scan quality, especially for gray scale images, use the document glass instead of the DADF.
• A computer connection is not required for copying.
• You cannot load the following documents in the DADF. Be sure to place them on the document glass.

To make a copy from the DADF:

1 Load the documents face up on the DADF with top edge of the documents in first. Then adjust the document 
guides to the correct document size.

NOTE: 
• Ensure that you use the document guides before copying a legal-size document.

2 Press the  (Services) button.
To simply make a copy without changing the default copy settings, proceed to step 6.

3 Select Copy.

4 Customize the copy settings including copy size, contrast, and image quality. 

See also: 
• "Setting Copy Options" on page 202
To clear the settings, use the CA (Clear All) button.

NOTE: 
The copy options automatically return to their default status after the auto clear timer is expired.

5 Enter the number of copies from 1 to 99 using the number pad.

6 Press the  (Start) button to begin copying.

NOTE: 
• Press the  (Stop) button to cancel a copy job at any time while scanning and printing a document.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Setting Copy Options
Set the following options for the current copy job before pressing the  (Start) button to begin copying.
For details about making copies, see "Making Copies From the Document Glass" on page 199 and "Making Copies 
From the DADF" on page 201.

NOTE: 
• The copy options automatically return to their default status after auto clear timer is expired.

This section includes:
Options on each tab are below:

• Copy tab
• "Output Color" on page 203
• "Select Tray" on page 203
• "Lighten / Darken" on page 203
• "2 Sided Copying" on page 204

• Quality tab
• "Original Type" on page 204
• "Sharpness" on page 204
• "Saturation" on page 205
• "Auto Background Suppression" on page 205

• Output tab
• "Collation" on page 205
• "Reduce / Enlarge" on page 206
• "Original Size" on page 207
• "Pages Per Side" on page 208
• "Edge Erase" on page 209
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Output Color
To select the mode for color or black and white copying.

1 Select Output Color.

2 Select Full Color or Black & White, and then select OK.

NOTE: 
• Color copy is secured with a passcode if the Service Lock setting for Copy is set to On (Color Password Locked). 

If you set Output Color to Full Color and the Service Lock setting for Copy to On (Color Password 
Locked), you will need to enter the four digit passcode after pressing the  (Start) button.

Select Tray
To select a tray.

1 Select Select Tray.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

NOTE: 
• Tray 2 is only available when the optional 550 sheet feeder is installed.
• When Any is displayed as the paper size and type in the bypass tray, you can select the paper size and type from this 

menu.

Lighten / Darken
To adjust the contrast to make the copy lighter or darker than the original.

1 Select Lighten / Darken.

2 Select the desired level on the Lighten / Darken bar, and then select OK.
You can select a contrast level from seven levels between Darken and Lighten.

Selecting a cell on the left side of the bar makes the document contrast darker, and selecting a cell on the right 
side of the bar makes the document contrast lighter.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Bypass Tray The paper is fed from the bypass tray.

Tray 1* The paper is fed from the standard 550 sheet tray.

Tray 2 The paper is fed from the optional 550 sheet feeder.

Darken +3 Works well with light documents or faint pencil markings.

Darken +2
Darken +1
Normal* Works well with normal typed or printed documents.

Lighten +1 Works well with dark documents.

Lighten +2
Lighten +3
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2 Sided Copying
To make duplex copies with the specified binding position.

1 Select 2 Sided Copying.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

When you are using the document glass and it is set to 1→2 Sided or 2→2 Sided, the display prompts you for 
another page after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select 
Continue or press the  (Start) button.

b If you finish copying, select Print Now.

NOTE: 
• When you use the DADF to copy both sides of a document, the printed position of the front and back of the document 

may differ if the size in the document size setting and the size of the document do not match. In this case, set Document 
Size to the same size as the document.

Original Type
To select the copy image quality.

1 Select the Quality tab, and then select Original Type.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Sharpness
To adjust the sharpness to make the copy image sharper or softer than the original.

1 Select the Quality tab, and then select Sharpness.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

1 → 1 Sided* Select 1-sided or 2-sided and specify 
binding position for the 2-sided copy.1 → 2 Sided Binding of Output Long Edge Binding

Short Edge Binding
2 → 1 Sided Binding of Original Long Edge Binding
2 → 2 Sided Short Edge Binding

Photo & Text* Used for documents with photos and text.

Text Used for documents with text.

Photo Used for documents with photos.

Sharpen Makes the copy image sharper than the original.

Normal* The color clarity of the image is the same as the original.

Soften Makes the copy image softer than the original.
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Saturation
To adjust the amount of colors of the copy to make the colors darker or lighter than the original.

1 Select the Quality tab, and then select Saturation.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Auto Background Suppression
To suppress the background of the original to enhance text on the copy.

1 Select the Quality tab, and then select Auto Background Suppression.

2 Select On, and then select OK.

Collation
To sort the copy output. For example, if you make two copies of three page documents, one complete three page 
document will be printed followed by the second complete document.

NOTE: 
• You can collate more pages when 512MB memory or hard disk unit is installed.

1 Select the Output tab, and then select Collation.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

When you are using the document glass and it is set to Collated, the display prompts you for another page 
after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select 
Continue or press the  (Start) button.

b If you finish copying, select Print Now.

Vivid Makes the color of the copy more vivid.

Normal* The color saturation is the same as the original.

Pastel Makes the color of the copy less vivid.

Auto* Only the documents loaded from the DADF are copied in collated order.

Collated Copies in collated order.

Uncollated Does not copy in collated order.
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Reduce / Enlarge
To reduce or enlarge the size of a copied image from 25 to 400% when you copy original documents from the 
document glass or the DADF.

NOTE: 
• When you make a reduced copy, black lines may appear at the bottom of your copy.

1 Select the Output tab, and then select Reduce / Enlarge.

2 Select the desired setting, and then select OK.

• mm series
NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• inch series

NOTE: 
• You can also specify the value in increments of 1% from 25 to 400 by selecting  or  or entering a value using the 

number pad. See the following table for specific zoom ratios.

The method to load print media depends on the size and orientation of a print media, see "Loading Print Media 
in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 150 or "Loading Print Media in the 
Bypass Tray" on page 153.

For print media that can be loaded, see "About Print Media" on page 142.

200%
141% A5 → A4
122% A5 → B5
100%*
81% B5 → A5
70% A4 → A5
50%

200%
154%
129% 8.5 x 11" → 8.5 x 14"
100%*
78% 8.5 x 14" → 8.5 x 11"
64%
50%

Copy

Original

A5 B5 A4

A5 100% 122% 141%

B5 81% 100% 115%

A4 70% 86% 100%
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Original Size
To select the default document size.

1 Select the Output tab, and then select Original Size.

2 Select the desired setting, and then select OK.

• mm series
NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• inch series

Auto*
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
Executive (7.25 x 10.5")

Auto*
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
A4 (210 x 297mm)
A5 (148 x 210mm)
B5 (182 x 257 mm)
Executive (7.25 x 10.5")
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Pages Per Side
To print two original images to fit onto one sheet of paper.

1 Select the Output tab, and then select Pages Per Side.

2 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

When you are using the document glass and it is set to Auto or Manual, the display prompts you for another page 
after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select 
Continue or press the  (Start) button.

b If you finish copying, select Print Now.

Off* Does not perform Pages Per Side printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

Manual Prints the original pages onto the one sheet of paper in the size specified in Reduce 
/ Enlarge.

Auto:
Automatically 
reduces the 
pages to fit in 
one page.

Manual:
Reduces the pages in 
the custom size 
depending on the 
setting of the Reduce / 
Enlarge menu.
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Edge Erase
To specify the top and bottom margins of the copy.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

1 Select the Output tab.

2 Select  until Edge Erase appears, and then select Edge Erase.

3 Select  or , or use the number pad to enter the desired value.

Top / Bottom 4 mm* (0.2 inch*) Specify the value in increments of 0.1 inch (1 mm).

0→50 mm (0.0→2.0")
Left / Right 4 mm* (0.2 inch*) Specify the value in increments of 0.1 inch (1 mm).

0→50 mm (0→2.0")
Middle 0 mm* (0 inch*) Specify the value in increments of 0.1 inch (1 mm).

0→50 mm (0→2.0")
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Using the ID Card Copy
NOTE: 
• If the Service Lock setting for ID Card Copy is set to Disable, the ID card copy function is disabled and the menu is not 

displayed on the screen. For details, see "Service Lock" on page 327.
• ID Card Copy is available only for document glass.

You can copy both sides of an ID card on one side of a single sheet of paper in its original size by selecting ID Card 
Copy on the operator panel. This feature helps to show both sides of an ID card in one page in its original size.
To make a copy:

1 Place an ID card face down on the document glass, and close the document cover.
For details about loading a document, see "Making Copies From the Document Glass" on page 199.

2 Press the  (Services) button.

3 Select ID Card Copy.

4 Specify the copy settings below as required.
• Output Color
• Select Tray
• Lighten / Darken
• Auto Background Suppression
• Sharpness
• Saturation

For details, see "Setting Copy Options" on page 202.

5 Press the  (Stop) button to begin copying.
After the front side of the ID card is scanned, the display prompts you to turn over the card.

a To scan the back side of the ID card, turn the ID card over and select Continue.
b To finish copying, select Print Now.

NOTE: 
• Color copy is secured with a passcode if the Service Lock setting for Copy is set to On (Color Password). If you set 

Output Color to Full Color and the Service Lock setting for Copy to On (Color Password), you will need to enter the 
four digit passcode after pressing the  (Stop) button.
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Changing the Default Settings
The default settings of the Copy menu options such as Output Color, Select Tray, and Lighten / Darken 
can be set to the most frequently used modes. When you copy a document, the specified default settings are used 
unless they are changed by using the operator panel.
To create your own default settings:

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Default Settings.

4 Select the desired menu item.

5 Select the desired setting or enter the value using the number pad, and then select OK.

6 Repeat steps 4 and 5 as needed.

7 To return to the top level of the System menu, press the CA (Clear All) button.
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NOTE: 
• If the Service Lock setting for a scan function (E-mail, Scan To Network, Scan To PC / WSD Scan, PC Scan, or 

Scan To USB) is set to Password Locked, you need to enter the four digit passcode to use that scan function. If the 
Service Lock setting for a scan function is set to Disable, that scan function is disabled and the menu is not displayed on 
the screen. For details, see "Service Lock" on page 327.

This chapter includes:
• "Scanning Overview" on page 214
• "Installing the Scan Driver" on page 215
• "Scanning to a Computer" on page 216
• "Using a Scanner on the Network" on page 224
• "Scanning to a USB Storage Device" on page 246
• "Sending an E-Mail With the Scanned Image" on page 248
• "Adjusting Scanning Options" on page 251
• "Scanner Connection Tool" on page 254
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Scanning Overview
You can use your printer to turn pictures and text into editable images on your computer. 
The printer provides several ways to scan your document. There are two main scanning types. One is operated on 
the printer side without using the scan driver, and the other is operated on the computer side using a software and 
the scan driver. 

Scanning - With scan driver
• Scan and send the scanned document to computer connected via USB cable

(Supporting USB connection for both Microsoft® Windows® and Mac OS® X using bundled software tool of 
Express Scan Manager)

Using the feature of "Scan to PC" on the operator panel of your printer, the scanned image is saved in the 
location of your computer specified with the Express Scan Manager.

See "Scanning From the Operator Panel - Scan to PC" on page 217.

• Scan into a graphic software such as Adobe® Photoshop® using a TWAIN driver
(Supporting USB and Network connections for both Windows and Mac OS X using a graphic software)

See "Scanning Using the TWAIN Driver" on page 220.

• Scan into a Microsoft’s default program such as Windows Photo Gallery and Microsoft Paint, using a Windows 
Image Acquisition (WIA) driver
(Supporting USB and Network (including WSD) connections on Windows only)

See "Scanning Using the WIA Driver" on page 221.

NOTE: 
• WSD stands for Web Services on Devices.

Scanning - Without scan driver
• Scan and send the scanned document to a computer connected to a network using WSD

See "Scanning From the Operator Panel - WSD Scan" on page 218.

• Scan and send the scanned document to computer or server connected to network
See "Using a Scanner on the Network" on page 224.

• Scan and save the scanned document in a USB storage device
See "Scanning to a USB Storage Device" on page 246.

• Scan and send the scanned document by e-mail
See "Sending an E-Mail With the Scanned Image" on page 248.

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or 
document after you scan it into your computer. For the best results, use these recommended settings. 

Scanning beyond these recommended resolutions may exceed the capabilities of the application. If you require a 
resolution above those recommended in the above table, you should reduce the size of the image by previewing (or 
pre-scan) and cropping before scanning the image.

Type Resolution
Documents 300 dpi black-and-white or 200 dpi grayscale or color

Documents of poor quality or that contain small text 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100–200 dpi color or 200 dpi grayscale

Images for an inkjet printer 150–300 dpi

Images for a high-resolution printer 300–600 dpi
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Installing the Scan Driver
If you plan to import scanned images directly into an application (such as Adobe Photoshop or Microsoft Clip 
Organizer), or scan images directly to your computer, you must install a scan driver.
This section includes:

• "For Windows" on page 215
• "For Mac OS X" on page 215

For Windows
To install the scan driver from the Driver CD Kit: 

1 Turn off the printer and the computer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Connect the computer and your printer with a USB cable.
OR

Connect your printer to a network.

3 Insert the Driver CD Kit into your computer to start Easy Install Navi.

4 Click Installing Driver and Software.

5 Click the Main tab, and then select Scan Driver. 

6 Click Start.

7 Follow the on-screen instructions to install the scan driver.
For more information about scanning using USB connection, see "Express Scan Manager" on page 88.

For Mac OS X
To install the scan driver from the Driver CD Kit: 

1 Run the Driver CD Kit on the Mac OS X.

2 Open the MacOSX folder under the Common folder.

3 Open either the 10.3.9-10.6 or 10.7- folder depending on the version of Mac OS X you are running.

4 Double-click FX DocuPrint CM405 df.dmg.

5 Follow the on-screen instructions to install the scan driver.
For more information about scanning using USB connection, see "Express Scan Manager" on page 88.
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Scanning to a Computer
This section includes:

• "Scanning From the Operator Panel - Scan to PC" on page 217
• "Scanning From the Operator Panel - WSD Scan" on page 218
• "Scanning Using the TWAIN Driver" on page 220
• "Scanning Using the WIA Driver" on page 221
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Scanning From the Operator Panel - Scan to PC
The following procedure uses Windows 7 as an example.

NOTE: 
• This feature cannot be used when the printer is connected to a network.
• Ensure that the printer is connected to the computer via the USB cable.
• This feature is supported on both Windows and Mac OS X.

1 Load the document(s) face up with top edge in first into the duplex automatic document feeder (DADF).
OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Press the  (Services) button.

3 Select Scan to.

4 Select PC.

5 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on the 
Scan to PC, Quality and Options tabs.

6 Press the  (Start) button.
The selected application window opens on your computer.

NOTE: 
• If the following dialog box appears on your computer, select DocuPrint CM405 df Express Scan Manager, and then 

click OK.

NOTE: 
• Once you select the Always use this program for this action check box when selecting DocuPrint CM405 df Express 

Scan Manager, the selected application is automatically used without displaying the program selection window.
• You must use Express Scan Manager on your computer to change the settings for scanning. For details, see "Express Scan 

Manager" on page 88.
• For Mac OS X, the dialog box for selecting a program is not displayed.
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Scanning From the Operator Panel - WSD Scan
If the printer is connected to a computer via network using WSD (Web Services on Devices), you can use the WSD 
Scan function to send scanned images to a computer.
The following procedure uses Windows 7 as an example.

NOTE: 
• To use WSD Scan, you need to setup connection using WSD.
• WSD is supported only on Windows Vista®, Windows 7, and Windows 8.

Printer Setup for WSD Scan
Setup the printer and computer for connection using WSD.

• Checking the Printer Setting
To use the WSD Scan function, WSD Scan needs to be set to Enable. For details, "Protocols" on page 305.

• Setting Up the Computer
NOTE: 
• For Windows 8, the computer automatically connects the printer using WSD. There is no need to install the printer manually.

For Windows 7:

1 Click Start → Computer → Network.

2 Right-click the icon for the printer, and then click Install. 
The printer is connected using WSD.

For Windows Vista:

1 Click Start → Network.

2 Right-click the icon for the printer, and then click Install.

3 Click Continue. 
The printer is connected using WSD.
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Procedures for WSD Scan
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Press the  (Services) button.

3 Select Scan to.

4 Select WSD.

5 Select  until the desired computer you want to send the scan job to appears, and then select that computer.

6 Select Event, and specify the type of scan such as Scan, Scan To Print and Scan To E-mail.

7 Press the  (Start) button to begin sending the scanned file.
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Scanning Using the TWAIN Driver
Your printer supports the TWAIN driver for scanning images. The following procedure uses Windows 7 as an 
example.

NOTE: 
• Ensure that the printer is connected to the computer via the USB cable or to a network.

The following procedure to scan an image uses Clip Organizer as an example.

1 Load the document(s) face up with top edge in first into the DADF.
OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Click Start → All Programs → Microsoft Office → Microsoft Office 2010 Tools → Microsoft Clip Organizer.

3 Click File → Add Clips to Organizer → From Scanner or Camera.

4 In the Insert Picture from Scanner or Camera dialog box, under Device, select your device.

5 Click Custom Insert.

6 Select your scanning preferences and click Preview to display the preview image.

NOTE: 
• Preview is grayed out and disabled when you select Document Feeder from Scan from.
• The illustration may vary for different operating systems.

7 Select the desired properties from the Image Quality and Image Options tabs.

8 Click Scan to start scanning.
The scanned image file is generated.
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Scanning Using the WIA Driver
Your printer also supports the Windows Image Acquisition (WIA) driver for scanning images. WIA is one of the 
standard components provided by Windows XP and later operating systems and works with digital cameras and 
scanners. Unlike the TWAIN driver, the WIA driver allows you to scan an image and easily manipulate those images 
without using additional software.

NOTE: 
• Ensure that the printer is connected to the computer via the USB cable or to a network.
• The Windows Image Acquisition (WIA) driver is supported only on Windows.

To Scan an Image From the Drawing Software
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Start the drawing software, such as Paint for Windows.

NOTE: 
• When you use Windows Vista, use Windows Photo Gallery instead of Paint.
• When using applications that utilize WIA 2.0, such as Windows Fax and Scan on Windows Vista, Windows 7 and 

Windows 8, the Feeder (Scan both sides) option can be selected for duplex (two-sided) scanning.

3 Click Paint button → From scanner or camera (Click File → From Scanner or Camera for Windows XP, 
Windows Server 2003, Windows Server 2008 and Windows Vista).
The Scan using FX DP CM405 df (WIA - USB) window appears.

NOTE: 
• The illustration may vary for different operating systems.
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4 Select Document Feeder or Flatbed in Paper source.

NOTE: 
• Select Document Feeder when you want to scan the document loaded in the DADF. Select Flatbed when you want to 

scan the document loaded on the document glass.

5 Select your scanning preferences and click Adjust the quality of the scanned picture to display the 
Advanced Properties dialog box.

6 Select the desired properties including brightness and contrast, and then click OK.

7 Click Scan to start scanning.

8 Click Save from the Paint menu.

9 Enter a picture name, and select a file format and destination to save the picture.

To Scan an Image From Control Panel
NOTE: 
• This feature is supported on Windows Server 2003 and Windows XP only.

1 Load the document(s) face up with top edge in first into the DADF.
OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Click start → Control Panel → Printers and Other Hardware → Scanners and Cameras.

3 Double-click the scanner icon. 
The Scanner and Camera Wizard launches.

4 Click Next to display the Choose Scanning Preferences page.

NOTE: 
• The screen image may vary depending on the operating system.
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5 Select your desired type of picture, paper source, and paper size, and click Next.

6 Enter a picture name, select a file format, and specify the desired location to save the scanned document.

7 Click Next to start scanning.

8 Follow the on-screen instructions to edit the picture after it is copied to your computer.
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Using a Scanner on the Network
This section includes:

• "Overview" on page 225
• "Setting a Login Name and a Password (SMB Only)" on page 227
• "Creating a Shared Folder (SMB Only)" on page 230
• "Setting a Destination Using an Address Book" on page 239
• "Sending the Scanned File on the Network" on page 245

NOTE: 
• This feature does not require a network scan driver.
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Overview
The Scan to Server/Computer feature allows you to scan documents and send the scanned document to a network 
computer via the FTP or SMB protocol. 

You can select the kind of server and specify a destination to store the scanned document with the CentreWare 
Internet Services or Address Book Editor.
The following items are required to use the Scan to Server/Computer feature.

• Using SMB
To transfer data via SMB, your computer must run on one of the following operating systems that includes 
folder sharing.

NOTE: 
• Windows Server 2003, Windows XP, Mac OS X 10.3/10.4/10.5 support IPv4 only.
• For Mac OS X, a shared user account is required.

• Windows Server 2003
• Windows Server 2008
• Windows Server 2008 R2
• Windows Server 2012
• Windows XP
• Windows Vista
• Windows 7
• Windows 8
• Mac OS X 10.3/10.4/10.5/10.6

• Using FTP
To transfer data via FTP, one of the following FTP servers and an account to the FTP server (login name and 
password) are required.

NOTE: 
• Windows Server 2003, Windows XP, Windows Vista, Mac OS X 10.3/10.4/10.5 support IPv4 only.

• Windows XP
FTP service of Microsoft Internet Information Services 5.1

• Windows Server 2003
FTP service of Microsoft Internet Information Services 6.0

• Windows Vista, Windows Server 2008
FTP service of Microsoft Internet Information Services 7.0

Scan
Using FTP

Using SMB

FTP Server

Computer

Computer
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• Windows 7, Windows Server 2008 R2
FTP service of Microsoft Internet Information Services 7.5

• Windows 8, Windows Server 2012
FTP service of Microsoft Internet Information Services 8.0

• Mac OS X 10.3/10.4/10.5/10.6/10.7/10.8
FTP service of Mac OS X

For information on how to configure the FTP service, contact your system administrator.

Follow the procedure below to use the Scan to Server/Computer feature.

• For SMB:

• For FTP:

"Setting a Login Name and a Password (SMB Only)" on page 227

"Creating a Shared Folder (SMB Only)" on page 230

"Setting a Destination Using an Address Book" on page 239

"Sending the Scanned File on the Network" on page 245

"Setting a Destination Using an Address Book" on page 239

"Sending the Scanned File on the Network" on page 245
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Setting a Login Name and a Password (SMB Only)
The Scan to Computer/Server feature requires a user login account with a valid and non-empty password for 
authentication. Confirm a login user name and password.

If you do not use a password for your user login, you need to create a password on your User Login Account with the 
following procedure.

• For Windows XP:

1 Click start → Control Panel → User Accounts.

2 Click Change an account.

3 Select your account.

4 Click Create a password and add in a password for your user login account.

• For Windows Server 2003:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 
• When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

• For Windows Vista and Windows 7:

1 Click Start → Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.
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• For Windows Server 2008:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 
• When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

• For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 
• When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

• For Windows 8 and Windows Server 2012:

1 Point to the top or bottom right corner of the screen, and then click Settings.

2 Click Change PC settings.

3 Click Users.

4 Click Create a Password and add in a password for your user login account.

• For Mac OS X 10.3:

1 Click System Preferences → Accounts.

2 Select your account.

3 Enter a password for your user login account in Password.

4 Re-enter the password in Verify.
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• For Mac OS X 10.4/10.5/10.6:

1 Click System Preferences → Accounts.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New Password (New password for Mac OS X 10.6).

5 Re-enter the password in Verify.

6 Click Change Password.
After you confirmed a login user name and password, go to "Creating a Shared Folder (SMB Only)" on page 230.
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Creating a Shared Folder (SMB Only)
Share a folder to store the scanned document using the following procedure.

• For Windows XP Home Edition:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder on the network.

4 Enter a shared name in the Share name box.

NOTE: 
• Write down this shared name because you will use this name in the next setting procedure.

NOTE: 
• When the following screen appears, click If you understand the security risks but want to share files without 

running the wizard, click here, then select Just enable file sharing, and then click OK.
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5 Select Allow network users to change my files.

6 Click Apply, and then click OK.

NOTE: 
• To add sub-folders, create new folders in the shared folder you have created.

Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 239.

• For Windows XP Professional Edition:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare) and double-click 
the folder.

2 Select Folder Options from Tools.

3 Click the View tab, and then deselect the Use simple file sharing (Recommended) check box.
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4 Click OK, and then close the window.

5 Right-click the folder, and then select Properties.

6 Click the Sharing tab, and then select Share this folder.

7 Enter a shared name in the Share name box.

NOTE: 
• Write down this shared name because you will use this name in the next setting procedure.

8 Click Permissions to create a write permission for this folder.

9 Click Add.

10 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 
select box and click Check Names to confirm (Example of user login name: MySelf).
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11 Click OK.

12 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 
• Do not use Everyone as the user login name.

13 Click OK.

14 Click Apply, and then click OK.

NOTE: 
• To add sub-folders, create new folders in the shared folder you have created.

Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 239.
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• For Windows Server 2003

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder.

4 Enter a shared name in the Share name box.

NOTE: 
• Write down this shared name because you will use this name in the next setting procedure.

5 Click Permissions to create a write permission for this folder.

6 Click Add.

7 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 
select box and click Check Names to confirm (Example of user login name: MySelf).
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8 Click OK.

9 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 
• Do not use Everyone as the user login name.

10 Click OK.

11 Configure other settings as necessary, and then click Apply and click OK.

NOTE: 
• To add sub-folders, create new folders in the shared folder you have created.

Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 239.
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• For Windows Vista, Windows 7, Windows 8, Windows Server 2008, 
Windows Server 2008 R2, Windows Server 2012

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then click Advanced Sharing.
For Windows Vista, when User Account Control dialog box appears, click Continue.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

NOTE: 
• Write down this shared name because you will use this name in the next setting procedure.
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6 Click Permissions to create a write permission for this folder.

7 Click Add.

8 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 
select box and click Check Names to confirm (Example of user login name: MySelf).

9 Click OK.

10 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 
• Do not use Everyone as the user login name.

11 Click OK.

12 Click OK to exit the Advanced Sharing dialog box.

13 Click Close.

NOTE: 
• To add sub-folders, create new folders in the shared folder you have created.

Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to "Setting a Destination Using an Address Book" on page 239.
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• For Mac OS X 10.3/10.4:

1 Select Home from the Go menu.

2 Double-click Public.

3 Create a folder (Example of folder name: MyShare).

NOTE: 
• Write down this shared name because you will use this name in the next setting procedure.

4 Open System Preferences, and then click Sharing.

5 Select the Personal File Sharing check box and the Windows Sharing check box.

• For Mac OS X 10.5/10.6:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

NOTE: 
• Write down this shared name because you will use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared Folder (Shared folder for Mac OS X 10.6) check box, and then close the window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share Files and folders using SMB (Share files and folders using SMB (Windows) for Mac OS 
X 10.6) check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.
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Setting a Destination Using an Address Book
You can configure the printer settings to use the Scan to Server/Computer feature with the CentreWare Internet 
Services or Address Book Editor.
The following procedure uses Windows 7 as an example.
Before beginning to setup a destination, make sure you have the IP addresses you need such as printer and 
computer.

Verifying the IP Address Setting of the Printer
To setup the server address book through the network, you will first need to locate the IP address of the printer. To 
find your printer's IP address, see "Verifying the IP Settings" on page 99.

Locating the IP Address Setting of Your Computer
You can locate the IP address of your computer by the following operations.

1 Point to the top or bottom right corner of the screen, and then click Search → Type run in the text field, click 
Apps, and then click Run. (for Windows 8/Windows Server 2012)
Click Start → All Programs → Accessories → Run. (for Windows Vista/Windows 7)

Click start → Run. (for Windows XP)

Click Start → Run. (for Windows Server 2003/Windows Server 2008/Windows Server 2008 R2)

2 Type cmd in the text field and click OK. A command prompt window will open.

3 Type ipconfig and press Enter.

4 Write down the IP Address xxx.xxx.xxx.xxx.
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Using CentreWare Internet Services
1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.
The printer's web page appears.

NOTE: 
• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 99.

3 Click the Address Book tab.
If user name and password are required, enter the correct user name and password.

NOTE: 
• The default user name is "11111", and the default password is "x-admin".

4 Under Network Scan (Comp./Serv.), click Computer/Server Address Book.

5 Select any unused number and click Add. 
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The Add Network Scan Address page appears.

To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want it to appear on the Computer/Server Address 
Book.

2 Server Type Select Computer (SMB) if you store the document in a shared folder of your 
computer.

Select Server (FTP) if you use an FTP server.

3 Server Address Enter a server name or IP address of your computer or the FTP server that you have 
shared out.

The following are examples:
• For Computer (SMB):

Server name: myhost
IP address: 192.168.1.100

• For Server (FTP):
Server name: myhost.example.com
(myhost: host name, example.com: domain name)
IP address: 192.168.1.100

4 Server Port Number Enter the port number. If you are unsure, you can enter the default value of 139 for 
SMB and 21 for FTP.

5 Login Name Enter the user account name that has access to the shared folder on your computer 
or FTP server.

6 Login Password Enter the password corresponding to the above login name.

NOTE: 
• Empty password is not valid in the Scan to Computer feature. Ensure that you 

have a valid password for the user login account. (See "Setting a Login Name 
and a Password (SMB Only)" on page 227 for details on how to add a password 
in your user login account.)

7 Re-enter Password Re-enter your password.

1

2

3

4

5

6

7

8

9
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After you configured settings, go to "Sending the Scanned File on the Network" on page 245.

8 Share Name For Computer (SMB) only.

On the Windows operating system, enter the share name of the folder to store the 
scanned document on the recipient computer.

On the Mac OS X, enter the folder name to store the scanned document on the 
recipient computer.

9 Server Path For Computer (SMB)
To store the scanned document in the shared folder directly without creating any 
subfolder, leave the space blank.

To store the scanned document in the folder you created under the shared folder, 
enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: MyPic, 
Third-level folder name: John
You should now see MyShare\Mypic\John in your directory.

In this case, enter the following item.

Server Path: \MyPic\John
For Server (FTP)
Enter the server path to store the scanned document.

MyShare (Share folder)

MyPic

John
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Using Address Book Editor
The following procedure uses Windows 7 as an example.

1 Click Start → All Programs → Fuji Xerox → DocuPrint CM405 df → Address Book Editor.
The Select Device window appears.

NOTE: 
• If the Address Book Editor window appears, go to step 4.

2 Select your printer from the list.

3 Click OK.

4 Click Tool → New (Printer Address Book) → Server.

The Server Address dialog box appears.

3

9

10

8

7

6

5

4

2
1
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To fill in the fields, enter the information as follows: 

After you configured settings, go to "Sending the Scanned File on the Network" on page 245.

1 Name Enter a friendly name that you want it to appear on the address book.

2 Server Type Select Computer (SMB) if you store the document in a shared folder of your 
computer. 

Select Server (FTP) if you use an FTP server.

3 Computer Settings 
wizard

Clicking this button opens the wizard screen which guides you through several 
steps.

When you complete the steps in the wizard, the settings for Server Address are 
automatically configured.

4 Server Name / IP 
Address

Enter a server name or IP address of your computer or the FTP server that you have 
shared out.

The following are examples:
• For Computer (SMB):

Server name: myhost
IP address: 192.168.1.100

• For Server (FTP):
Server name: myhost.example.com
(myhost: host name, example.com: domain name)
IP address: 192.168.1.100

5 Share Name Enter the name of the shared folder on the recipient computer. For SMB only.

6 Path For Computer (SMB)
To store the scanned document in the shared folder directly without creating any 
subfolder, leave the space blank.

To store the scanned document in the folder you created under the shared folder, 
enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: MyPic, 
Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Path: \MyPic\John
For Server (FTP)
Enter the path to store the scanned document.

7 Login Name Enter the user account name that has access to the shared folder on your computer 
or FTP server.

8 Login Password Enter the password corresponding to the above login name.

NOTE: 
• Empty password is not valid in the Scan to Computer feature. Ensure that you 

have a valid password for the user login account. (See "Setting a Login Name 
and a Password (SMB Only)" on page 227 for details on how to add a password 
in your user login account).

9 Confirm Login 
Password

Re-enter your password.

10 Port Number Enter the port number. If you are unsure, you can enter the default value of 139 for 
SMB and 21 for FTP.

MyShare (Share folder)

MyPic

John
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Sending the Scanned File on the Network
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Press the  (Services) button.

3 Select Scan to.

4 Select Network.

5 Select  until the desired address appears and then select that address.

6 Select OK.

7 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on the 
Scan to Network, Quality and Options tabs. For details, see "File Format" on page 336.

8 Press the  (Start) button to begin sending the scanned file.
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Scanning to a USB Storage Device

Types of a USB Storage Device
You can use a USB storage device with the following interfaces:

• USB 1.1
• USB 2.0

The USB storage device must be formatted in FAT file systems (FAT16, FAT32, or VFAT) before inserting the 
memory device into the front USB port of the printer.

NOTE: 
• If the USB storage device is formatted in a file system other than above, the printer may not recognize that the USB storage 

device is attached.
• A USB storage device with authentication feature and some brands of USB storage devices cannot be used with this printer.

Procedures
To store the scanned images to a USB storage device:

NOTE: 
• If you insert a USB storage device to the front USB port first, the USB Drive Detected screen may appear. In this case, 

select Scan To USB, and proceed to step 6.

1 Load the document(s) face up with top edge in first into the DADF.
OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Press the  (Services) button.

3 Insert a USB storage device into the front USB port of the printer.
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4 Select Scan to.

5 Select USB Memory.

6 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on the 
Scan To USB, Quality and Options tabs. For details, see "File Format" on page 336.
You can also specify the folder to save the scanned image. For details, see "Specifying a Folder to Save the 
Scanned Image" on page 247.

7 Press the  (Start) button to begin scanning the document.

8 Remove the USB storage device from the printer.

IMPORTANT: 
• Before removing the USB storage device, ensure that the printer is not accessing the USB storage device. If you remove 

the USB storage device while the printer is accessing, the data in the USB storage device or the USB storage device 
itself may be destroyed.

Specifying a Folder to Save the Scanned Image
To save the scanned image to a folder in the USB storage device, specify the folder before executing the scan job.

1 Select Change Folder on the Scan To USB Memory tab.

2 Select a folder to save the scanned image.

NOTE: 
• The default saving location is the root directory of the USB storage device.
• You cannot directly enter a folder path using the number pad.
• You can select any folder in the USB storage device but cannot create a new folder in this step. You should always 

create a new folder before connecting the memory to the printer.
If you want the printer to automatically create a folder and then save the scanned image to that folder, set Create 
Folder to On.  For details, see "Create Folder" on page 340.

If the name of the scanned image has already existed in the folder, the printer automatically generate a new file 
name to save the data.
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Sending an E-Mail With the Scanned Image
To send an e-mail attached with the scanned image from your printer, follow the steps below:

• Setup the E-mail address book through the CentreWare Internet Services. See "Registering a New E-Mail 
Address" on page 248 for more details.

E-Mail Settings
1 From the CentreWare Internet Services, click Properties.

2 Click E-mail.

3 Specify the settings for E-mail as follows:
SMTP Server Address: Enter the IP address of the e-mail server.

E-Mail Send Authentication: Specify Invalid to enable the e-mail server.

NOTE: 
• If an error message including 016-506 or 016-764 is displayed, contact your server administrator for the settings for 

E-Mail Send Authentication.

4 Click the Apply button.

Registering a New E-Mail Address
The following procedure uses Windows 7 as an example.

1 Launch your web browser. 

2 Enter the IP address of the printer in the address bar, and then press the Enter key.
The printer's web page appears.

NOTE: 
• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 99.



Scanning 249

3 Click the Address Book tab.
If user name and password are required, enter the correct user name and password.

NOTE: 
• The default user name is "11111", and the default password is "x-admin".

4 Click Email Address Book.

5 Select any unused number and click Add.
The Add Email Address page appears.

6 Enter a name in the Name field and e-mail address in the E-mail Address field.

7 Click the Apply button.
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Sending an E-mail With the Scanned File
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Making Copies From the DADF" on page 201
• "Making Copies From the Document Glass" on page 199

2 Press the  (Services) button.

3 Select Email.

4 Specify a recipient from the following, and then select OK:
New Recipient: Enter an e-mail address directly.

Address Book: Select from the following types of address books:

• Device Address Book - Individuals: Select an e-mail address registered in the address book.
• Device Address Book - Groups: Select a group of e-mails registered in the address book.
• Search Network Address Book: Search an e-mail address from the LDAP server address book.
Select the recipient you specified from the New Recipient to remove or edit the recipient.

Select the recipient you specified from the Address Book to remove or see details of the recipient. You can 
also change the email to Bcc.

5 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on the 
Quality and Options tabs. For details, see "File Format" on page 336.

NOTE: 
• Users need to be registered in the E-mail address book before you can select Address Book on the operator panel.
• For more information on address book and server address book, see "Address Book Editor" on page 87.
• If you are using the LDAP server address book, Email Server Address Book must be set to On. For details, see 

"Email Server Address Book" on page 318.

6 Press the  (Start) button to send e-mail.
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Adjusting Scanning Options
This section includes:

• "Adjusting the Default Scan Settings" on page 251
• "Changing the Scan Settings for an Individual Job" on page 253

Adjusting the Default Scan Settings
This section includes:

• "Setting the Scanned Image File Type" on page 251
• "Setting the Color Mode" on page 251
• "Setting the Scan Resolution" on page 252
• "Setting the Original Size" on page 252
• "Automatically Suppressing Background Variations" on page 252

For a complete list of all of the defaults settings, see "Default Settings" on page 331.

Setting the Scanned Image File Type
To specify the file type of the scanned image:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select File Format.

5 Select the type, and then select OK.
Available types:

• PDF (factory default)
• Multi-Page TIFF

• TIFF

• JPEG

• XDW

Setting the Color Mode
You can scan an image in color or in black and white. Selecting black and white significantly reduces the file size of 
the scanned images. An image scanned in color will have a larger file size than the same image scanned in black 
and white.

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Output Color.

5 Change the color setting to Color, Black & White or Gray Scale, and then select OK.



252 Scanning

Setting the Scan Resolution
You may want to change the scan resolution depending on the way you plan to use the scanned image. Scan 
resolution affects both the size and image quality of the scanned image file. The higher the scan resolution, the 
larger the file size.
To select the scan resolution:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Resolution.

5 Select one of the following options, and then select OK:
• 200 dpi: Produces the lowest resolution and smallest file size. (factory default)
• 300 dpi: Produces medium resolution and a medium file size.
• 400 dpi: Produces high resolution and a large file size.
• 600 dpi: Produces the highest resolution and largest file size.

Setting the Original Size
To specify the size of the original:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Original Size, and then select OK.

5 Select a specific paper size to determine the area to be scanned, and then select OK. 
The factory default setting is A4 (210x297mm).

Automatically Suppressing Background Variations
When scanning documents with a dark background such as newspapers, the printer automatically can detect the 
background and whiten it when outputting the image.
To turn on/off automatic suppression:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Auto Background Suppression.

5 Select either On or Off, and then select OK.
The factory default setting is On.
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Changing the Scan Settings for an Individual Job
Use the scan options to configure a variety of scanner features when scanning to a Network, Application, or USB 
storage device.

• Scan To Network/Scan To PC/Scan To USB Memory Tab
You can set the basic options of the scan such as Output Color, Resolution, 2 Sided Scanning and 
File Format.

• Quality Tab
You can set the options concerning image quality such as Lighten / Darken, Sharpness, Contrast and 
Auto Background Suppression.

• Options Tab
You can set other options for the scan such as Original Size and Edge Erase.

To temporarily change a scan setting when emailing the scanned image:

1 Press the  (Services) button.

2 Select E-mail.

3 Select scan options on the Quality and Options tabs.

4 Change the selected setting, and then select OK.

5 Press the  (Start) button to begin the scan.

To temporarily change a scan setting when scanning to a computer:

1 Press the  (Services) button.

2 Select Scan to.

3 Select the scan destination.

4 Select scan options on the Scan To PC, Quality and Options tabs.

5 Change the selected setting, and then select OK.

6 Press the  (Start) button to begin the scan.
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Scanner Connection Tool
You can check the IP address of the printer or set the password using the Scanner Connection Tool. The following 
procedure uses Windows 7 as an example.
To open the Scanner Connection Tool:
Click Start → All Programs → Fuji Xerox → DocuPrint CM405 df → Scanner Connection Tool.

IP Address Settings
In the IP Address Settings tab, you can check the IP address that is set for your scanner or change the scanner 
selection.

• IP Address
Enter the IP address.

• Search for all scanners on the network (Windows only)
Searches scanners in your network.

• Scanner List
Displays a list of scanners that are detected.

• Search again
Searches the scanners in your network. 

• Search Criteria (Windows only)
Displays the Search Criteria dialog box for setting the search condition.
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Search Criteria Dialog Box (Windows only)

• Broadcast address
Enter the subnet address.

• IPv4: Broadcast Address such as 192.168.1.255
• IPv6: Multicast Address such as ff02::1

• Search Time
Specify a time period for searching a scanner.

• Community Name
Enter the SNMPv1/v2 community name. The default community name is public.

Password Settings
In the Password Settings tab, you can enter the password that is set for your scanner to access from your 
computer to the printer.

• Password for Scanner
Enter the password.
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8
Faxing

NOTE: 
• If the Service Lock setting for Fax is set to Password Locked, you need to enter the four digit passcode to use the fax 

function. If the Service Lock setting for Fax is set to Disable, the fax function is disabled and the menu is not displayed 
on the LCD panel. For details, see "Service Lock" on page 327.

• If the Panel Lock Set is set to Enable, you need to enter the four digit passcode to enter the Admin Settings menu.

This chapter includes:
• "Connecting the Telephone Line" on page 258
• "Configuring Fax Initial Settings" on page 259
• "Sending a Fax" on page 263
• "Sending a Delayed Fax" on page 268
• "Sending a Fax from the Driver (Direct Fax)" on page 269
• "Receiving a Fax" on page 272
• "Automatic Dialing" on page 275
• "Address Book" on page 279
• "Other Ways to Fax" on page 280
• "Setting Sounds" on page 282
• "Specifying the Fax Settings Options" on page 283
• "Changing Setting Options" on page 287
• "Printing a Report Page" on page 288
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Connecting the Telephone Line
NOTE: 
• Do not connect your printer directly to a DSL (digital subscriber line). This may damage the printer. To use a DSL, you will 

need to use an appropriate DSL filter. Contact your service provider for the DSL filter.

1 Plug one end of a telephone line cord into the wall jack connector and the other end into an active wall jack.

2 To connect a telephone and/or answering machine to your printer, plug the telephone or answering machine 
line cord into the phone connector ( ).

Wall jack connector

To the wall jack

Phone connector

To an external telephone 
or answering machine
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Configuring Fax Initial Settings
This section includes:

• "Specifying the Fax Initial Settings Using the Easy Install Navi (Windows Only)" on page 259
• "Specifying the Fax Initial Settings From the Operator Panel" on page 260

Specifying the Fax Initial Settings Using the Easy Install 
Navi (Windows Only)

You can specify the region, line type, tone/pulse, receive mode, DRPD pattern, fax header name, and fax number.

1 Insert the Driver CD Kit provided with the printer in your computer. The Easy Install Navi file launches 
automatically.

2 Click Advanced Tools on the Easy Install Navi window. The Advanced Tools window appears.
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3 Click Fax Configuration.

4 Follow the instructions displayed on the screen.
Available settings are:

• Region
• Line Type
• Dial Type
• Receive Mode
• DRPD Pattern

(This setting is available only when a distinctive ring service is installed on your telephone line by your 
telephone company.)

•   Company Name
• FAX Number

NOTE: 
• To make initial settings from the printer operator panel, see "Specifying the Fax Initial Settings From the Operator Panel" 

on page 260.

Specifying the Fax Initial Settings From the Operator 
Panel

Setting Your Region
You need to set the region where your printer is used for using the fax service on the printer.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Region.

6 Select the region where the printer is used, and then select OK.

7 Select Yes,Save.
The printer restarts automatically to apply the settings.

NOTE: 
• When you configure the region setting, the information registered to the device is initialized.
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Setting the Printer ID
In most regions, you are required by law to indicate your fax number on any fax you send. The printer ID, containing 
your telephone number and name or company name, will be printed at the top of each page sent from your printer.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Fax Number.

6 Enter your fax number using the number pad.

NOTE: 
• If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

7 Select OK when the number on the display is correct.

8 Select Company Name, and then select OK.

9 Enter your name or company name using the keyboard.

10 Select OK when the name on the display is correct.
To return to the top level of the System menu, press the CA (Clear All) button.

Setting the Time and Date
NOTE: 
• It may be necessary to reset the correct time and date if loss of power to the printer occurs.

To set the time and date:

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select System Settings.

4 Select General.

5 Select Date & Time.

6 Select Time Zone.

7 Select the desired time zone, and then select OK.

8 Select Date.

9 Enter the correct date using the number pad, or select the correct date using the  or  button.

NOTE: 
• If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

10 Select OK when the date on the display is correct.

11 Select Time.

12 Enter the correct time using the number pad.

13 Select OK when the time on the display is correct.
To return to the top level of the System menu, press the CA (Clear All) button.
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Changing the Clock Mode
You can set the current time using either the 12-hour or the 24-hour format.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select System Settings.

4 Select General.

5 Select Date & Time.

6 Select Time.

7 Select the desired format, and then select OK.
To return to the top level of the System menu, press the CA (Clear All) button.
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Sending a Fax
You can fax data from your printer.
This section includes:

• "Loading an Original Document" on page 263
• "Adjusting the Document Resolution" on page 265
• "Adjusting the Document Contrast" on page 265
• "Inserting a Pause" on page 265
• "Sending a Fax From Memory" on page 266
• "Sending a Fax Manually" on page 267
• "Confirming Transmissions" on page 267
• "Automatic Redialing" on page 267

Loading an Original Document
You can use the DADF or the document glass to load an original document for faxing.

To Fax a Document Using the DADF
Using the duplex automatic document feeder (DADF), you can load up to 50 sheets of 75 gsm (20 lb) paper at a 
time.

NOTE: 
• To get the best scan quality, especially for gray scale images, use the document glass instead of the DADF.
• You cannot load the following documents in the DADF. Be sure to place them on the document glass.

1 Place the document(s) face up on the DADF with the top edge of the documents in first. Then adjust the 
document guides to the correct document size.

2 Adjust the document resolution.

See also: 
• "Adjusting the Document Resolution" on page 265

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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To Fax a Document From the Document Glass
Using the document glass, you can load one sheet at a time.

1 Lift and open the document cover.

2 Place the document face down on the document glass and align it with the registration guide on the top left 
corner of the document glass.

3 Close the document cover.

NOTE: 
• Ensure that no document is in the DADF. If any document is detected in the DADF, it takes priority over the document on 

the document glass. 
• If you are faxing a page from a book or magazine, lift the document cover until its hinges are caught by the stopper and 

then close the document cover. If the book or magazine is thicker than 30 mm, start faxing with the document cover 
open.

4 Adjust the document resolution.

See also: 
• "Adjusting the Document Resolution" on page 265

CAUTION:
• Do not apply excessive force to hold thick document on the document glass. It may break the glass and 

cause injuries.
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Adjusting the Document Resolution
You can improve the quality of the fax document by adjusting the resolution, especially for the document in 
low-quality or containing the photographic image.

1 Press the  (Services) button.

2 Select Fax.

3 Select Resolution.

4 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

NOTE: 
• Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

Adjusting the Document Contrast
You can adjust the contrast of the fax document to be lighter or darker than the original.

1 Press the  (Services) button.

2 Select Fax.

3 Select Lighten / Darken.

4 Select the desired setting, and then select OK.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Inserting a Pause
For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must 
be entered in order for the access code to function. For example, enter the access code 9 and then press the  
(Redial / Pause) button before entering the telephone number. "-" appears on the LCD panel to indicate when a 
pause is entered.

Standard* Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents 
printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode is 
enabled only if the remote machine also supports the Super Fine resolution. See the 
note below.

Photo Suitable for documents containing photographic images.

Darken +3 Works well with light print or faint pencil markings.

Darken +2
Darken +1
Normal* Works well with standard typed or printed documents.

Lighten +1 Works well with dark print.

Lighten +2
Lighten +3
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Sending a Fax From Memory
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Loading an Original Document" on page 263

2 Press the  (Services) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs.

See also: 
• "Adjusting the Document Resolution" on page 265
• "Adjusting the Document Contrast" on page 265

5 To select a fax number, do one of the followings:
• Select  button, and then select one of the following:

Device Address Book - Individuals - Select an individual fax number and then select OK.

Device Address Book - Groups - Select a group dial number and then select OK.

Search Network Address Book - Search and select a fax number from the LDAP server and then 
select OK.

• Select  button.
Enter the speed dial number using the number pad, and then select  button.

NOTE: 
• For more information on address book and server address book, see "Address Book" on page 279.
• If you are using the LDAP server address book, Fax Server Address Book must be set to On. For 

details, see "Fax Server Address Book" on page 317.
• The fax number needs to be registered before you can select Address Book.

6 Press the  (Start) button.
When the document is placed on the document glass, the display prompts you for another page. If you want to 
place a new document, replace the document with a new document, and then select Continue. When you 
have finished loading documents, select Send Now.

The printer starts dialing the number, and then sending the fax when the remote fax machine is ready.

NOTE: 
• By pressing the  (Stop) button, you can cancel the fax job at any time while sending the fax.
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Sending a Fax Manually
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Loading an Original Document" on page 263

2 Press the  (Services) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs.

See also: 
• "Adjusting the Document Resolution" on page 265
• "Adjusting the Document Contrast" on page 265

5 Select OnHook, and then select Manual Send.

6 Enter the remote fax machine's fax number using the number pad.
You can also select the recipient by using speed dial number or address book.

See also: 
• "Automatic Redialing" on page 267

NOTE: 
• You can enter a fax number using the ten key, *, and #.
• Pressing the  (Redial / Pause) button enables you to enter a pause in the fax number.
• Entering "=" in the fax number enables dial tone detection.
• Entering ":" enables you to switch dialing type from dial pulse (DP) to push button (PB).

7 Press the  (Start) button to begin sending the fax.

NOTE: 
• By pressing the  (Stop) button, you can cancel the fax job at any time while sending the fax.

Confirming Transmissions
When the last page of your document has been sent successfully, the printer beeps and returns to the standby 
mode.
If something goes wrong while sending your fax, an error message appears on the LCD panel.
If you receive an error message, select OK to clear the message and try to send the document again.
You can set your printer to print a confirmation report automatically after each fax transmission.

See also: 
• "Printing a Report Page" on page 288

Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial 
the number every minute based on the number set in the redial settings.
To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options" 
on page 283.

NOTE: 
• The printer will not automatically redial a number that was busy when the number was manually entered.
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Sending a Delayed Fax
The Delayed Start mode can be used to save scanned documents for transmission at a specified time to take 
advantage of lower long distance rates.

1 Load the document(s) face up with top edge in first into the DADF.
OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Loading an Original Document" on page 263

2 Press the  (Services) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs.

See also: 
• "Adjusting the Document Resolution" on page 265
• "Adjusting the Document Contrast" on page 265

5 Select the Options tab, and then select Delayed Send.

6 Select On.

7 Enter the start time using the number pad, and then select OK.

8 Select the Fax tab.

9 Enter the fax number of the recipient using the number pad.
You can also use speed or group dial numbers.

See also: 
• "Automatic Dialing" on page 275

10 Press the  (Start) button to scan data.
Once Delayed Start mode is activated, your printer stores all of the documents to be faxed into its memory and 
sends them at the specified time. After faxing in the Delayed Start mode is complete, the data in the memory is 
cleared.

NOTE: 
• If you turn off and on the printer, the stored documents are sent as soon as the printer is activated.
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Sending a Fax from the Driver (Direct Fax)
You can send a fax directly from the computer running a Microsoft® Windows® operating system or Mac OS® X by 
using the driver.

NOTE: 
• Only black and white faxes can be sent using Direct Fax.
• The names of the dialog boxes and the buttons may be different from those given in the following procedure depending on the 

application you are using. 
• For Windows, the fax driver is installed with the PCL 6 driver. (For details, see "Inserting the CD-ROM" on page 102.)
• For Mac OS X, to use this feature, you must install the fax driver. To install the fax driver, run the Driver CD Kit on the Mac OS 

X, and then open the MacOSX folder under the Common folder. Open either the 10.3.9-10.6 or 10.7- folder depending on the 
version of Mac OS X you are running. Double-click FX DocuPrint CM405 df.dmg, and then follow the on-screen instructions 
to install the fax driver.

1 Open the file you want to send by fax.

2 Open the print dialog box from the application, and then select your printer name.

3 Click Preferences in Windows, or select FAX Setting in Mac OS X.
For Windows:

For Mac OS X:
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4 Specify the fax settings. For more information, see the Help of the driver.

NOTE: 
• The settings done here are only applied to a single fax job.
For Windows:

For Mac OS X:
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5 For Windows, click OK to close the Printing Preferences dialog box, and then click Print. 
The Recipient Setting dialog box appears.

For Mac OS X, click Print. The Set / Check Fax Transmission dialog box appears.

For Windows:

For Mac OS X:

6 Specify the destination for the recipient in one of the following ways. For details on how to specify the 
destination, see the Help of the driver.
a Enter the name and fax number directly.
b Select a fax number from the address book.

• Look Up Address Book: Displays a list of fax numbers that are saved in the file specified for My 
Address Book file.

• Import and add file (Windows only): Allows you to select a source file such as a CSV file, WAB file, 
MAPI, or a LDAP server. (For details on LDAP server, see "Fax Server Address Book" on page 317.)

NOTE: 
• Enter the password in Passcode in Windows or Password in Mac OS X in the Authorization area before sending a fax 

if the Fax service is locked with a password.
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Receiving a Fax
This section includes:

• "About Receiving Modes" on page 272
• "Loading Paper for Receiving Faxes" on page 272
• "Receiving a Fax Automatically in the FAX Mode" on page 272
• "Receiving a Fax Manually in the TEL Mode" on page 272
• "Receiving a Fax Automatically in the TEL/FAX Mode or Ans/FAX Mode" on page 273
• "Receiving a Fax Manually Using an External Telephone" on page 273
• "Receiving Faxes Using the DRPD Mode" on page 273
• "Receiving Faxes in the Memory" on page 274
• "Polling Receive" on page 274

About Receiving Modes
NOTE: 
• To use the TEL/FAX Mode or Ans/FAX Mode, connect an external telephone or answering machine to the phone connector 

( ) on the rear of your printer.

When the memory is full, you cannot receive a fax automatically. Use an external telephone to receive a fax 
manually.

See also: 
• "Receiving a Fax Manually Using an External Telephone" on page 273

Loading Paper for Receiving Faxes
The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying, except 
that faxes can only be printed on Letter-sized, A4-sized, or Legal-sized paper. 

See also: 
• "Loading Print Media" on page 149
• "Setting Paper Sizes and Types" on page 157

Receiving a Fax Automatically in the FAX Mode
Your printer is preset to the FAX Mode at the factory. 
If you receive a fax, the printer automatically goes into the FAX Mode after a specified period of time and receives 
the fax.
To change the interval at which the printer goes into the FAX Mode after receiving an incoming call, see "Available 
Fax Settings Options" on page 283.

Receiving a Fax Manually in the TEL Mode
You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive 
code (see "Available Fax Settings Options" on page 283), or by selecting Manual Receive in OnHook (you can 
hear voice or fax tones from the remote machine) and then pressing the  (Start) button.
The printer begins receiving a fax and returns to the standby mode when the reception is completed.
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Receiving a Fax Automatically in the TEL/FAX Mode or 
Ans/FAX Mode

To use the TEL/FAX Mode or Ans/FAX Mode, you must connect an external telephone to the phone connector ( ) 
on the rear of your printer. 
If the caller leaves a message, the answering machine stores the message as it would normally. If your printer hears 
a fax tone on the line, it automatically starts to receive a fax.

NOTE: 
• If you have set your printer to Ans/FAX Mode and your answering machine is turned off, or no answering machine is 

connected to your printer, your printer will automatically go into the FAX Mode after a predefined time.

Receiving a Fax Manually Using an External Telephone
This feature works best when you are using an external telephone connected to the phone connector ( ) on the 
rear of your printer. You can receive a fax from someone you are talking to on the external telephone without having 
to go to the printer.
When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the external 
telephone, or set select Manual Receive in OnHook and then press the  (Start) button.
The printer receives the document.
Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try pressing the 
two-digit keys once again.
The remote receive code is set to Off at the factory. You can change the two-digit number to whatever you choose. 
For details on changing the code, see "Available Fax Settings Options" on page 283.

NOTE: 
• Set the dialing system of your external telephone to DTMF.

Receiving Faxes Using the DRPD Mode
The Distinctive Ring Pattern Detection (DRPD) is a telephone company service which enables a user to use a single 
telephone line to answer several different telephone numbers. The particular number someone uses to call you on is 
identified by different ringing patterns, which consist of various combinations of long and short ringing sounds.
Before using the DRPD option, Distinctive Ring service must be installed on your telephone line by the telephone 
company. To set up DRPD, you will need another telephone line at your location, or someone available to dial your 
fax number from outside. 
To set up the DRPD:

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select DRPD Pattern.

6 Select the desired pattern, and then select OK.

7 Reboot the printer by turning the power switch off and then on again.
To receive faxes in the DRPD, you need to set the menu to DRPD. For details, see "Available Fax Settings 
Options" on page 283.
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Receiving Faxes in the Memory
Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you 
receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the 
memory. Then, as soon as you finish copying, printing, or re-supply the toner cartridges, the printer automatically 
prints the fax.

Polling Receive
You can receive faxes from the remote fax machine when you want to receive it.

1 Press the  (Services) button.

2 Select Fax.

3 Select the Options tab, and then select Polling Receive.

4 Select On, and then select OK.

5 Enter the number of the remote machine using the number pad.

NOTE: 
• For information on how to enter the fax number of the remote machine, see "Sending a Fax From Memory" on page 266 

or "Sending a Fax Manually" on page 267. 

6 Press the  (Start) button.
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Automatic Dialing
This section includes:

• "Speed Dialing" on page 275
• "Setting Speed Dial" on page 275
• "Sending a Fax Using Speed Dial" on page 276
• "Group Dialing" on page 276
• "Setting Group Dial" on page 277
• "Editing Group Dial" on page 277
• "Sending a Fax Using Group Dialing (Multi-address Transmission)" on page 278
• "Printing a Fax Address Book List" on page 278

Speed Dialing
You can store up to 200 frequently dialed numbers in speed dial locations (1–200).
When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from 
the operator panel or CentreWare Internet Services.

Setting Speed Dial
1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Address Book.

4 Select Individuals.

5 Select the desired speed dial number between 1 and 200.

6 Select the Name text box.

7 Enter the name, and then select OK.

8 Select the Fax Number text box.

9 Enter the number you want to store using the number pad, and then select OK.
To insert a pause between numbers, press the  (Redial / Pause) button. "-" appears on the LCD panel.

10 Select OK.
To store more fax numbers, repeat steps 5 to 10.

To return to the top level of the System menu, press the CA (Clear All) button.
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Sending a Fax Using Speed Dial
1 Load the document(s) face up with top edge in first into the DADF.

OR

Place a single document face down on the document glass, and close the document cover.

See also: 
• "Loading an Original Document" on page 263

2 Press the  (Services) button.

3 Select Fax and then select  button.

4 Enter the speed dial number between 001 and 200 using the number pad, and then select  button.

5 Adjust the document resolution to suit your fax needs.

See also: 
• "Adjusting the Document Resolution" on page 265
• "Adjusting the Document Contrast" on page 265

6 Press the  (Start) button.
The document scans into the memory.

When the document is placed on the document glass, the display prompts you for another page. If you want to 
place a new document, replace the document with a new document, and then press the  (Start) button. 
When you have finished loading documents, select Send Now.

The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote 
fax machine answers.

NOTE: 
• Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, you 

can send a document to the locations registered between 001 and 009.

Group Dialing
If you frequently send the same document to several destinations, you can create a group of these destinations and 
set them under a one-digit group dial location. This enables you to use a group dial number setting to send the same 
document to all the destinations in the group.

NOTE: 
• You cannot include one group dial number within another group dial number.
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Setting Group Dial
1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Address Book and then select Groups.

4 Select the desired group dial number between 01 and 06.

5 Select the Enter Group Name text box.

6 Enter the name, and then select OK.

7 Select Add from Address Book.

8 Select the desired speed dial numbers.

9 Select OK, and then select OK again.
To store more group dial numbers, repeat steps 4 to 9. 

To return to the top level of the System menu, press the CA (Clear All) button.

Editing Group Dial
You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Address Book and then select Groups.

4 To change the group dial name:
a Select the group dial number that you want to edit, and then select Edit.
b Select Enter Group Name text box.
c Enter a new name, and then select OK twice.
To delete a speed dial number from the group dial number:

a Select the group dial number that you want to edit, and then select Edit.
b Select the speed dial number that you want to edit.
c Select Remove.
d Select OK.
To delete the group dial:

a Select the group dial number.
b Select Remove.
c Select Delete.

NOTE: 
• When you delete the last speed dial in a group, the group itself is not deleted.

5 If you want to edit another group dial number, repeat step 4.
To return to the top level of the System menu, press the CA (Clear All) button.
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Sending a Fax Using Group Dialing (Multi-address 
Transmission)

You can use group dialing for broadcasting or delayed transmissions.
Follow the procedure of the desired operation (For delayed transmission, see "Sending a Delayed Fax" on 
page 268).
You can use one or more group numbers in one operation. Then continue the procedure to complete the desired 
operation.
Your printer automatically scans the document loaded in the DADF or on the document glass into the memory. The 
printer dials each of the numbers included in the group.

Printing a Fax Address Book List
You can check your automatic dial setting by printing a Fax Address Book list.

1 Press the  (System) button.

2 Select Report / List.

3 Select Fax Address Book, and then select Print.
A list of your Fax Address Book entries is printed.
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Address Book
You can select the registered phone numbers from the address books.

1 Load the document(s) face up with top edge in first into the DADF.
OR

Place a single document face down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document" on page 263.

2 Press the  (Services) button.

3 Select Fax.

4 To select the registered phone numbers from the address books:
a Select Device Address Book - Individuals or Device Address Book - Groups.
b Select the desired speed dial number or group dial number.
c Select OK.

NOTE: 
• The fax number needs to be registered before you can select address book.

5 Press the  (Start) button to begin sending the fax.
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Other Ways to Fax
This section includes:

• "Using the Secure Receiving Mode" on page 280
• "Using an Answering Machine" on page 281
• "Using a Computer Modem" on page 281

Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the 
secure fax mode using the Secure Receive option to restrict printing out all of the received faxes when the printer 
is unattended. In the secure receiving mode, all incoming faxes will go in memory. When the mode turns off, any 
faxes stored will be printed.

NOTE: 
• Before operation, ensure Panel Lock is enabled.

To turn the secure receiving mode on:

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Incoming Defaults.

5 Select Secure Receive.

6 Select Secure Receive Set.

7 Select Enable, and then select OK.

8 Enter a four-digit password using the number pad, and then select OK.
To return to the top level of the System menu, press the CA (Clear All) button.

When a fax is received in the secure receiving mode, your printer stores it into memory and the Active Jobs 
screen displays Secure Receive to let you know that there is a fax stored.

To print received documents:

1 Press the  (Job Status) button.

2 Select Secure Fax Receive.

3 Enter the passcode, and then select OK.
The faxes stored in memory are printed.

To turn the secure receiving mode off:

1 Access the Secure Receive Set menu by following steps from 1 to 6 in "To turn the secure receiving mode 
on:" on page 280.

2 Select Disable, and then select OK.
To return to the top level of the System menu, press the CA (Clear All) button.
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Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the rear of your printer as shown above.
• Set your printer to the Ans/FAX Mode and set Auto Ans. Ans/FAX to specify the time for the TAD.
• When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts 

receiving the fax.
• If the answering device is off, the printer automatically goes into the FAX Mode after the ring tone sounds for a 

predefined time.
• If you answer the call and hear fax tones, the printer will answer the fax call if you

→ Select Manual Receive in OnHook (you can hear voice or fax tones from the remote machine), and then 
press the  (Start) button and hang up the receiver.

OR

→ Press the two-digit remote receive code and hang up the receiver.

Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up internet connection, connect the computer 
modem directly to the rear of your printer with the TAD as shown above.

• Set your printer to the Ans/FAX Mode and set Auto Ans. Ans/FAX to specify the time for the TAD.
• Turn off the computer modem's Fax Receive feature.
• Do not use the computer modem if your printer is sending or receiving a fax.
• Follow the instructions provided with your computer modem and fax application to fax via the computer 

modem.

To the 
wall jack Printer

Line

Telephone Answering Device Phone

To the 
internet

Computer Printer

Line

Telephone Answering Device Phone
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Setting Sounds
This section includes:

• "Speaker Volume" on page 282
• "Ringer Volume" on page 282

Speaker Volume
1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Line Monitor.

6 Select the desired volume, and then select OK.

7 Reboot the printer by turning the power switch off and then on.

Ringer Volume
1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Incoming Defaults.

5 Select Ring Tone Volume.

6 Select the desired volume, and then select OK.

7 Reboot the printer by turning the power switch off and then on.
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Specifying the Fax Settings Options
This section includes:

• "Changing the Fax Settings Options" on page 283
• "Available Fax Settings Options" on page 283

Changing the Fax Settings Options
1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select the desired menu item.

5 Select the desired setting or enter the value using the number pad.

6 Select OK to save the selection.

7 Ensure that the message This Setting Becomes Effective after Restart appears, and then press 
any button.

8 If necessary, repeat steps 4 to 6.
To return to the top level of the System menu, press the CA (Clear All) button.

Available Fax Settings Options
You can use the following settings options for configuring the fax system:

Option Description
 Fax Number Specifies the fax number of the printer, which will be printed on the header of 

faxes. This feature is available when you set Send Header to On. The 
number specified in Fax Number is used in the printer ID.

Region You can select the region where the printer is used.

You can change this setting when:
• No jobs in operation
• No fax jobs waiting in the memory

Company Name Specifies the sender’s name to be printed on the header of faxes.

Line Type You can select the default line type.
• PSTN
• PBX

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission 
through the internal speaker until a connection is made.

DRPD Pattern Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive 
ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

Extel Hook Threshold You can select the external telephone hook detection threshold for the 
condition in which a telephone line is not being used.
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Receive Mode TEL Mode Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone and then pressing the remote receive 
code, or by selecting Manual Receive in OnHook (you can hear voice or 
fax tones from the remote machine) and then pressing the  (Start) button.

FAX Mode* Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external telephone rings for 
the time specified in Auto Ans. TEL/FAX, and then the printer 
automatically receives a fax. If an incoming call is not a fax, the printer beeps 
from the internal speaker indicating that the call is a telephone call.

Ans/FAX Mode The printer can share a telephone line with an answering machine. In this 
mode, the printer will monitor the fax signal and pick up the line if there are 
fax tones.

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive 
ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming call is a 
telephone call through the internal speaker when Ans Select is set to 
TEL/FAX Mode.

Auto Answer 
Setup

Auto Answer Fax Sets the interval at which the printer goes into the fax receive mode after 
receiving an incoming call. The interval can be specified within the range of 0 
to 255 seconds. The default is 0 second.

Auto Answer 
TEL/FAX

Sets the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call. The interval can be specified 
within the range of 0 to 255 seconds. The default is 6 seconds.

Auto Answer 
Ans/FAX

Sets the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call. The interval can be 
specified within the range of 0 to 255 seconds. The default is 21 seconds.

Junk Fax Filter You can reject faxes sent from unwanted stations. The system only accepts 
faxes from the remote stations registered in the speed dial. This feature is 
useful for blocking any unwanted faxes.

Select Off to turn the feature off. Anybody can send you a fax.

Select On to turn the feature on.

Secure Receive Secure Receive 
set

Allows you to password protect all the incoming faxes. When the Secure 
Receive feature is enabled, the printer stores incoming faxes and prints them 
when the correct password is entered on the operator panel.

Option Description
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Forward Settings You can set your printer to forward incoming faxes to another fax number, an 
e-mail address, or a server.

When a fax arrives at your printer, it is stored in the memory. Then, the printer 
does one of the following:
• Dials the fax number you have specified in Forwarding Number
• Sends an e-mail to the address you have specified in Forwarding E-mail 

Address 1-5. The fax is converted to a pdf and is attached to the e-mail
• Saves a pdf version of the fax to a shared folder on a server you have 

specified in Forward to Server Settings

Select Off to not forward incoming faxes.

Select Forward to forward incoming faxes without printing. If an error occurs 
during forwarding a received fax, the printer prints the fax.

Select Print and Forward to forward and print incoming faxes.

Select Print and E-mail to print incoming faxes and also forward to 
e-mail.

Select Forward to Server to forward incoming faxes to a server.

Select Print and Forward to Server to print incoming faxes and also 
forward to a server.

To forward to a fax number, you need to register a fax number on Forwarding 
Number. To forward to an e-mail address, you need to register information on 
E-mail and Forwarding E-mail Address. To forward to a server, you need to 
register the server information on Forward to Server Settings.

For information on E-mail, see "E-Mail Settings" on page 248 and for 
information on Forwarding E-mail Address, see the Help on CentreWare 
Internet Services. For information on Forwarding Number, see "Forward 
Settings" on page 310. For information about shared folders on servers, see 
"Using a Scanner on the Network" on page 224 and for information on 
Forward to Server Settings, see the Help on CentreWare Internet Services.

Forwarding Number You enter the fax number of the destination to which incoming faxes will be 
forwarded.

2 Sided Print You can set whether to make duplex print when you print faxes.

Select Off to print faxes on one side of a sheet of paper.

Select On to print faxes on both sides of a sheet of paper.

Remote Receive You can receive a fax by pressing the remote receive code on the external 
telephone after picking up the handset of the telephone.

Remote Receive Tone You can specify the tone when Remote Receive is set to On.

Discard Size When receiving a document as long as or longer than the paper installed in 
your printer, you can set the printer to discard any excess at the bottom of the 
page. If the received page is outside the margin you set, it will print on two 
sheets of paper at the actual size. When the document is within the margin 
and Discard Size is set to Auto Reduction, the printer reduces the 
document to fit it onto the appropriate sized paper and discard does not 
occur. If Discard Size is set to other than Auto Reduction, the data 
within the margin will be discarded.

Auto Redial Setup Number of Redial You can specify the number of redial attempts to make when the destination 
fax number is busy, within the range of 0 to 9. If you enter 0, the printer will 
not redial.

Redial Interval Your printer can automatically redial a remote fax machine if it was busy. 
Intervals from 1–15 minutes can be entered.

Interval Timer You can specify the interval between transmission attempts within the range 
of 3 to 255 seconds. The default is 8 seconds.

Dial Type You can select the dialing type.
• PB
• DP (10PPS)
• DP (20PPS)

Prefix Dial You can specify whether or not to set a prefix dial number.

Option Description
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• Prefix Dial
NOTE: 
• Prefix Dial supports only the environment where you send a fax to the external line number. To use Prefix Dial, you must do 

the following from the operator panel. 

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Line Type.

6 Select PBX.

7 Access the Fax Settings menu by following steps from 1 to 3.

8 Select Transmission Defaults.

9 Select Prefix Dial.

10 Select On, and then select OK.

11 Enter an up-to-five-digit prefix number from 0–9, *, and #, and then select OK.

12 Reboot the printer by turning the power switch off and then on.

Prefix Dial Number You can set a prefix dial number of up to five digits. This number dials before 
any auto dial number is started. It is useful for accessing the Private 
Automatic Branch Exchange (PBX).

Fax Cover Page You can set whether to attach a cover page to faxes when sending faxes.

Send Header Prints the sender’s information on the header of faxes. 

Select Off to turn this feature off. 

Select On to turn this feature on.

Note that if United States is selected for the setting of Region, this option 
does not appear on the menu. The setting is fixed to On and cannot be 
changed.

For information on the region setting, see "Specifying the Fax Initial Settings 
From the Operator Panel" on page 260.

ECM You can set whether to enable or disable the ECM (Error Correction Mode).

Modem Speed You can set the modem speed.

Display Manual Fax Recipients To set whether to display the fax number of the recipient when manually 
sending a fax.

Fax Reports Fax Activity You can set whether to automatically print a fax activity report after every 50 
incoming and outgoing fax communications.

Fax Transmit You can set whether to print a transmission result after a fax transmission.

Fax Broadcast You can set whether to print a transmission result after a fax broadcast to 
multiple locations.

Fax Protocol You can set whether to print the protocol monitor report after a fax 
transmission to monitor fax protocol problems.

Option Description
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Changing Setting Options
1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Fax Defaults.

4 Select the desired menu item.

5 Select the desired setting or enter the value using the number pad, and then select OK.
To return to the top level of the System menu, press the CA (Clear All) button.
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Printing a Report Page
The following reports may be useful when you use the fax:

• Fax Address Book
This list shows all the fax numbers currently stored in the memory of your printer as speed dial numbers.

You can print this Fax Address Book list from the operator panel. (For details, see also "Printing a Fax Address 
Book List" on page 278.)

• Email Address Book
This list shows all the e-mail addresses currently stored in the memory of your printer as Email Address Book 
information.

• Fax Activity
This report shows information about the faxes you recently received or sent.

• Fax Pending
This list shows the status of pending faxes. You may print this list to confirm your changes after changing any 
settings.

Procedures:

1 Press the  (System) button.

2 Select Report / List.

3 Select the report or list you want to print, and then select Print.
The selected report or list is printed.



Using the Operator Panel Menus and Keypad 289

9
Using the Operator Panel Menus and 
Keypad

This chapter includes:
• "Understanding the Printer Menus" on page 290
• "Panel Lock Function" on page 348
• "Limiting Access to Copy, Fax, Scan, and Print from USB Operations" on page 349
• "Changing the Language" on page 350
• "Setting the Energy Saver Option" on page 351
• "About the Concurrent Jobs Feature" on page 352
• "Resetting to Factory Defaults" on page 353
• "Entering Characters" on page 354
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Understanding the Printer Menus
When your printer is connected to a network and available to a number of users, the access to the Admin 
Settings can be limited. This prevents other users from using the operator panel to inadvertently change a user 
default that has been set by the administrator. 
However, you can use your print driver to override user defaults and select settings for individual print jobs.

Report / List
Use the Report / List menu to print various types of reports and lists.

System Settings
Purpose:
To print a list of the current user default values, the installed options, the amount of installed print memory, and the 
status of printer supplies.

Panel Settings
Purpose:
To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List
Purpose:
To print a sample of the available PCL fonts.

PCL Macros List
Purpose:
To print the information on the downloaded PCL macro.

PS Fonts List
Purpose:
To print a sample of the available PS fonts.

PDF Fonts List
Purpose:
To print a sample of the available PDF fonts.

Job History
Purpose:
To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list contains the last 20 
jobs.

Error History
Purpose:
To print a detailed list of paper jams and fatal errors.
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Printer Meter
Purpose:
To print the reports for the total number of pages printed.

Demo Page
Purpose:
To print a page for testing colors.

Protocol Monitor
Purpose:
To print a detailed list of monitored protocols.

Fax Address Book
Purpose:
To print the list of all fax addresses stored as Fax Address Book information.

Email Address Book
Purpose:
To print the list of all e-mail addresses stored as Email Address Book information.

Server Address
Purpose:
To print the list of all server addresses stored as Server Address information.

Fax Activity
Purpose:
To print the report of faxes you recently received or sent.

Fax Pending
Purpose:
To print the list of status of pending faxes. 

Stored Documents
NOTE: 
• Stored Documents feature is available only when the optional 512MB memory is installed on the printer and RAM Disk under 

System Settings is enabled or when the hard disk unit is installed.

Purpose:
To print a list of all files stored for Secure Print and Sample Print in the RAM disk.
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Billing Meters
Purpose:
To check the total number of printed pages.
Values:

*1 This item always shows 0 on your printer.

Admin Settings
Use the Admin Settings menu to configure a variety of printer features.

Fax Address Book
Use the Fax Address Book menu to configure the individuals and groups settings.

• Individuals
Purpose:
To store up to 200 frequently dialed numbers in individuals locations.

• Groups
Purpose:
To create a group of fax destinations and register it under a two-digit dial code. Up to six group dial codes can be 
registered.

PCL Settings
Use the PCL Settings menu to change printer settings that only affect jobs using the PCL emulation printer 
language.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Paper Tray
Purpose:
To specify the default paper tray.
Values:

*1 Tray2 is available only when the optional 550 sheet feeder is installed.

Meter1 Displays the total number of color prints.

Meter2 Displays the total number of monochrome prints.

Meter3*1 Displays the total number of large size color prints. 

Meter4 Displays the total number of color and monochrome prints (Meter1 + Meter2).

Auto*

Bypass Tray
Tray1
Tray2*1
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• Output Size
Purpose:
To specify the default paper size.
Values:

mm series

*1The default for Output Size varies depending on region-specific factory.

inch series

*1The default for Output Size varies depending on region-specific factory.

NOTE: 
• Selecting New Custom Size for the paper size prompts you to enter a custom length and width.

A4 (210 x 297mm)*1

A5 (148 x 210mm)
B5 (182 x 257mm)
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
Executive(7.25 x 10.5")
Monarch Env. (3.9 x 7.5")
DL Env. (110 x 220mm)
C5 Env. (162  x 229mm)
#10 Env. (4.1 x 9.5")
New Custom Size Width(x) 210 mm* Specifies the length of the 

custom size paper.77 - 215 mm

Length(y) 297 mm* Specifies the length of the 
custom size paper.127 - 355 mm

Letter (8.5 x 11")*1

Folio (8.5 x 13")
Legal (8.5 x 14")
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)
Executive(7.25 x 10.5")
Monarch Env. (3.9 x 7.5")
DL Env. (110 x 220 mm)
C5 Env. (162  x 229 mm)
#10 Env. (4.1 x 9.5")
New Custom Size Width(x) 8.3 inch* Specifies the length of the 

custom size paper.3.0-8.5 inches

Length(y) 11.7 inch* Specifies the width of the 
custom size paper.5.0-14.0 inches
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• Orientation
Purpose:
To specify how text and graphics are oriented on the page.
Values:

• 2 Sided Print
Purpose:
To specify whether to print on both sides of a sheet of paper.
Values:

• Font
Purpose:
To specify the default font from the fonts registered in the printer.
Values:

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.

1 Sided* Does not print on both sides of a sheet of paper.

2 Sided Binding Edge Long Edge Flip* Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

CG Times LetterGothic CourierPS
CG Times It LetterGothic It CourierPS Ob
CG Times Bd LetterGothic Bd CourierPS Bd
CG Times BdIt Albertus Md CourierPS BdOb
Univers Md Albertus XBd SymbolPS
Univers MdIt Clarendon Cd Palatino Roman
Univers Bd Coronet Palatino It
Univers BdIt Marigold Palatino Bd
Univers MdCd Arial Palatino BdIt
Univers MdCdIt Arial It ITCBookman Lt
Univers BdCd Arial Bd ITCBookman LtIt
Univers BdCdIt Arial BdIt ITCBookmanDm
AntiqueOlv Times New ITCBookmanDm It
AntiqueOlv It Times New It HelveticaNr
AntiqueOlv Bd Times New Bd HelveticaNr Ob
CG Omega Times New BdIt HelveticaNr Bd
CG Omega It Symbol HelveticaNrBdOb
CG Omega Bd Wingdings N C Schbk Roman
CG Omega BdIt Line Printer N C Schbk It
GaramondAntiqua Times Roman N C Schbk Bd
Garamond Krsv Times It N C Schbk BdIt
Garamond Hlb Times Bd ITC A G Go Bk
GaramondKrsvHlb Times BdIt ITC A G Go BkOb
Courier* Helvetica ITC A G Go Dm
Courier It Helvetica Ob ITC A G Go DmOb
Courier Bd Helvetica Bd ZapfC MdIt
Courier BdIt Helvetica BdOb ZapfDingbats
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• Symbol Set
Purpose:
To specify a symbol set for a specified font.
Values:

• Font Size
Purpose:
To specify the font size for scalable typographic fonts, within the range of 4.00 to 50.00. The default is 12.00.
Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

NOTE: 
• The Font Size menu is only displayed for typographic fonts.

• Font Pitch
Purpose:
To specify the font pitch for scalable mono spaced fonts, within the range of 6.00 to 24.00. The default is 10.00.
Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscheduled mono 
spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: 
• The Font Pitch menu is only displayed for fixed or mono spaced fonts.

• Form Line
Purpose:
To set the number of lines in a page.
Values:

*1Denotes region-specific factory default values. 

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 
Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also: 
• "Orientation" on page 294

ROMAN-8* WIN L1 ISO-6
ISO L1 WIN L2 ISO-11
ISO L2 WIN L5 ISO-15
ISO L5 DESKTOP ISO-17
ISO L6 PS TEXT ISO-21
PC-8 MC TEXT ISO-60
PC-8 DN MS PUB ISO-69
PC-775 MATH-8 WIN 3.0
PC-850 PS MATH WINBALT
PC-852 PI FONT SYMBOL
PC-1004 LEGAL WINGDINGS
PC-8 TK ISO-4 DNGBTSMS

64*1  (mm series)/60*1 (inch series) Sets the value in increments of 1.

5–128
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• Quantity
Purpose:
To set the default print quantity, within the range of 1 to 999. The default is 1. (Set the number of copies required for 
a specific job from the print driver. Values selected from the print driver always override values selected from the 
operator panel.)

• Image Enhance
Purpose:
To specify whether to enable the Image Enhance feature, which makes the boundary line between black and white 
smoother to decrease jagged edges and enhance the visual appearance.
Values:

• Hex Dump
Purpose:
To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in 
hexadecimal and character representation. Control codes are not executed.
Values:

• Draft Mode
Purpose:
To save toner by printing in the draft mode. The print quality is reduced when you print in the draft mode.
Values:

• Line Termination
Purpose:
To add the line termination commands.
Values:

Off Disables the Image Enhance feature.

On* Enables the Image Enhance feature.

Disable* Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.

CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF
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• Output Color
Purpose:
To specify the color mode to Color or Black and White. This setting is used for a print job that does not specify a print 
mode.
Values:

• Ignore Form Feed
Purpose:
To specify whether to ignore blank pages that only contain Form Feed control codes.
Values:

PostScript Settings
Use the PostScript Settings menu to change printer settings that only affect jobs using the PostScript® 
emulation printer language.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• PS Error Report
Purpose:
To specify whether to print the contents of PostScript errors.
The change becomes effective after the printer is turned off and then on again.
Values:

NOTE: 
• Instructions from the PS driver override the settings specified on the operator panel.

• PS Job Time-out
Purpose:
To specify the runtime of one PostScript job.The change becomes effective after the printer is turned off and then on 
again.
Values:

Black and White* Prints in the black and white mode.

Color Prints in the color mode.

Off* Disables the Ignore Form Feed feature.

On Enables the Ignore Form Feed feature.

Off Discards the print job without printing an error message.

On* Prints an error message before it discards the job.

Off* Job time-out does not occur.

On 1 A PostScript error occurs if processing is not completed after the specified 
time.1-900min
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• Paper Select Mode
Purpose:
To set the way to select the paper tray for PostScript mode.The change becomes effective after the printer is turned 
off and then on again.
Values:

• Output Color
Purpose:
To specify the color mode to Color or Black and White. This setting is used for a print job which does not specify a 
print mode.
Values:

PDF Settings
Use the PDF Settings menu to change printer settings that only affect the PDF jobs.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Quantity
Purpose:
To specify the number of copies to print.
Values:

• 2 Sided Print
Purpose:
To specify whether to print on both sides of a sheet of paper.
Values:

• Print Mode
Purpose:
To specify the print mode.
Values:

Auto* The tray is selected as the same setting as in the PCL mode.

Select From Tray The tray is selected in a method compatible with regular PostScript printers.

Color* Prints in color mode.

Black and White Prints in black and white mode.

1* Sets the value in increments of 1.

1–999

1 Sided* Does not print on both sides of a sheet of paper.

2 Sided Binding Edge Long Edge Flip* Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

Normal* For documents with normal sized characters. 

High Quality For documents with small characters or thin lines, or documents printed using a dot-matrix 
printer.

High Speed Prints with the higher speed than the Normal mode, but the quality is less. 
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• PDF Password
Purpose:
To specify the password to print the secure PDF. 
Value:

• Collation
Purpose:
To specify whether to sort the job.
Values:

• Output Size
Purpose:
To specify the output paper size for PDF.
Values:

*1 The default paper size is displayed.

• Layout
Purpose:
To specify the output layout.
Values:

• Output Color
Purpose:
To specify the output color.
Values:

Enter PDF Password Enter the password to print the secure PDF.

Collated Sorts the job.

Uncollated* Does not sort the job.

A4*1

Letter*1

Auto

Full to Paper*

100% (No Scaling)
Booklet
2 Sides per Page
4 Sides per Page

Color (Auto)*

Black and White
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Network Setup
Use the Network Setup menu to change the printer settings affecting jobs sent to the printer through the wired or 
wireless network.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Ethernet/Wireless
NOTE: 
• When using a wired network, Ethernet is displayed. When the optional wireless printer adapter is attached and the 

Ethernet cable is disconnected, Wireless is displayed.

Purpose:
To confirm or specify network settings.

Wireless Status

NOTE: 
• Wireless Status feature is available only when the printer is connected using the wireless network.

Purpose:
To confirm the wireless communication status.
Values:

*The settings can be configured only on CWIS.

Status Good
Acceptable
Low
No Reception

SSID Displays the name that identifies the wireless network.
Encryption Type No Security 

WEP
WPA-PSK-TKIP
WPA2-PSK-AES
Mixed mode PSK
WPA-Enterprise-TKIP*
WPA2-Enterprise-AES*
Mixed mode Enterprise*
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Wireless Setup Wizard
NOTE: 
• Wireless Setup Wizard is available only when the printer is connected using the wireless network.

Purpose:
To configure the wireless network interface. The printer automatically searches and list available access points. 
Select one of the access points, and enter a pass phrase or WEP key to complete the wireless setup. You can also 
specify and configure the wireless network manually.
Values:

Select 
Access

Select the access point from the list.
WEP Key When you select an access point using WEP as the 

encryption type, enter the WEP key.
WPA When you select an access point using WPA, WPA2, or 

Mixed as the encryption type, enter the password.WPA2
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Manual 
SSID Setup

Enter SSID Specifies a name to identify the wireless network. Up to 
32 alphanumeric characters can be entered.

Infrastructure Select when you configure the wireless setting through 
the access point such as a wireless router.

No Security Specifies to configure the wireless setting without 
specifying a encryption type from WEP, 
WPA-PSK-TKIP, and WPA-PSK-AES.

Mixed mode 
PSK*

Select to configure the wireless setting with the 
encryption type of Mixed mode PSK.
Wireless Setup 
Password

Specifies the password of 
alphanumeric characters from 8 
to 63.

WPA-PSK-TKIP Select to configure the wireless setting with the 
encryption type of WPA-PSK-TKIP.
Wireless Setup 
Password

Specifies the password of 
alphanumeric characters from 8 
to 63.

WPA2-PSK-AES Select to configure the wireless setting with the 
encryption type of WPA2-PSK-AES.
Wireless Setup 
Password

Specifies the password of 
alphanumeric characters from 8 
to 63.

WEP Specifies the WEP key to use through the wireless 
network. For 64bit keys, up to 10 hexadecimal 
characters can be entered. For 128bit keys, up to 26 
hexadecimal characters can be entered.
Transmit Key Specifies the transmit key from 

Auto, WEP Key 1, WEP Key 
2, WEP Key 3,and WEP Key 
4.

Ad-hoc Select to configure the wireless setting without the 
access point such as a wireless router.

No Security* Select to configure the wireless setting without 
specifying the encryption type from WEP.

WEP Specifies the WEP key to use through the wireless 
network. For 64bit keys, up to 10 hexadecimal 
characters can be entered. For 128bit keys, up to 26 
hexadecimal characters can be entered.
Transmit Key Specifies the transmit key from 

WEP Key 1, WEP Key 2, WEP 
Key 3, and WEP Key 4.
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WPS Setup

NOTE: 
• WPS Setup is available only when the printer is connected using the wireless network.

Purpose:
To configure the wireless network using WPS.
Values:

IP Mode
Purpose:
To configure the IP mode.
Values:

TCP/IP
Purpose:
To configure TCP/IP settings.
Values:

Push Button Control* Start Configuration Configures the wireless setting with WPS-PBC.
PIN Code Start Configuration Configures the wireless setting using the PIN code assigned 

automatically by the printer.
Print PIN Code Prints the PIN code. Confirm it when entering PIN assigned to 

the printer into your computer.

Dual Stack* Uses both IPv4 and IPv6 to set the IP address.
IPv4 Mode Uses IPv4 to set the IP address.
IPv6 Mode Uses IPv6 to set the IP address.

Get IP Address DHCP / AutoIP* Sets the IP address automatically. A random value in the range 
of 169.254.1.0 to 169.254.254.255 that is not currently in 
use on the network is set as the IP address. The subnet mask is 
set as 255.255.0.0.

BOOTP Sets the IP address using BOOTP.
RARP Sets the IP address using RARP.
DHCP Sets the IP address using DHCP.
Panel Use this option when you want to set the IP address manually on 

the operator panel.
IP Address When an IP address is being set manually, the IP is allocated to 

the printer using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 
254. 127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address.

Subnet Mask When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 
255.255.255.255.255 cannot be specified as the subnet 
mask.

Gateway 
Address

When an IP address is being set manually, the gateway address 
is specified using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 
to 254. 127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address.
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IPsec
NOTE: 
• IPsec feature is available only when IPsec is enabled on the CentreWare Internet Services.

Purpose:
Disables IPsec.
Value:

Reset Wireless
NOTE: 
• Reset Wireless feature is available only when the printer is connected using the wireless network.

Purpose:
To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values.
Value:

Connection Speed

NOTE: 
• Connection Speed feature is available only when the printer is connected using the wired network.

Purpose:
To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the 
printer is turned off and then on again.
Values:

Disable Disables IPsec.

Reset Initialize wireless network settings.

Auto* Detects the Ethernet settings automatically.
10BASE-T Half Uses 10BASE-T Half-duplex.
10BASE-T Full Uses 10BASE-T Full-duplex.
100BASE-TX Half Uses 100BASE-TX Half-duplex.
100BASE-TX Full Uses 100BASE-TX Full-duplex.
1000BASE-T Full Uses 1000BASE-T Full-duplex.
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• Protocols
Purpose:
To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.
Values:

*1 HTTP-SSL/TLS is available only when a certificate is created using CentreWare Internet Services. For details about creating a 
certificate, see the Help on the CentreWare Internet Services.

NOTE: 
• WSD stands for Web Services on Devices.

LPD Disable Disables the Line Printer Daemon (LPD) port.
Enable* Enables the LPD port.

Port9100 Disable Disables the Port9100 port.
Enable* Enables the Port9100 port.

FTP Disable Disables FTP port.
Enable* Enables FTP port.

IPP Disable Disables IPP port.
Enable* Enables IPP port.

SMB TCP/IP Disable Disables SMB TCP/IP port.
Enable* Enables SMB TCP/IP port.

SMB NetBEUI Disable Disables SMB NetBEUI port.
Enable* Enables SMB NetBEUI port.

WSD Print Disable Disables WSD print.
Enable* Enables WSD print.

WSD Scan Disable Disables WSD scan.
Enable* Enables WSD scan.

Network TWAIN Disable Disables Network TWAIN.
Enable* Enables Network TWAIN.

SNMP UDP Disable Disables the Simple Network Management Protocol (SNMP) UDP 
port.

Enable* Enables the SNMP UDP port.
StatusMessenger Disable Disables the Status Messenger feature.

Enable* Enables the Status Messenger feature.
InternetServices Disable Disables an access to CentreWare Internet Services embedded in 

the printer.
Enable* Enables an access to CentreWare Internet Services embedded in 

the printer.
Bonjour(mDNS) Disable Disables Bonjour® (mDNS).

Enable* Enables Bonjour (mDNS).
Telnet Disable Disables Telnet.

Enable* Enables Telnet.
Update Address 
Book

Disable Disables Update Address Book.
Enable* Enables Update Address Book.

HTTP-SSL/TLS*1 Disable* Disables HTTP-SSL/TLS.
Enable Enables HTTP-SSL/TLS.
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• Advanced Settings
Purpose:
To specify advanced network settings.

IP Filter

NOTE: 
• IP Filter feature is available only when Protocols is set to LPD or Port9100.

Purpose:
To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP 
addresses. The change becomes effective after the printer is turned off and then on again.
Values:

802.1x

NOTE: 
• 802.1x feature is available only when the printer is connected using LAN cable and the 802.1x authentication is enabled using 

CentreWare Internet Services. For details about setting 802.1x, see the Help on the CentreWare Internet Services.

Purpose:
To disable 802.1x authentication. The change becomes effective after the printer is turned off and then on again.

• Adobe Protocol
Purpose:
To specify PostScript communication protocol for a parallel interface, you can configure the Adobe Protocol settings 
for the wired network. The change becomes effective after the printer is turned off and then on again.
Values:

• Reset Network Setup
Purpose:
To initialize wired network data stored in non-volatile memory (NVM). After executing this function and rebooting
the printer, all wired network settings are reset to their default values.

n (n is 1-5) IP Address Sets the IP address for Filter n.
Subnet Mask Sets the address mask for Filter n.
Mode Not 

Active*
Disables the IP Filter feature for Filter n.

Accept Accepts an access from the specified IP address.
Reject Rejects an access from the specified IP address.

Disable Disables 802.1x.

Auto* Sets the PostScript communications protocol automatically.
Standard Sets the PostScript communications protocol to Standard.
BCP Sets the PostScript communications protocol to BCP.
TBCP Sets the PostScript communications protocol to TBCP.
Binary Sets the PostScript communications protocol to Binary.

Reset Initializes the wired network data stored in NVM.
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Fax Settings
Use the Fax Settings menu to configure the basic fax settings.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Fax Line Settings
Purpose:
To configure basic settings for the fax line.

Fax Number
Purpose:
To set the fax number of the printer, which will be printed on the header of a fax message.

NOTE: 
• Ensure to specify Fax Number before using Junk Fax Setup.

Region
Purpose:
To select the region where the printer is used.
Values:

Company Name
Purpose:
To set the sender name to be printed on the header on faxes.

Line Type
Purpose:
To select the default line type.
Values:

Unknown*

Australia
China
Hong Kong
Indonesia
Malaysia
New Zealand
Philippines
Singapore
South Korea
Taiwan
Thailand

PSTN* Uses PSTN.
PBX Uses PBX.



308 Using the Operator Panel Menus and Keypad

Line Monitor
Purpose:
To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a 
connection is made.
Values:

DRPD Pattern
Purpose:
To provide a separate number for faxing with a distinctive ring pattern.
Values:

Off Turns off the volume of the line monitor.
Min Sets the volume of the line monitor to minimum.
Middle* Sets the volume of the line monitor to middle.
Max Sets the volume of the line monitor to maximum.

Pattern1–7 DRPD is a service provided by some telephone companies. DRPD patterns are 
specified by your telephone company. The patterns provided with your printer are 
shown below:

Ask your telephone company which pattern you need to select to use this service. 
For example, Pattern7 is the New Zealand FaxAbility distinctive ringing pattern: rings 
for 400 ms, stops for 800 ms, rings for 400 ms and stops for 1400 ms. This pattern is 
repeated over and over again. This printer only responds to Distinctive Alert 
cadence(s) DA4 in New Zealand.

Pattern1

Pattern2

Pattern3

Pattern4*

Pattern5

Pattern6

Pattern7
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Extel Hook Threshold
Purpose:
To select the external telephone hook detection threshold for the condition in which a telephone line is not being 
used.
Values:

• Incoming Defaults
Purpose:
To configure settings for incoming fax.

Receive Mode
Purpose:
To select the default fax receiving mode.
Values:

Ring Tone Volume
Purpose:
To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal
speaker when Receive Mode is set to TEL/FAX Mode.
Values:

Lower Sets the external telephone hook detection threshold to Lower.
Normal* Sets the external telephone hook detection threshold to Normal.
Higher Sets the external telephone hook detection threshold to Higher.

TEL Mode Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external phone and then pressing the remote receive code, or by 
selecting Manual Receive in OnHook to On (you can hear voice or fax tones 
from the remote machine) and then pressing  (Start) button. For details about 
Manual Receive, see "Receiving a Fax Manually in the TEL Mode" on 
page 272.

FAX Mode* Automatically receives faxes.
TEL/FAX Mode When the printer receives an incoming fax, the external telephone rings for the 

time specified in Auto Receive TEL/FAX, and then the printer automatically 
receives a fax. If an incoming call is not a fax, the printer beeps from the internal 
speaker indicating that the call is a telephone call.

Ans/FAX Mode The printer can share a telephone line with an answering machine. In this mode, 
the printer will monitor the fax signal and pick up the line if there are fax tones. If 
the phone communication in your region is serial, this mode is not supported.

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive 
ring service must be installed on your telephone line by the telephone company. 
After the telephone company has provided a separate number for faxing with a 
distinctive ring pattern, configure the fax setup to monitor for that specific ring 
pattern.

Off Turns off the volume of the ring tone.
Min Sets the volume of the ring tone to minimum.
Middle Sets the volume of the ring tone to middle.
Max* Sets the volume of the ring tone to maximum.
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Auto Answer Setup
Purpose:
To configure settings for automatic fax reception.
Values:

Junk Fax Filter
Purpose:
To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Fax Address Book.
Values:

Secure Receive
NOTE: 
• Secure Receive feature is available only when Panel Lock Set is set to Enable.

Purpose:
To specify whether to require a passcode to receive faxes, and to set or change the passcode.
Values:

*1 This item is available only when Secure Receive Set is set to Enable.

Forward Settings
NOTE: 
• The Print and E-mail feature is available only when E-mail information and Forwarding E-mail Address are registered. 

For information on E-mail, see "E-Mail Settings" on page 248 and information on Forwarding E-mail Address, see the Help on 
CentreWare Internet Services.

• The Forward to Server and Print and Forward to Server feature are available only when information about 
shared folders and servers are registered in Forward to Server Settings. For details about shared folders on servers, see 
"Using a Scanner on the Network" on page 224. For details about Forward to Server Settings, see the Help on the 
CentreWare Internet Services.

Auto Answer Fax 0* Sets the interval at which the printer goes into the fax receive 
mode after receiving an incoming call. The value is set in 
increments of 1 second.0-255

Auto Answer TEL/FAX 6* Sets the interval at which the printer goes into the fax receive 
mode after the external telephone receives an incoming call. 
The value is set in increments of 1 second.0-255

Auto Answer Ans/FAX 21* Sets the interval at which the printer goes into the fax receive 
mode after the external answering machine receives an 
incoming call. The value is set in increments of 1 second.0-255

Off* Does not reject faxes sent from unwanted numbers.
On Rejects faxes sent from unwanted numbers.

Secure Receive Set Disable* Does not require a passcode to receive faxes.
Enable Requires a passcode to receive faxes.

Change Passcode*1 0000–9999 Sets or changes the passcode required to receive faxes.
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Purpose:
To set whether to forward incoming faxes to a specified destination.
Values:

2 Sided Print
To set the duplex printing for fax.
Values:

Remote Receive
Purpose:
To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the 
telephone.
Values:

Discard Size
Purpose:
To set the printer to discard images or any text at the bottom of a fax page when the entire page does not fit the
output paper.
Values:

• Transmission Defaults
Purpose:
To configure settings for transmitting fax.

Off* Does not forward incoming faxes.
Forward Forwards incoming faxes to a specified destination. Prints 

incoming faxes if an error occurs during the transfer.
Print and Forward Prints incoming faxes and also forwards them to a specified 

destination.
Forwarding 
Number

Specifies the fax number of the destination to which incoming 
faxes will be forwarded.

Print and E-mail Prints incoming faxes and also forward them to a specified 
e-mail address.

Forward to Server Forwards incoming faxes to a specified server.
Print and Forward to 
Server

Prints incoming faxes and also forwards them to a specified 
server.

Off* Does not perform duplex printing.
On Performs duplex printing.

Off* Does not receive a fax by pressing a remote receive code on the 
external telephone.

On Receives a fax by pressing a remote receive code on the external 
telephone.

Remote Receive Tone Specifies the tone in two digits to start Remote Receive.

Off* Prints excess images or text at the bottom of a fax page without discarding it.
On Discards any excess images or text.
Auto Reduction Automatically reduces a fax page to fit it onto the appropriate paper size.
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Auto Redial Setup
Purpose:
To configure settings for automatic redial.
Values:

Dial Type
Purpose:
To select the dialing type.
Values:

Prefix Dial
Purpose:
To select whether to set a prefix dial number.
Values:

Fax Cover Page
Purpose:
To set whether to attach a cover page to faxes.
Values:

Send Header
Purpose:
To print the information of the sender on the header of the faxes.
Values:

Number of Redial 3* Sets the number of redial attempts to make when the destination 
fax number is busy. If you enter 0, the printer will not redial. The 
value is set in increments of 1.

0-9

Redial Interval 1* Sets the interval between redial attempts. The value is set in 
increments of 1 minute.1-15

Interval Timer 8* Sets the interval between re-send attempts. The value is set in 
increments of 1 second.3-255

PB* Uses tone dialing.
DP(10PPS) Sets DP (10PPS) (Dial Pulse, 10 Pulse Per Second) as the dial type.
DP(20PPS) Sets DP (20PPS) (Dial Pulse, 20 Pulse Per Second) as the dial type.

Off* Does not set a prefix dial number.
On Sets a prefix dial number.

Prefix Dial Number Sets a prefix dial number of up to five digits. This number dials before 
any auto dial number is started. It is useful for accessing the Private 
Automatic Branch Exchange (PABX).

Off* Does not attach a cover page to faxes.
On Attaches a cover page to faxes.

Off Does not print the sender's information on the header of faxes.
On* Prints the sender's information on the header of faxes.
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ECM
Purpose:
To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote machines must 
also support the ECM.
Values:

Modem Speed
Purpose:
To adjust the fax modem speed when a fax transmission or reception error occurs.
Values:

Display Manual Fax Recipients 
Purpose:
To set whether to display the fax number of the recipient on the sending fax screen when manually sending a fax.
Values:

• Fax Reports
Purpose:
To configure settings for fax reports.

Fax Activity
Purpose:
To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.
Values:

Fax Transmit
Purpose:
To set whether to print a transmission result after a fax transmission.
Values:

Off Disables the ECM.
On* Enables the ECM.

2.4 Kbps
4.8 Kbps
9.6 Kbps
14.4 Kbps
33.6 Kbps*

Off Does not display the fax number when manually sending a fax.
On* Displays the fax number when manually sending a fax.

Auto Print* Automatically prints a fax activity report after every 50 incoming and outgoing fax 
communications.

No Auto Print Does not automatically print a fax activity report after every 50 incoming and 
outgoing fax communications.

Print Always Prints a transmission report after every fax transmission.
Print On Error* Prints a transmission report only when an error occurs.
Print Disable Does not print a transmission report after a fax transmission.
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Fax Broadcast
Purpose:
To set whether to print a transmission result after a fax transmission to multiple destinations.
Values:

Fax Protocol
Purpose:
To set whether to print the protocol monitor report, which helps you identify the cause of a communication problem.
Values:

System Settings
Use System Settings to configure a variety of printer features.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

•  General
Purpose:
To configure general settings for the printer.

Energy Saver
Purpose:
To specify the time for transition to Energy Saver mode.
Values:

When you specify 1 minutes for Low Power Timer, the printer enters energy saver mode 1 minutes after it 
finishes a job. This uses much less energy, but requires more warm-up time for the printer. Specify 1 minutes if your 
printer shares an electrical circuit with room lighting and you notice lights flickering.
Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate 
with minimum warm-up time. Select a value between 1 and 60 minutes for Low Power Timer if you want a 
balance between energy consumption and a shorter warm-up period.
The printer automatically returns to the standby mode from the Energy Saver mode when it receives data from the 
computer or remote fax machine. You can also change the status of the printer to the standby mode by pressing  
(Wake UP) button on the operator panel.

Print Always* Prints a broadcast report after every fax broadcast.
Print On Error Prints a broadcast report only when an error occurs.
Print Disable Does not print a broadcast report after a fax broadcast to multiple destinations.

Print Always Prints a protocol monitor report after every fax transmission.
Print On Error Prints the protocol monitor report only when an error occurs.
Print Disable* Does not print the protocol monitor report.

Low Power Timer 1min* Specifies the time taken by the printer to enter Low Power mode 
after it finishes a job.1–60 min

Sleep Timer 4min* Specifies the time taken by the printer to enter Sleep mode after 
it has entered Low Power mode.1–6 min
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Date & Time
Purpose:
To specify the date and time formats.
Values:

Measurements
Purpose:
To specify the default measurement unit displayed after the numeric value on the operator panel.
Values:

NOTE: 
• The default for Measurements varies depending on other settings, such as Region and Document Size.

Display Brightness
Purpose:
To adjust the screen brightness of the LCD panel.
Values:

Audio
Purpose:
To configure settings for tones emitted by the printer during operation or when a warning message appears.
Values:

Time Zone Sets the time zone.
Date Sets the date depending on the Format settings.

Format YYYY / MM / DD Sets the date format.
DD / MM / YYYY*

MM / DD / YYYY
Time Sets the time.

Format 12 Hour Sets the time in 12-hour format.
24 Hour Sets the time in 24-hour format.

Millimeters(mm)* Selects millimeter as the default measurement unit.
Inches(") Selects inch as the default measurement unit.

5* Sets the brightness in 10 levels, with 10 being the brightest.
1-10

Panel Select Tone Off*  Does not emit a tone when the operator panel input is correct.
Soft Emits a tone when the operator panel entry is correct.
Normal
Loud

Panel Alert Tone Off* Does not emit a tone when the operator panel entry is incorrect.
Soft Emits a tone when the operator panel entry is incorrect.
Normal
Loud
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Low Toner Alert Message
Purpose:
To specify whether to show the alert message when the toner is low.
Values:

Machine Ready 
Tone

Off Does not emit a tone when the printer is ready to process a job.
Soft Emits a tone when the printer is ready to process a job.
Normal*

Loud
Copy Job Tone Off Does not emit a tone when a copy job is complete.

Soft Emits a tone when a copy job is complete.
Normal*

Loud
Non-Copy Job 
Tone

Off Does not emit a tone when a job other than a copy job is complete.
Soft Emits a tone when a job other than a copy job is complete.
Normal*

Loud
Fault Tone Off Does not emit a tone when a job ends abnormally.

Soft Emits a tone when a job ends abnormally.
Normal*

Loud
Alert Tone Off Does not emit a tone when a problem occurs.

Soft Emits a tone when a problem occurs.
Normal*

Loud
Out of Paper Off Does not emit a tone when the printer runs out of paper.

Soft Emits a tone when the printer runs out of paper.
Normal*

Loud
Low Toner Alert Off Does not emit a tone when a toner is low.

Soft Emits a tone when a toner is low.
Normal*

Loud
Auto Clear Alert Off* Does not emit a tone 5 seconds before the printer performs auto 

clear.
Soft Emits a tone 5 seconds before the printer performs auto clear.
Normal
Loud

All Tones Off Disables all the alert tones.
Soft Sets the volume of all the alert tones at once.
Normal*

Loud

Off Does not show the alert message when the toner is low.
On* Shows the alert message when the toner is low.
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OffHook Wake Up
Purpose:
To specify whether to wake up from the Low Power or Sleep mode when you pick up the handset of the external 
telephone.
Values:

Auto Job History
Purpose:
To automatically print a job history report after every 20 jobs.
Values:

The job history report can also be printed using the Report / List menu.

RAM Disk
NOTE: 
• RAM Disk feature is not available when the hard disk unit is installed.

Purpose:
To allocate memory to the RAM disk file system for the Secure Print and the Sample Print features. The change 
becomes effective after the printer is turned off and then on again.
Values:

*1 When the 512MB Memory is installed.

NOTE: 
• Restart your printer when you change the settings for the RAM Disk menu.

Fax Server Address Book
Purpose:
To specify whether to search the phone numbers from the Address Book for the LDAP server.
Values:

NOTE: 
• You can search the phone numbers only from the local Address Book when Fax Server Address Book is set to Off.

Off* Does not wake up from the Low Power or Sleep mode when you pick up the 
handset of the external telephone.

On Wakes up from the Low Power or Sleep mode when you pick up the handset of 
the external telephone.

Off* Does not automatically print a job history report.
On Automatically prints a job history report.

Off Does not allocate memory to the RAM disk file system. Secure Print and Sample 
Print jobs will abort and be recorded to the job log.

On* 50MB* 
(300MB*1)

Sets the allocation of memory to the RAM disk file system in increments of 50 MB.

50-100MB 
(50-600MB*1)

Off* Does not search the phone numbers from the Address Book for the LDAP server.
On Searches the phone numbers from the Address Book for the LDAP server.
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Email Server Address Book
Purpose:
To specify whether to search the e-mail addresses from the Address Book for the LDAP server.
Values:

NOTE: 
• You can search the e-mail addresses only from the Address Book that is local when Email Server Address Book is set 

to Off.

Power on Wizard
Purpose:
To perform initial setup for the printer.

• Timers
Purpose:
To configure timer settings.

Control Panel
Purpose:
To automatically reset the settings for Copy, Scan, Fax, E-mail, or Print to the default settings and return to the 
standby mode after you do not specify any settings for the specified time.
Values:

Fault Timeout
Purpose:
To specify the amount of time the printer waits before canceling a job that stops abnormally. The print job is 
cancelled if the time-out time is exceeded.
Values:

Off* Does not search the e-mail addresses from the Address Book for the LDAP 
server.

On Searches the e-mail addresses from the Address Book for the LDAP server.

45 Seconds*

1 Minute
2 Minute
3 Minute
4 Minute

Off Disables the fault time-out.
On* 60 sec* Sets the amount of time the printer waits before canceling a job that 

stops abnormally.3-300 sec
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Job Timeout
Purpose:
To specify the amount of time the printer waits for data to arrive from the computer. The print job is cancelled if the 
time-out time is exceeded.
Values:

• Output Settings
Purpose:
To configure settings concerning output from the printer.

Default Paper Size
Purpose:
To specify the default paper size.
Values:

*1The default for Default Paper Size varies depending on region-specific factory default.

Print ID
Purpose:
To specify a location where the user ID is printed.
Values:

NOTE: 
• When you print on DL size paper, a part of the user ID may not be printed correctly.

Print Text
Purpose:
To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer 
receives it. Text data is printed on A4 or Letter size paper.
Values:

Off Disables the job time-out.
On* 30 sec* Sets the time the printer waits for data to arrive from the computer.

5-300 sec

A4*1

Letter*1

Off* Does not print the user ID.
Top Left Prints the user ID on the top left of the page.
Top Right Prints the user ID on the top right of the page.
Bottom Left Prints the user ID on the bottom left of the page.
Bottom Right Prints the user ID on the bottom right of the page.

Off Does not print the received data.
On* Prints the received data as text data.
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Banner Sheet
NOTE: 
• Banner Sheet feature is available only when the optional 550 sheet feeder is installed on the printer.

Purpose:
To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded.
Values:

Substitute Tray
Purpose:
Specifies whether to use paper of a different size when the paper that is loaded in the specified tray does not match
the paper size settings for the current job.
Values:

Letterhead 2 Sided
Purpose:
To specify whether to print on both sides when using letterhead.
Values:

Insert Position Off* Does not print the banner sheet.
Front Inserted before the first page of every copy.
Back Inserted after the last page of every copy.
Front & Back Inserted before the first page of every copy and after the last 

page of every copy.
Specify Tray Bypass Tray The banner sheet is loaded in the bypass tray.

Tray1* The banner sheet is loaded in the standard 550 sheet tray.
Tray2 The banner sheet is loaded in the optional 550 sheet feeder.

Off* No tray size substitute accepted.
Larger Size Substitutes paper of next largest size. When there is no larger paper size, the 

printer substitutes paper of nearest size.
Nearest Size Substitutes paper of nearest size.
Use Bypass Tray Substitutes paper from the bypass tray.

Disable* Does not print on both sides of letterhead.
Enable Prints on both sides of letterhead.
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Report 2 Sided Print
Purpose:
To specify to print reports on both sides a sheet of paper.
Values:

Auditron Mode
Purpose:
To specify whether to limit the functions that can be used per user by Auditron authentication.
Values:

No Account User Print
Purpose:
To specify whether to permit the printing of data without authentication information.
Values:

 Maintenance
Use the Maintenance menu to initialize the NV (non-volatile) memory, configure the plain paper quality adjustment 
settings, and configure the security settings.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Adjust Paper Type
Purpose:
To specify paper density settings.
Values:

1 Sided Prints reports on one side of a sheet of paper.
2 Sided* Prints reports on both side of a sheet of paper.

Off* Does not limit functions by Auditron authentication.
On Limits functions by Auditron authentication.

Off* Does not permit non-account user to print the data.
On Permits non-account user to print the data.

Plain Lightweight
Heavyweight*

Labels Lightweight
Heavyweight*
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• Adjust Transfer Belt Unit
Purpose:
To adjust the transfer bias when ghosting occur. (The ghost image may be the image of the previous page, or a part 
of the page currently printing.)
Values:

• Adjust 2nd BTR
Purpose:
To specify the transfer roller voltage adjustment for each paper type.
The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

NOTE: 
• The print quality changes depending on the setting values you select for this item.

Values:

K Offset 0* If faint black colored ghosts appear, try to decrease the value.
-5 to +5

YMC Offset 0* If faint ghosts in color (yellow, magenta, or cyan) appear, try to 
decrease the value.-5 to +5

Plain 0*

-5 to +10
Lightweight Cardstock 0*

-5 to +10
Heavyweight Cardstock 0*

-5 to +10
Light Glossy Cardstock 0*

-5 to +10
Heavy Glossy 
Cardstock

0*

-5 to +10
Labels 0*

-5 to +10
Envelope 0*

-5 to +10
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• Adjust Fusing Unit
Purpose:
To adjust the temperature setting of the fusing unit for each paper type.
The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower 
the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

NOTE: 
• The print quality changes depending on the setting values you select for this item.

Values:

• Auto Registration
Purpose:
To specify whether to automatically perform color registration adjustment.
Values:

Plain 0*

-3 to +3
Lightweight Cardstock 0*

-3 to +3
Heavyweight Cardstock 0*

-3 to +3
Light Glossy Cardstock 0*

-3 to +3
Heavy Glossy 
Cardstock

0*

-3 to +3
Labels 0*

-3 to +3
Envelope 0*

-3 to +3

Off Does not automatically perform color registration adjustment.
On* Automatically performs color registration adjustment.
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• Color Registration
Purpose:
To manually perform color registration adjustment.
manual color registration adjustments are required when the printer is initially installed and after the printer is
moved.

NOTE: 
• The Color Registration feature can be configured when Auto Registration is set to Off.

Values:

NOTE: 
• Ensure that you remove the paper from the bypass tray before performing Auto Registration.

• Initialize NVM
Purpose:
To initialize the non-volatile (NV) memory for system parameters, Address Book data for fax, or Address Book data 
for scan. After executing this function and rebooting the printer, the menu parameters or data, except the parameters 
for the network, are reset to their factory default values.
Values:

• Initialize Print Meter
Purpose:
To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero.
Value:

Auto 
Registration

Start Automatically performs color registration correction.

Print 
Registration 
Chart

Print Prints a color registration chart. The color registration chart prints a 
lattice pattern of yellow, magenta, and cyan lines. On the chart, find the 
values on the right side that are next to the line that is perfectly straight 
for each of the three colors. If the value for this line is 0, color registration 
adjustment is not required.
If the value for this line is any value other than 0, specify the adjustment 
values under lateral adjustment and process adjustment in Enter 
Registration values.

Enter 
Registration 
Values

LY -9 to +9 Sets lateral (perpendicular to paper feed 
direction) and process (paper feed direction) 
color adjustment values individually for yellow, 
magenta, and cyan. Enter a number in order of 
lateral adjustment (left), lateral adjustment 
(right), and process adjustment. Select OK to 
save all the settings.

LM
LC
RY -9 to +9
RM
RC
PY -9 to +9
PM
PC

Fax Settings Initialize Initializes the fax number entries in the Address Book.
Scan 
Settings

Initialize Initializes the e-mail and server address entries in the Address 
Book.

System 
Settings

Initialize Initializes the system parameters.

Initialize Initializes the print meter.
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• Reset Transfer Unit
Purpose:
To initialize the life counter of the transfer unit. After replacing the transfer unit, be sure to initialize its life counter.
Value:

• Clear Storage
NOTE: 
• Clear Storage feature is available only when the optional 512MB memory or the hard disk unit is installed.

Purpose:
To clear all files stored as Secure Print and Sample Print in the RAM Disk or the hard disk unit.
Values:

• Format Hard Disk
NOTE: 
• Format Hard Disk feature is available only when the hard disk unit is installed.

Purpose:
To initialize the hard disk unit.

• Non-Genuine Toner
Purpose:
To use toner cartridge of another manufacturer.

NOTE: 
• Using a non-Fuji Xerox toner cartridge may severely damage your printer. The warranty does not cover damages caused by 

using non-Fuji Xerox toner cartridges.

Values:

Initialize Initializes the transfer unit counter.

All Deletes all files stored as Secure Print and Sample Print in the RAM Disk or the hard disk 
unit.

Secure Print Deletes all files stored as Secure Print in the RAM Disk or the hard disk unit.

Sample Print Deletes all files stored as Sample Print in the RAM Disk or the hard disk unit.

Off* Does not use toner cartridge of another manufacturer.
On Uses toner cartridge of another manufacturer.
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• Adjust Altitude
Purpose:
To specify the altitude of the location where the printer is installed.
The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are
performed by specifying the altitude of the location where the printer is being used.

NOTE: 
• An incorrect altitude adjustment setting leads to problems such as poor printing quality and incorrect indication of remaining 

toner.

• Clear Job History
Purpose:
To clear the job history of all finished jobs.

• Adjust TouchScreen
Purpose:
To calibrate the LCD panel.

Secure Settings
Use the Secure Settings menu to set a passcode to limit access to the menus. This prevents items from being 
changed accidentally.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Panel Lock
Purpose:
To set a limited access to Admin Settings with a passcode, and to set or change the passcode. 

See also: 
• "Panel Lock Function" on page 348

Values:

*1This item is available only when Panel Lock Set is set to Enable.

0m* Sets the altitude of the location where the printer is installed.
1000m
2000m
3000m

Panel Lock Set Disable* Disables passcode protection for Admin Settings.

Enable Enables passcode protection for Admin Settings.

Change Passcode*1 0000–9999 Sets or changes the passcode required to access Admin Settings.
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• Service Lock
NOTE: 
• Service Lock feature is available only when Panel Lock Set is set to Enable.

Purpose:
To specify whether to enable or disable each of the printer services, or to require a passcode to use the services.
Values:

Copy Enabled* Enables the Copy service.

Password Locked Enables the Copy service, but requires a passcode to use the 
service.

Color Password 
Locked

Enables the Copy service with a color mode, but requires a 
passcode.

Disable Disables the Copy service.

E-mail Enabled* Enables the E-mail service.

Password Locked Enables the E-mail service, but requires a passcode to use the 
service.

Disable Disables the E-mail service.

Fax Enabled* Enables the Fax service.

Password Locked Enables the Fax services, but requires a passcode to send 
faxes (does not require a passcode to receive incoming 
faxes).

Disable Disables the Fax service (the printer will not send or receive 
faxes).

Send via Fax 
Driver

Enable* Enables the Send via Fax Driver service.

Disable Disables the Send via Fax Driver service.

Scan To Network Enabled* Enables the Scan To Network service.

Password Locked Enables the Scan To Network service, but requires a 
passcode to use the service.

Disable Disables the Scan To Network service.

Scan To PC Enabled* Enables the Scan To PC / WSD Scan service.

Password Locked Enables the Scan To PC / WSD Scan service, but requires a 
passcode to use the service.

Disable Disables the Scan To PC / WSD Scan service.

PC Scan Enabled* Enables the PC Scan service.

Password Locked Enables the PC Scan service, but requires a passcode to use 
the service.

Disable Disables the PC Scan service.

Scan To USB Enabled* Enables the Scan To USB service.

Password Locked Enables the Scan To USB service, but requires a passcode to 
use the service.

Disable Disables the Scan To USB service.

Print from USB Enabled* Enables the Print from USB service.

Password Locked Enables the Print from USB service, but requires a passcode.

Color Password 
Locked

Enables the Print from USB service with a color mode, but 
requires a passcode.

Disable Disables the Print from USB service.

ID Card Copy Enable* Enables the ID Card Copy service.

Disable Disables the ID Card Copy service.
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*1 This item is available only when Password Locked or Color Password Locked is enabled.

• Edit Email From Field
Purpose:
To specify whether to enable editing of the transmission source when you use Scan to E-mail.
Values:

• Confirm Recipients
NOTE: 
• If Confirm Recipients menu is set to Confirm Recipient, recipients can only be selected from the phone book or 

the address book. You cannot directly enter an address or fax number.

Purpose:
To specify whether to confirm the recipient before sending a fax or scan.
Values:

• Domain Filtering
NOTE: 
• Set the domains from SMTP Domain Filtering on the CentreWare Internet Services.

Purpose:
To specify whether to only send e-mails to specified domains.
Values:

• Software Download
Purpose:
To enable or disable download of firmware updates.
Values:

USB Services Show USB 
Pop Up 
Menu

Enable* Shows a USB Drive Detected screen when a USB storage 
device is inserted in to the printer.

Disable Does not show a USB Drive Detected screen when a USB 
storage device is inserted in to the printer.

Display USB 
Memory 
Services

Hide until USB 
inserted*

Hides menus concerning USB storage device until a USB 
storage device is inserted to the printer.

Always Display Menus concerning USB storage device are shown without a 
USB storage device inserted to the printer.

Change Passcode*1 Changes the passcode that is set under the Service Lock 
menu.

Disable Disables editing of the transmission source.

Enable* Enables editing of the transmission source.

No Confirmation* Does not display a screen to reconfirm the recipient before the job is actually sent.

Confirm Recipient Displays a screen to reconfirm the recipient before the job is actually sent.

Disable* Disables Domain Filtering.

Enable Only allows e-mails to be sent to specified domains.

Disable Disables firmware updates.

Enable* Enables firmware updates.
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• Display Network Information
Purpose:
To show or hide network information in the message field of the Main Home screen.
Values:

• Data Encryption
Purpose:
To disable or enable data encryption when using the printer.
Values:

• HDD Overwrite
NOTE: 
• HDD Overwrite feature is available only when the hard disk unit is installed.
• Overwrite of the hard disk may take several hours. When overwriting the hard disk unit, all functions of the printer are 

inoperable.

Purpose:
To erase the contents of the entire hard disk unit by overwriting the hard disk unit with meaningless data.
Values:

• Login Attempts
NOTE: 
• Login Attempts feature is available only when Panel Lock Set is set to Enable.

Purpose:
To specify the number of error entry attempts allowed when you log in as an administrator in the Admin Settings 
and Report / List menu.
Values:

Show IPv4 Address* Shows the IPv4 address of the printer on the Main Home screen.

Show Host Name Shows the host name of the printer on the Main Home screen.

Hide Network Information Does not show network information on the Main Home screen.

Encryption Off* Disables encryption of the data.

On Enables encryption of the data.

Encryption Key Sets a key that is required for encryption.

Off* Disables overwrite of the hard disk unit.

1 Time Overwrites the hard disk unit once.

3 Times Overwrites the hard disk unit three times.

Off* Does not allow an administrator to log in after one error entry attempt.

On 5* Sets the number of error entry attempts allowed when an administrator logs in.

1-10
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USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Port Status
NOTE: 
• Port Status feature is available only for the USB port on the rear of the printer.

Purpose:
To specify whether to enable the USB port. The change becomes effective after the printer is turned off and then on 
again.
Values:

• Adobe Protocol
Purpose:
To specify PostScript communication protocol. You can configure the Adobe Protocol settings for the wired 
network. The change becomes effective after the printer is turned off and then on again.
Values:

Disable Disables the USB port.
Enable* Enables the USB port.

Auto Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP* Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.
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Default Settings
Use Default Settings menu to modify the defaults for the Copy, Scan Menu, Fax, or USB Direct Print.

Copy Defaults
Purpose:
To modify the defaults for the Copy menu.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Output Color
Purpose:
To select color or black and white copying.
Values:

• Select Tray
Purpose:
To specify the input tray.
Values:

NOTE: 
• Tray2 is available only when the optional 550 sheet feeder is installed.

• Collation
Purpose:
To sort the copy job.
Values:

Full Color* Copies in color mode.

Black & White Copies in black and white mode.

Bypass Tray The paper is fed from the bypass tray.

Tray1* The paper is fed from the standard 550 sheet tray.

Tray2 The paper is fed from the optional 550 sheet feeder.

Auto* Automatically determines which output mode for the copy job.

Collated Sorts the copy job. 

Uncollated Does not sort the copy job.
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• Reduce / Enlarge
Purpose:
To set the default copy reduction/enlargement ratio.
Values:

mm series

inch series

NOTE: 
• You can also use the number pad to input the desired zoom ratio from 25% to 400%, or select  to enlarge the zoom ratio 

or select  to reduce the zoom ratio in 1% intervals.
• This item is available only when Pages Per Side is set to Off or Manual.

200%
141% A5→A4
122% A5→B5
100%*
81% B5→A5
70% A4→A5
50%

200%
154%
129% 8.5x11"→8.5x14"
100%*
78% 8.5x14"→8.5x11"
64%
50%
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• Original Size
Purpose:
To specify the default document size.
Values:

mm series

inch series

NOTE: 
• When Auto is selected, the printer assumes that the document size is the size of the print media loaded in the standard 550 

sheet tray or bypass tray.

• Original Type
Purpose:
To select the copy image quality.
Values:

Auto*
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
Executive (7.25 x 10.5")

Auto*
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)
Executive (7.25 x 10.5")

Photo & Text* Suitable for documents with both text and photos/gray tones.

Text Suitable for documents with text.

Photo Suitable for documents with photos.
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• Lighten / Darken
Purpose:
To set the default copy density level.
Values:

• Sharpness
Purpose:
To set the default sharpness level.
Values:

• Saturation
Purpose:
To set the default color saturation level.
Values:

• Auto Background Suppression
Purpose:
To suppress the background of the original to enhance text on the copy.
Values:

• Auto Background Suppression Level
Purpose:
To specify the default background suppression level.
Values:

Darken +3 Makes the copy darker than the original. Works well with light print or faint pencil markings.

Darken +2
Darken +1
Normal* Works well with standard typed or printed documents. 

Lighten +1 Makes the copy lighter than the original. Works well with dark print.

Lighten +2
Lighten +3

Sharpen Makes the copy sharper than the original. 

Normal* Does not make the copy sharper or softer than the original. 

Soften Makes the copy softer than the original.

Vivid Increases the color saturation to brighten the color of the copy.

Normal* The color saturation is the same as the original.

Pastel Decreases the color saturation to lighten the color of the copy.

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the copy.

Normal* Sets the background suppression level to Normal.

Higher Sets the background suppression level to Higher.

Highest Sets the background suppression level to Highest.
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• Color Balance
Purpose:
To specify the default color balance level within the range of -3 to +3.
Values:

• 2 Sided Copying
Purpose:
To print on both sides of a sheet of paper.
Values:

Yellow Shadows 0* Sets the color balance level of low density yellow.

-3 to +3
Midtones 0* Sets the color balance level of medium density yellow.

-3 to +3
Highlights 0* Sets the color balance level of high density yellow.

-3 to +3
Magenta Shadows 0* Sets the color balance level of low density magenta.

-3 to +3
Midtones 0* Sets the color balance level of medium density magenta.

-3 to +3
Highlights 0* Sets the color balance level of high density magenta.

-3 to +3
Cyan Shadows 0* Sets the color balance level of low density cyan.

-3 to +3
Midtones 0* Sets the color balance level of medium density cyan.

-3 to +3
Highlights 0* Sets the color balance level of high density cyan.

-3 to +3
Black Shadows 0* Sets the color balance level of low density black.

-3 to +3
Midtones 0* Sets the color balance level of medium density black.

-3 to +3
Highlights 0* Sets the color balance level of high density black.

-3 to +3

1→1 Sided* Prints on one side of a sheet of paper.

1→2 Sided Prints one sided originals on both sides of a sheet of paper.

Binding of 
Output

Long Edge Binding Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge 
Binding

Prints on both sides of a sheet of paper to be bound by short edge.

2→1 Sided Prints two sided originals on one side of a sheet of paper.

Binding of 
Original

Long Edge Binding Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge 
Binding

Prints on both sides of a sheet of paper to be bound by short edge.

2→2 Sided Prints two sided originals on both sides of a sheet of paper.

Binding of 
Original

Long Edge Binding Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge 
Binding

Prints on both sides of a sheet of paper to be bound by short edge.



336 Using the Operator Panel Menus and Keypad

• Pages Per Side
Purpose:
To print two original pages to fit onto one sheet of paper.
Values:

• Edge Erase
Purpose:
To specify the value of the top and bottom margins.
Values:

Scan Defaults
To modify the defaults for the Scan menu and Email menu defaults.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• File Format
Purpose:
To specify the file format to save the scanned image.
Values:

• Output Color
Purpose:
To specify whether to scan in color, black and white, or gray scale.
Values:

Off* Does not perform Pages Per Side printing. 

Auto Automatically reduces the original pages to fit onto one sheet of paper. 

Manual Prints the original pages onto the one sheet of paper in the size specified in 
Reduce/Enlarge.

Top / 
Bottom

0.2 inch* (4 mm*) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0 – 50 mm)
Left / Right 0.2 inch* (4 mm*) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0 – 50 mm)
Middle 0.0 inch*(0 mm*) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0 – 50 mm)

PDF*

Multi-Page TIFF
TIFF (1 File per page)
JPEG (1 File per page)
XDW

Color* Scans in color.

Black & White Scans in black and white.

Gray Scale Scans in grayscale.
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• Resolution
Purpose:
To specify the default scan resolution.
Values:

*1For color scan, 400 × 400 dpi and 600 × 600 dpi are available only when the optional 512MB memory is installed on the printer.

• Original Size
Purpose:
To specify the default document size.
Values:

mm series

*1The default for Document Size varies depending on region-specific factory default.

inch series

*1The default for Document Size varies depending on region-specific factory default.

• 2 Sided Scanning
Purpose:
To scan both sides of a sheet of paper.
Values:

*1 This item is available only when 2 Sided Scanning is set to 2 Sided in the Scan Defaults menu.

200 dpi*
300 dpi
400 dpi*1

600 dpi*1

A4 (210x297mm)*1

A5 (148x210mm)
B5 (182x257mm)
Letter (8.5x11")
Folio (8.5 x 13")
Legal (8.5x14")
Executive (7.25x10.5") 

Letter (8.5x11")*1

Folio (8.5 x 13")
Legal (8.5x14")
A4 (210x297mm)
A5 (182x257mm)
B5 (176x250mm)
Executive (7.25x10.5")

1 Sided* Scans one side of a document.

2 Sided Binding of 
Original*1

Long Edge Binding* Scans both sides of a document to be bound 
by long edge.

Short Edge Binding Scans both sides of a document to be bound 
by short edge.
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• Lighten / Darken
Purpose:
To set the default scan density level.
Values:

• Sharpness
Purpose:
To set the default sharpness level.
Values:

• Contrast
Purpose:
To adjust the amount of colors to make the contrast of colors darker or lighter than the original.
Values:

• Auto Background Suppression
Purpose:
To suppress the background of the original to enhance text on the scanned image.
Values:

• Auto Background Suppression Level
Purpose:
To specify the default background suppression level.
Values:

Darken +3 Makes the scanned image darker than the original. Works well with light print or faint pencil 
markings.Darken +2

Darken +1
Normal* Works well with standard typed or printed documents. 

Lighten +1 Makes the scanned image lighter than the original. Works well with dark print.

Lighten +2
Lighten +3

Sharpen Makes the scanned image sharper than the original.

Normal* Does not make the scanned image sharper or softer than the original.

Soften Makes the scanned image softer than the original.

More Adjusts the amount of colors to make the contrast of colors darker than the original.

Normal* Does not adjust the amount of colors to make the contrast of colors darker or lighter than 
the original.

Less Adjusts the amount of colors to make the contrast of colors lighter than the original.

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the scanned image.

Normal* Sets the background suppression level to Normal.

Higher Sets the background suppression level to Higher.

Highest Sets the background suppression level to Highest.
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• Edge Erase
Purpose:
To specify the value of the top and bottom margins.
Values:

• TIFF File Format
Purpose:
To specify the default TIFF file format.
Values:

• Quality/File Size
Purpose:
To specify the Quality/File Size.
Values:

• Max Email Size
Purpose:
To specify the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes. The default 
is 2048 K bytes.

• File Name
Purpose:
To specify the detailed setting for file name.
Values:

Top / Bottom 0.1 inch* (2 mm*) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0 – 50 mm)
Left / Right 0.1 inch* (2 mm*) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0 – 50 mm)
Middle 0.0 inch*(0 mm*) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0 – 50 mm)

TIFF V6* Sets the default TIFF file format to TIFF V6.

TTN2 Sets the default Tiff file format to TTN2.

Small Sets the Quality/File Size level to Small.

Normal* Sets the Quality/File Size level to Normal.

Large Sets the Quality/File Size level to Large.

Auto* Sets the default file name.

Add Prefix Adds texts in front of the file name.

Text String Specifies the texts that are added when Add Prefix is selected.

Add Suffix Adds texts after the file name.

Text String Specifies the texts that are added when Add Suffix is selected.
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• Create Folder
Purpose:
To specify whether to create a folder when saving scanned images.
Values:

Fax Defaults
Purpose:
To modify the defaults for the Fax menu.

NOTE: 
• The FAX service cannot be used unless you set up a region code under Region. If Region is not set up, a message Set 

the Country Code appears on the display.
• Values marked by an asterisk (*) are the factory default menu settings.

• Resolution
Purpose:
To specify the scan resolution to improve the output quality.
Values:

NOTE: 
• Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

• 2 Sided Scanning
Purpose:
To scan both sides of a sheet of paper.
Values:

*1 This item is available only when 2 Sided Scanning is set to 2 Sided Printing in the Scan Defaults menu.

Off Does not create a folder when saving a scanned image.

On* Creates a folder when saving a scanned image.

Standard* Suitable for documents with normal sized characters. 

Fine Suitable for documents containing small characters or thin lines or documents printed 
using a dot-matrix printer. 

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode is enabled 
only if the remote machine also supports the Super Fine mode. See the notes below.

Photo Suitable for documents containing photographic images.

1 Sided* Scans one side of a document.

2 Sided Binding of 
Original*1

Long Edge 
Binding*

Scans both sides of a document to be bound by long edge.

Short Edge 
Binding

Scans both sides of a document to be bound by short edge.
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• Lighten / Darken
Purpose:
To adjust the density to make the copy lighter or darker than the original.
Values:

• Delayed Send
Purpose:
This feature enables you to set a specific time for the fax transmission to start. Once Delayed Send mode is 
activated, your printer stores all of the documents to be faxed into its memory and sends them at the specified time. 
After faxing in the Delayed Send mode is complete, the data in the memory is cleared.
Values:

NOTE: 
• A maximum of 19 delayed fax jobs can be stored in this printer.

Print from USB Defaults
To modify the defaults for the Print from USB menu.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

• Output Color
Purpose:
To specify whether to print in black and white or in color.
Values:

Darken +3 Works well with light print or faint pencil markings.

Darken +2
Darken +1
Normal* Works well with standard typed or printed documents. 

Lighten +1 Works well with dark print.

Lighten +2
Lighten +3

21:00*/9:00PM* Specify the fax transmission start time when sending a fax at a specified time.

0:00 – 23:59 / 
1:00 – 12:59AM/PM

Full Color* Prints in color.

Black & White Prints in black and white.
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• Select Tray
Purpose:
To specify the input tray.
Values:

NOTE: 
• Tray2 is available only when the optional 550 sheet feeder is installed.

• 2 Sided Printing
Purpose:
To print on both sides of a sheet of paper.
Values:

• Sides Per Page
Purpose:
To print two or four original pages to fit onto one sheet of paper.
Values:

• PDF Password
Purpose:
To enter the password when you print the secure PDF job.
Values:

Tray Management
Use the Tray Management menu to define the print media loaded in the standard 550 sheet tray and the optional 
550 sheet feeder.

NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Tray Settings
To configure tray settings.

Bypass Tray The paper is fed from the bypass tray.

Tray1* The paper is fed from the standard 550 sheet tray.

Tray2 The paper is fed from the optional 550 sheet feeder.

1 Sided* Prints on one side of a sheet of paper.

2 Sided Binding of Output Long Edge Binding* Prints on both sides of a sheet of paper to be bound by 
long edge.

Short Edge Binding Prints on both sides of a sheet of paper to be bound by 
short edge.

Off* Prints one page on one side of a sheet of paper.

2 Sides per Page Prints two pages on one side of a sheet of paper.

4 Sides per Page Prints four pages on one side of a sheet of paper.

Enter PDF Password Enter the password to print the secure PDF job.
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• Bypass Tray
Purpose:
To specify the paper loaded in the bypass tray.
Values:

Display Tray 
Prompt

Enter a check to display a popup message that prompts to set Type and Size when paper is loaded 
in the bypass tray. The factory default is on (check).

Use Driver 
Settings for Print 
Job

Enter a check to use the Size and Type set on the print driver. The factory default is off (blank).

Size A4 (210 x 297 mm)*1

mm series A5 (148 x 210 mm)
B5 (182 x 257 mm)
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
Executive (7.25 x 
10.5")
Monarch Env. (3.9 x 
7.5")
DL Env. (110 x 220 
mm)
C5 Env. (162  x 229 
mm)
#10 Env. (4.1 x 9.5")
New Custom Size Width(x) 210 mm* Specifies the width of the custom 

size paper.77-215 mm

Length(y) 297 mm* Specifies the length of the custom 
size paper.127-355 mm

inch series Letter (8.5 x 11")*1

Folio (8.5 x 13")
Legal (8.5 x 14")
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)
Executive (7.25 x 
10.5")
Monarch Env. (3.9 x 
7.5")
DL Env. (110 x 220 
mm)
C5 Env. (162  x 229 
mm)
#10 Env. (4.1 x 9.5")
New Custom Size Width(x) 8.3 inches* Specifies the width of the custom 

size paper.3.0-8.5 inches

Length(y) 11.7 inches* Specifies the length of the custom 
size paper.5.0-14.0 inches
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*1 The default for Size varies depending on region-specific factory default.

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 145.

Type Plain*

Other Type
Lightweight 
Cardstock
Heavyweight 
Cardstock
Light Glossy 
Cardstock
Heavy Glossy 
Cardstock
Labels
Envelope
Letterhead
Hole Punched
Colored
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• Tray1
Purpose:
To specify the paper loaded in the standard 550 sheet tray.
Values:

*1 The default for Size varies depending on region-specific factory default.

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 145.

Display Tray 
Prompt

Enter a check to display a popup message that prompts to set Type and Size when paper is loaded in 
the standard 550 sheet tray. The factory default is on (check).

Size A4 (210 x 297 
mm)*1

mm series A5 (148 x 210 mm)
B5 (182 x 257 mm)
Letter (8.5 x 11")
Folio (8.5 x 13")
Legal (8.5 x 14")
Executive (7.25 x 
10.5")
New Custom Size Width(x) 210 mm* Specifies the width of the custom size 

paper.148-215 mm

Length(y) 297 mm* Specifies the length of the custom size 
paper.210-355 mm

inch series Letter (8.5 x 11")*1

Folio (8.5 x 13")
Legal (8.5 x 14")
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)
Executive (7.25 x 
10.5")
New Custom Size Width(x) 8.3 inches* Specifies the width of the custom size 

paper.5.8-8.5 inches

Length(y) 11.7 inches* Specifies the length of the custom size 
paper.8.3-14.0 inches

Type Plain*

Other Type
Lightweight 
Cardstock
Heavyweight 
Cardstock
Light Glossy 
Cardstock
Heavy Glossy 
Cardstock
Letterhead
Hole Punched
Colored
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• Tray2
NOTE: 
• Tray2 is available only when the optional 550 sheet feeder is installed.

Purpose:
To specify the paper loaded in the optional 550 sheet feeder.
Values:

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 145.

Display Tray 
Prompt

Enter a check to display a popup message that prompts to set Type and Size when paper is loaded in 
the optional 550 sheet feeder. The factory default is on (check).

Size Auto Detect*

New Custom Size Width(x) 210 mm*

(8.3 inches*)

Specifies the width of the custom size 
paper.

148-215 mm

(5.8-8.5 inches)

Length(y) 297 mm*

(11.7 inches*)

Specifies the length of the custom size 
paper.

210-355 mm

(8.3-14.0 inches)

Type Plain*
Other Type
Lightweight 
Cardstock
Heavyweight 
Cardstock
Light Glossy 
Cardstock
Heavy Glossy 
Cardstock
Letterhead
Hole Punched
Colored
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   Tray Priority
Purpose:
To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with the same paper size
and type exists, the paper tray is selected according to this priority order.
Values:

NOTE: 

• Tray2 and 3 Third are available only when the optional 550 sheet feeder is installed.
• The paper tray name is not displayed in the priority menu after once selected.

Panel Language
NOTE: 
• Values marked by an asterisk (*) are the factory default menu settings.

Purpose:
To determine the language of the text on the LCD panel.
Values:

1 First Bypass Tray* Sets the bypass tray as the first priority.

Tray1 Sets the standard 550 sheet tray as the first priority.

Tray2 Sets the optional 550 sheet feeder as the first priority.

2 Second Bypass Tray Sets the bypass tray as the second priority.

Tray1* Sets the standard 550 sheet tray as the second priority.

Tray2 Sets the optional 550 sheet feeder as the second priority.

3 Third Bypass Tray Sets the bypass tray as the third priority.

Tray1 Sets the standard 550 sheet tray as the third priority.

Tray2* Sets the optional 550 sheet feeder as the third priority.

English*

Simplified Chinese
Traditional Chinese
Korean
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Panel Lock Function
This feature prevents unauthorized personnel from changing the settings made by the administrator. However, you 
can select settings for individual print jobs using the print driver.
This section includes:

• "Enabling the Panel Lock" on page 348
• "Disabling the Panel Lock" on page 348

NOTE: 
• Disabling the operator panel menus does not prevent access to the Secure Print, Sample Print and Tray Settings 

menus.

Enabling the Panel Lock
1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Secure Settings.

5 Select Panel Lock.

6 Select Panel Lock Set.

7 Select Enable, and then select OK.

8 Enter the new passcode, and then select OK.

9 Re-enter the passcode to confirm the passcode that you entered, and then select OK.

NOTE: 
• The factory-default panel passcode is 0000.
• Be sure to remember the passcode. The procedure described below allows you to reset the passcode, but the settings for 

Address Book are cleared.

• Turn off the printer. Then, while holding the  (System) button, turn on the printer.
• If you change the passcode while Panel Lock Set is Enable, perform steps 1 to 3. Enter the current passcode, and then 

select OK. Perform steps 4 and 5. Select Change Passcode, and then select OK. Enter the current passcode, and then 
select OK. Perform steps 8 and 9. This will change the passcode.

Disabling the Panel Lock
1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Enter the passcode, and then select OK.

5 Select Secure Settings.

6 Select Panel Lock.

7 Select Panel Lock Set.

8 Select Disable, and then select OK.

9 Enter the current passcode, and then select OK.
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Limiting Access to Copy, Fax, Scan, and Print from 
USB Operations
Enabling the Copy Lock, Fax Lock, Scan Lock, and Print from USB Lock options limits access to copy, fax, scan, and 
print from USB operations by requiring a passcode to be entered before copying, scanning, faxing, or printing.
Taking Fax Lock as an example, the following procedure explains how to enable or disable the option. Use the same 
procedure to enable or disable Copy Lock, Scan Lock, or Print from USB Lock.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Secure Settings.

5 Select Panel Lock.

6 Select Panel Lock Set.

7 Select Enable, and then select OK.

8 Enter the new passcode using the number pad and then select OK.

9 Re-enter the passcode and then select OK.

NOTE: 
• The default passcode is 0000.

10 Select the  button once.

11 Select Service Lock.

12 Select FAX.
• Enabled

• Password Locked

• Disable

• Color Password Locked (available only for Copy Lock and Print from USB Lock)
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Changing the Language
To change language used on the operator panel:

1 Press the  (System) button.

2 Select the Tools tab, and then select Panel Language.

3 Select the desired language.

4 Select OK.
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Setting the Energy Saver Option
You can set the Energy Saver for the printer. The printer switches to the Energy Saver mode after the specified time.

NOTE: 
• If the Panel Lock Set is set to Enable, you need to enter the four digit passcode to enter the Admin Settings menu.

To set the Energy Saver:

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select System Settings.

5 Select General.
Select Energy Saver.

6 Select Low Power Timer or Sleep Timer.

7 Select the  or  or enter the desired value using the number pad, and then select OK.
You can select from 1–60 minutes for Low Power Timer or 1–6 minutes for Sleep Timer.

8 To return to the previous screen, select .
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About the Concurrent Jobs Feature
This feature enables you to start a concurrent job while a fax job is running. This is done by temporally displaying the 
Main Home screen and switching to a different function that can be run concurrently such as copy or scan.

1 While the printer is sending or receiving a fax, press (Service) button.

2 Select Copy or Scan menu.

3 After setting the copy or scan options, press the (Start) button.
For details about Copy or Scan menu, see "Copying" on page 195 or "Scanning" on page 213.
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Resetting to Factory Defaults
After executing this function and rebooting the printer, the address book or all the menu parameters, except the 
parameters for the network, are reset to their default values.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Initialize NVM.

6 Select the desired setting.

7 Select Initialize.
The printer restarts automatically to apply the settings.



354 Using the Operator Panel Menus and Keypad

Entering Characters
This section describes how to use the keyboard displayed on the operator panel and the number pad.

Using the Keyboard Displayed on the Operator Panel
During operations, a screen for entering text sometimes appears. The following describes how to enter text.

You can enter the following characters: numerals, alphabets, and symbols.

Using the Number Pad
As you perform various tasks, you may need to enter numbers. For example, when you specify the quantity of 
copies or when you enter fax number directly.

Available Characters
You can enter the characters as follows by using the number pad: 0 to 9, * and #.

Changing Numbers
If you make a mistake while entering a number, press the CA (Clear All) button to delete the last digit or character. 
Then enter the correct number.

QWERTY AZERTY QWERTZ

Item Description

Changing keyboards Select  to change the keyboard layout on the operator panel, and then select from 
QWERTY, AZERTY, or QWERTZ.

Entering alphabets and 
numerals

To enter uppercase letters, select . To return to the lowercase letters, select  again.

Entering symbols Select .

Entering a space Select  or .

Deleting characters Select  to delete one character at a time.
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10
Troubleshooting

This chapter includes:
• "Clearing Jams" on page 356
• "Basic Printer Problems" on page 375
• "Display Problems" on page 376
• "Printing Problems" on page 377
• "Print Quality Problems" on page 379
• "Noise" on page 395
• "Copy Problem" on page 396
• "Copy Quality Problems" on page 397
• "Adjusting Color Registration" on page 398
• "Fax Problems" on page 402
• "Scanning Problems" on page 404
• "Digital Certificate Problem" on page 406
• "Problems With Installed Optional Accessories" on page 407
• "Scan Driver/Printer Utility Problems" on page 408
• "Other Problems" on page 409
• "Understanding Printer Messages" on page 410
• "Contacting Service" on page 415
• "Getting Help" on page 416
• "Non-Genuine Mode" on page 417
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Clearing Jams
This section includes:

• "Avoiding Jams" on page 356
• "Identifying the Location of Paper Jams" on page 357
• "Clearing Paper Jams From the DADF" on page 358
• "Clearing Paper Jams From the Bypass Tray" on page 360
• "Clearing Paper Jams From the Standard 550 Sheet Tray" on page 362
• "Clearing Paper Jams From the Fusing Unit" on page 365
• "Clearing Paper Jams From the Optional 550 Sheet Feeder" on page 369
• "Jam Problems" on page 371

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 142
• "Supported Print Media" on page 145

NOTE: 
• Before buying large quantities of any print media, it is recommended that you try a sample first.

Avoiding Jams
• Use only recommended print media.
• See "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 150 

and "Loading Print Media in the Bypass Tray" on page 153 to load print media properly.
• Do not overload the print media sources. Ensure that the print media stack height does not exceed the 

maximum height indicated by the load-line in the tray.
• Do not load wrinkled, creased, damp, or curled print media.
• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at 

a time through the bypass tray.
• Do not use print media that you have cut or trimmed.
• Do not mix print media sizes, weights, or types in the same print media source.
• Ensure that the recommended print side is face up when you load the print media.
• Keep print media stored in an acceptable environment.
• Do not remove the feeding tray during a print job.
• Push the tray in firmly after loading.
• Ensure that all cables that connect to the printer are correctly attached.
• Overtightening the guides may cause jams.
• Wipe the feed roller in the tray or bypass tray with a cloth moistened with water if jams caused by misfeeding 

paper occur frequently.

See also: 
• "About Print Media" on page 142 
• "Supported Print Media" on page 145
• "Print Media Storage Guidelines" on page 143
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Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:
• Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped around the fusing 

unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the product immediately and contact 
your local Fuji Xerox representative.

1 Duplex Automatic Document Feeder (DADF)

2 Fusing Unit

3 Standard 550 Sheet Tray

4 Bypass Tray

5 Optional 550 Sheet Feeder

1

2

4 3

5
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Clearing Paper Jams From the DADF
When a document jams while it passes through the DADF, remove the jam in the following procedure.

NOTE: 
• To prevent document jams, use the document glass for thick, thin, or mixed documents.

1 Remove the remaining documents from the DADF.
If the document is jammed in the paper feed area:

a Open the DADF cover.

[

b Lift the release lever 90 degrees and remove the jammed document by carefully pulling the document in 
the direction of the arrow shown in the following illustration.

If you find it difficult to pull the document:

c Remove the DADF feed roller assembly and remove the document by gently pulling the document in the 
direction of the arrow shown in the following illustration.
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d Insert the DADF feed roller assembly and press down the release lever.

If the document is jammed in the paper exit area:

a Remove the jammed document from the document output tray. 

b Close the DADF cover, and then load the documents back into the DADF.

NOTE: 
• Ensure that you adjust the document guides before printing a Legal-size document.

2 If you cannot remove the jammed document from the document output tray or cannot find any jammed 
document there, open the document cover.

3 Remove the document from the white sheet by carefully pulling it to the right.

4 Close the document cover, and then load the documents back into the DADF.

5 Press the  (Start) button.
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Clearing Paper Jams From the Bypass Tray
IMPORTANT: 
• Protect the drums of the drum cartridges against bright light. If the side cover remains open for more than 3 minutes, print 

quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.
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4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

5 Remove the jammed paper.

6 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

7 Insert the bypass tray into the printer, push until it stops, and close the cover.



362 Troubleshooting

Clearing Paper Jams From the Standard 550 Sheet Tray
IMPORTANT: 
• Protect the drums of the drum cartridges against bright light. If the side cover remains open for more than 3 minutes, print 

quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.



Troubleshooting 363

4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

5 Remove the jammed paper.

6 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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7 Insert the bypass tray into the printer, push until it stops, and close the cover.

8 Press the  (Start) button.
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Clearing Paper Jams From the Fusing Unit
IMPORTANT: 
• Ensure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on 

the film of the belt unit may reduce print quality.
• Protect the drums of the drum cartridges against bright light. If the side cover remains open for more than 3 minutes, print 

quality may deteriorate.

NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover, or remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.
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4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

5 Push down the latch to open the rear cover.

6 Lift the levers on both sides of the fusing unit.

IMPORTANT: 
• The fusing unit is hot. Do not touch it, doing so may cause burns.
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7 Hold and lower the tab to open the inner part.

8 Remove the jammed paper.

9 Replace the inner part.

10 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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11 Insert the bypass tray into the printer, push until it stops, and close the cover.

12 Press down the levers on both sides of the fusing unit, and then close the rear cover.
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Clearing Paper Jams From the Optional 550 Sheet Feeder
NOTE: 
• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the optional 550 sheet feeder from the printer about 200 mm.

2 Hold the optional 550 sheet feeder with both hands, and remove it from the printer.

3 Remove the jammed paper.
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4 Insert the optional 550 sheet feeder into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the feeder. Doing so could damage the feeder or the inside of the printer.
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Jam Problems
This section includes:

• "Standard 550 Sheet Tray/Optional 550 Sheet Feeder Misfeed Jam" on page 371
• "Bypass Tray Misfeed Jam" on page 372
• "Regi Jam (Exit Sensor On JAM)" on page 373
• "Exit Jam (Exit Sensor Off JAM)" on page 373
• "Standard 550 Sheet Tray/Optional 550 Sheet Feeder Multi-feed Jam" on page 374
• "Bypass Tray Multi-feed Jam" on page 374

Standard 550 Sheet Tray/Optional 550 Sheet Feeder Misfeed Jam

Problem Action
Print media misfeeds occur in the 
standard 550 sheet tray or the 
optional 550 sheet feeder.

Ensure that the standard 550 sheet tray or the optional 550 sheet feeder is properly 
inserted.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 145

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not curled.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the standard 550 sheet tray or the 
optional 550 sheet feeder with a cloth moistened with water.

Wipe the feed roller in the standard 550 sheet tray or the optional 550 sheet feeder 
with a cloth moistened with water.

If the problem persists, replace the drum cartridges if you have spare cartridges. 

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Bypass Tray Misfeed Jam

Problem Action
Print media misfeeds occur in the 
bypass tray.

Ensure that the bypass tray is properly inserted.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 145

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not damp.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the bypass tray with a cloth moistened 
with water.

Wipe the feed roller in the bypass tray with a cloth moistened with water.

If the problem persists, replace the drum cartridges if you have spare cartridges. 

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Regi Jam (Exit Sensor On JAM)

Exit Jam (Exit Sensor Off JAM)

Problem Action
Regi jam (Exit Sensor On JAM) 
occurs.

Ensure that the drum cartridges are installed correctly.

If the problem persists, replace the drum cartridges if you have spare cartridges as 
instructed in "Replacing the Drum Cartridges" on page 436.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436

If the problem persists, ensure that the fusing unit is installed correctly.

Ensure that the fusing unit is installed correctly.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit" on page 442.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit" on page 442

If the problem persists, ensure that the belt unit is installed correctly.

Ensure that the belt unit is installed correctly.

If the problem persists, replace the belt unit, the 2nd BTR, and the retard roller as 
instructed in "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on 
page 445.

Replace the belt unit, the 2nd BTR, and the retard roller.

See also: 
• "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on page 445

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
Exit jam (Exit Sensor Off JAM) 
occurs.

Ensure that the fusing unit is installed correctly.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit" on page 442.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit" on page 442

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Standard 550 Sheet Tray/Optional 550 Sheet Feeder Multi-feed Jam

Bypass Tray Multi-feed Jam

Problem Action
Print media multiple feeds occur 
in the standard 550 sheet tray or 
optional 550 sheet feeder.

Ensure that the tray or feeder is properly inserted.

If using coated paper, load coated paper one sheet at a time.

If using other type of print media, use print media that is not damp.

Load coated paper one sheet at a time.

If the problem persists, fan the print media.

Use print media that is not damp.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray or feeder where the multifeed 
occurred with a cloth moistened with water.

Wipe the feed roller in the tray or feeder where the multifeed occurred with a cloth 
moistened with water.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
Print media multiple feeds occur 
in the bypass tray.

Ensure that the media type you are using.

If using coated paper, load coated paper one sheet at a time.

If using other type of print media, use print media that is not damp.

Load coated paper one sheet at a time.

If the problem persists, fan the print media.

Use print media that is not damp.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray where the multifeed occurred 
with a cloth moistened with water.

Wipe the feed roller in the tray where the multifeed occurred with a cloth moistened 
with water.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Basic Printer Problems
Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.
• The printer is turned on.
• The electrical outlet is not turned off at any switch or breaker.
• Other electrical equipment plugged into the outlet is working.
• All options are properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer is 

turned off.

NOTE: 
• If error messages are displayed on the LCD panel or on your computer, follow the on-screen instructions to resolve the printer 

problems. For details about error messages and error codes, see "Understanding Printer Messages" on page 410.
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Display Problems

Problem Action
Menu settings changed from the 
operator panel have no effect.

Settings in the software program, the print driver, or the printer utilities have 
precedence over the settings made on the operator panel.
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Printing Problems
NOTE: 
• If Panel Lock Set is set to Enable, you need to enter the four digit passcode to enter the Admin Settings menu.

Problem Action
Job did not print or incorrect 
characters printed.

Ensure that the top menu appears on the LCD panel before you send a job to print. 
Press the  (Services) button to return to the top menu.

Ensure that the print media is loaded in the printer. Press the  (Services) button to 
return to the top menu.

Verify that the printer is using the correct page description language (PDL).

Verify that you are using the correct print driver.

Ensure that the correct USB cable, Ethernet cable or wireless printer adapter is 
securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the printer's interface from the Admin Settings menu.

Determine the host interface you are using. Print a Panel Settings page to verify that 
the current interface settings are correct.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for your printer.

See also: 
• "Usable Print Media" on page 145

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources are adjusted 
correctly.

Ensure that the standard 550 sheet tray, the optional 550 sheet feeder, or the bypass 
tray is securely inserted.

Do not overload the standard 550 sheet tray, the optional 550 sheet feeder, or the 
bypass tray.

Do not force print media into the bypass tray when you load it; otherwise, it may skew 
or buckle.

Ensure that the print media is not curled.

Face the recommended print side up.

See also: 
• "Loading Print Media" on page 149

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print media.

Load print media only when the standard 550 sheet tray, the optional 550 sheet 
feeder, or the bypass tray is empty.

Wipe the feed roller in the standard 550 sheet tray, the optional 550 sheet feeder, or 
the bypass tray with a cloth moistened with water.

The envelope is creased after 
printed.

Make sure that the envelope is loaded in the bypass tray as instructed in "Loading 
Envelope in the Bypass Tray" on page 154.

Page breaks in unexpected 
places.

Increase the value for the time-out on the operator panel or CentreWare Internet 
Services. 
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Print media does not stack neatly 
in the output tray.

Turn the print media stack over in the standard 550 sheet tray or the bypass tray.

Cannot print from the standard 
550 sheet tray or the optional 550 
sheet feeder because the print 
media in the tray or feeder is 
curled.

Load the print media into the bypass tray.

Problem Action
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Print Quality Problems
This section includes:

• "The Output Is Too Light" on page 380
• "Toner Smears or Print Comes Off" on page 381
• "Random Spots/Blurred Images" on page 382
• "The Entire Output Is Blank" on page 383
• "Streaks Appear on the Output" on page 384
• "Part or the Entire Output Is Black" on page 384
• "Pitched Color Dots" on page 385
• "Vertical Blanks" on page 386
• "Mottle" on page 386
• "Ghosting" on page 387
• "Light-Induced Fatigue" on page 387
• "Fog" on page 388
• "Bead-Carry-Out (BCO)" on page 388
• "Jagged Characters" on page 389
• "Banding" on page 390
• "Auger Mark" on page 390
• "Wrinkled/Stained Paper" on page 391
• "Damage on the Leading Edge of Paper" on page 392
• "The Top and Side Margins Are Incorrect" on page 392
• "Color Registration Is out of Alignment" on page 393
• "Protrudent/Bumpy Paper" on page 393
• "Images Are Skewed" on page 394

NOTE: 
• In this section, some procedures use the operator panel, CentreWare Internet Services or PCL 6 driver.

See also: 
• "Understanding the Printer Menus" on page 290
• "CentreWare Internet Services" on page 85
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The Output Is Too Light

Problem Action
The output is too light. The toner cartridges may be low or need to be replaced. Confirm the amount of toner 

in each toner cartridge.
1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridges as necessary.

If the problem persists, disable Toner Saver in the print driver.

Disable Toner Saver in the print driver. The following procedure uses the PCL 6 
driver as an example.
1 On the Image Options tab, ensure that Off is selected in the Toner Saver 

drop-down menu.

If the problem persists, try changing the Paper Type setting in the print driver.

The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using a PCL 6 
driver.
1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 145

If not, use the print media recommended for the printer.

If the problem persists, clean inside the printer by using the cleaning rod.

Clean inside the printer by using the cleaning rod.

See also: 
• "Cleaning the Raster Optical Scanner (ROS) Window" on page 428

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Toner Smears or Print Comes Off

Problem Action
Toner smears or print comes off. The print media surface may be uneven. Try changing the Paper Type setting in the 

print driver. For example, change the plain paper to heavyweight using a PCL 6 
driver.
1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 145

If not, use the print media recommended for the printer.

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.
1 Replace the drum cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

2 After you replace the drum cartridges, test print your document again.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit" on page 442.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit" on page 442

If the problem persists, replace the 2nd BTR, the belt unit, and the retard roller as 
instructed in "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on 
page 445.

Replace the 2nd BTR, the belt unit, and the retard roller.

See also: 
• "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on page 445

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Random Spots/Blurred Images

Problem Action
The printed result has random 
spots or is blurred.

Ensure that the toner cartridges are installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 434

If the problem persists, ensure that the drum cartridges are installed correctly.

Ensure that the drum cartridges are installed correctly.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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The Entire Output Is Blank

Problem Action
The entire output is blank. The toner cartridges may be low or need to be replaced. Confirm the amount of toner 

in each toner cartridge.
1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridges as necessary.

If the problem persists, disable Toner Saver in the print driver.

Disable Toner Saver in the print driver. The following procedure uses the PCL 6 
driver as an example.
1 On the Image Options tab, ensure that Off is selected in the Toner Saver 

drop-down menu.

If the problem persists, try changing the Paper Type setting in the print driver.

The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using the PCL 6 
driver.
1 On the Paper / Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 145

If not, use the print media recommended for the printer.

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Streaks Appear on the Output

Part or the Entire Output Is Black

Problem Action
Streaks appear on the output. The toner cartridges may be low or need to be replaced. Confirm the amount of toner 

in each toner cartridge.
1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridges as necessary.

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
Part or the entire output is black. Ensure that the drum cartridges are installed correctly.

See also: 
• "Installing the Drum Cartridges" on page 439

If the problem persists, ensure Output Color is set to Color in the print driver.

Ensure Output Color is set to Color in the print driver. The following procedure uses 
the PCL 6 driver as an example.
1 On the Color Options tab, ensure that the Output Color is set to Color.

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Pitched Color Dots

Problem Action
The printed result has pitched 
color dots.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit" on page 442

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Replace the 2nd BTR, the belt unit, and the retard roller.

See also: 
• "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on page 445

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Vertical Blanks

Mottle

Problem Action
The printed result has vertical 
blanks.

Clean inside the printer by using the cleaning rod.

See also: 
• "Cleaning the Raster Optical Scanner (ROS) Window" on page 428

If the problem persists, ensure the light path is not covered.

Ensure the light path is not covered.
1 Remove the drum cartridges, and keep it in the dark place.

See also: 
• "Replacing the Drum Cartridges" on page 436

2 Check the light path, and then remove the shielding.

3 Re-install the drum cartridges.

See also: 
• "Installing the Drum Cartridges" on page 439

If the problem persists, replace the drum cartridges if you have spare cartridges.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
The printed result has mottled 
appearance.

Verify that the print media recommended for the printer is being used.

If you use non-recommended print media, use the print media recommended for the 
printer.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Ghosting

Light-Induced Fatigue

Problem Action
The printed result has ghosting. If the type of the ghosting is positive ghost:

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

If the type of the ghosting is negative ghost:

Verify that the print media recommended for the printer is being used.

If you are using non-recommended print media, use the print media recommended 
for the printer.

If the problem is solved, adjust the transfer bias.

If the problem persists, replace the drum cartridges if you have spare cartridges.

Adjust the transfer bias.
1 On the operator panel, press the  (System) button and select the Tools tab 

and select Admin Settings → Maintenance → Adjust 2nd BTR.

2 Adjust the setting for the type of print media being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
The printed result has 
light-induced fatigue pattern.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Fog

Bead-Carry-Out (BCO)

Problem Action
The printed result is foggy. Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
Bead-Carry-Out (BCO) is 
happening.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Jagged Characters

Problem Action
The printed result has jagged 
characters.

Set Screen to Fineness in the print driver. The following procedure uses the PCL 6 
driver as an example.
1 On the Advanced tab, set Screen under Image Options to Fineness.

If the problem persists, set Image Quality to High Quality in the print driver.

Set Image Quality to High Quality in the print driver. The following procedure uses 
the PCL 6 driver as an example.
1 On the Color Options tab, select High Quality from Image Quality.

If the problem persists, enable Bitmap Smoothing in the print driver.

Enable Bitmap Smoothing in the print driver. The following procedure uses the PCL 
6 driver as an example.
1 On the Advanced tab, set Bitmap Smoothing under Image Options: to On.

If the problem persists, enable Print Page Mode in the print driver.

Enable Print Page Mode in the print driver. The following procedure uses the PCL 6 
driver as an example.
1 On the Advanced tab, set Print Page Mode under Image Options: to On.

If the problem persists, check whether or not the downloaded font you are using is 
recommended.

If using a downloaded font, ensure that the font is recommended for the printer, 
operating system, and the application being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Banding

Auger Mark

Problem Action
The printed result has banding. Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit" on page 442

If the cause of the problem is not located, contact the Fuji Xerox local representative 
office or an authorised dealer.

Replace the 2nd BTR, the belt unit, and the retard roller.

See also: 
• "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on page 445

If the cause of the problem is not located, contact the Fuji Xerox local representative 
office or an authorised dealer.

Problem Action
The printed result has auger 
mark.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Wrinkled/Stained Paper

Problem Action
The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 145
• "About Print Media" on page 142

If not, use the print media recommended for the printer.

If the problem with printing on an envelope persists, check the wrinkle of the 
envelope.

If the problem with printing on a print media other than envelopes persists, contact the 
Fuji Xerox local representative office or an authorised dealer.

Check whether the wrinkle of the four edges of the envelope is within 30 mm.

If the wrinkle of the four edges of the envelope is within 30 mm, this type of wrinkle is 
considered normal. Your printer is not at fault.

If not, load the envelopes in the bypass tray properly.

Load the envelopes in the bypass tray properly.

See also: 
• "Loading Envelope in the Bypass Tray" on page 154

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Damage on the Leading Edge of Paper

The Top and Side Margins Are Incorrect

Problem Action
The output is damaged on its 
leading edge.

When using the bypass tray, reverse the paper and then try again. 

If the problem persists, change the paper with another one and then try again.

When using the standard 550 sheet tray or optional 550 sheet feeder, change the 
paper and then try again.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Change the paper with another one and then try again.

If the problem persists, use the standard 550 sheet tray or optional 550 sheet feeder 
in place of the bypass tray.

Use the standard 550 sheet tray or optional 550 sheet feeder in place of the bypass 
tray.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
The top and side margins are 
incorrect.

Ensure that the margins are set correctly on the application being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Color Registration Is out of Alignment

Protrudent/Bumpy Paper

Problem Action
Color registration is out of 
alignment.

Adjust the settings of the paper type on the print driver to those of the tray or feeder.

If the problem persists, execute auto color registration adjustment.

Execute auto color registration adjustment.
1 On the operator panel, press the  (System) button, select the Tools tab and 

select Admin Settings → Maintenance → Color Registration → Auto 
Registration → Start.

If the problem persists, check whether or not you have spare drum cartridges.

Check whether or not you have spare drum cartridges.

If you have spare drum cartridges, replace the drum cartridges.

If you do not have spare drum cartridges, contact the Fuji Xerox local representative 
office or an authorised dealer.

Replace the drum cartridges if you have spare cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action
Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.
1 Load one sheet of paper in the bypass tray, and then print a solid image all over 

paper.

2 Load the printed sheet with the side to be printed on facing down, and then print a 
blank sheet of paper.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Images Are Skewed

Problem Action
The printed result are skewed. Adjust the paper guides properly.

If the problem persists, install the belt unit according to an appropriate procedure.

Install the belt unit according to an appropriate procedure.

See also: 
• "Installing a Belt Unit" on page 449

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Noise

Problem Action
The printed result has the noise. To specify the cause of the noise, perform the Auto Registration.

If the problem is solved, replace the 2nd BTR, the belt unit, and the retard roller.

If the problem persists, replace the fusing unit.

Replace the 2nd BTR, the belt unit, and the retard roller.

See also: 
• "Replacing the Belt Unit, the 2nd BTR, and the Retard Roller" on page 445

If the problem persists, replace the waste toner box.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit" on page 442

If the problem persists, replace the black toner cartridge.

Replace the waste toner box.

See also: 
• "Replacing the Waste Toner Box" on page 454

If the problem persists, replace the drum cartridges.

Replace the drum cartridges.

See also: 
• "Replacing the Drum Cartridges" on page 436
• "Installing the Drum Cartridges" on page 439

If the problem persists, replace the black toner cartridge.

Replace the black toner cartridge.

See also: 
• "Replacing the Toner Cartridges" on page 433

If the problem persists, replace the yellow toner cartridge.

Replace the yellow toner cartridge.

See also: 
• "Replacing the Toner Cartridges" on page 433

If the problem persists, replace the magenta toner cartridge.

Replace the magenta toner cartridge.

See also: 
• "Replacing the Toner Cartridges" on page 433

If the problem persists, replace the cyan toner cartridge.

Replace the cyan toner cartridge.

See also: 
• "Replacing the Toner Cartridges" on page 433

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Copy Problem

Problem Action
A document loaded in the DADF 
cannot be copied.

Ensure that the DADF cover is firmly closed.

Ensure that the release lever is properly positioned.

Vertical blanks or streaks appear 
on the output when scanned 
using the DADF.

Clean the DADF glass.

Clean inside the printer by using the cleaning rod.

See also: 
• "Cleaning the Raster Optical Scanner (ROS) Window" on page 428
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Copy Quality Problems

NOTE: 
• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 

representative office or an authorised dealer.

Problem Action
There are lines or streaks in 
copies made from the DADF.

There is debris on the DADF glass. When scanning, the paper from the DADF passes 
over the debris creating lines or streaks. 

Clean the DADF glass with a lint free cloth.

See also: 
• "Cleaning the Scanner" on page 420

There are spots in copies taken 
from the document glass.

There is debris on the document glass. When scanning, the debris creates a spot on 
the image.

Clean the document glass with a lint free cloth.

See also: 
• "Cleaning the Scanner" on page 420

The reverse side of the original is 
showing on the copy.

Use the Lighten / Darken option on the Copy menu.

For information on making the image lighter, see "Lighten / Darken" on page 203.

Light colors are washed out or 
white on the copy.

On the Copy menu, disable Auto Background Suppression.

For information on turning Auto Background Suppression on and off, see "Auto 
Background Suppression" on page 205.

Image is too light or dark. Use the Lighten / Darken option on the Copy menu.

For information on making the image lighter or darker, see "Lighten / Darken" on 
page 203.
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Adjusting Color Registration
This section describes how to adjust the color registration when you first install the printer or after moving it to a new 
location.
This section includes:

• "Performing Auto Adjust" on page 398
• "Printing the Color Registration Chart" on page 398
• "Determining Values" on page 399
• "Entering Values" on page 401

NOTE: 
• If Panel Lock Set is set to Enable, you need to enter the four digit passcode to enter the Admin Settings menu.

Performing Auto Adjust
Auto Adjust allows you to correct the color registration automatically.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Color Registration.

6 Select Auto Registration.

7 Select Start.
Auto Adjust is performed.

Printing the Color Registration Chart 
1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Color Registration.

6 Select Print Registration Chart.

7 Select Print.
The color registration chart is printed.
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Determining Values
On the color registration chart, there are two types of charts: Chart 1 (fast scan) and Chart 2 (slow scan).

The Chart 1 is used to adjust the color registration for the fast scan direction, which is vertical to paper feed direction. 
The Chart 2 is used to adjust the color registration for the slow scan direction, which is horizontal to paper feed 
direction.
The following sections explain how to determine the adjustment values for the fast scan and the slow scan using 
Chart 1 and Chart 2.

Fast Scan
On the Chart 1 of the color registration chart, find the straightest lines where the two black lines and the colored line 
are most closely aligned for each color (LY, LM, LC, RY, RM, and RC). If you find the straightest line, make a note of 
the value (-8 to +8) indicated by the straightest line for each color.
When the value is 0 for each color, you do not need to adjust the color registration for the fast scan.
When the value is not 0, enter the value using the procedure in "Entering Values" on page 401.

Chart 1 (fast scan)

Chart 2 (slow scan)

Straightest line
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Slow Scan
On the Chart 2 of the color registration chart, find the medium line within the range of white area for each color 
pattern (PY, PM, and PC). If you find the medium line, make a note of the value (-9 to +9) indicated by the medium 
line for each color.
When the value is 0 for each color, you do not need to adjust the color registration for the slow scan.
When the value is not 0, enter the value using the procedure in "Entering Values" on page 401.

Lattice pattern
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Entering Values
Using the operator panel, enter the values found in the color registration chart to make adjustments. 

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Color Registration.

6 Select Enter Registration Values.

7 Ensure that LY, LM, and LC appear.

8 Select + or - to specify the values for LY, LM, and LC.

9 Select Next.

10 Ensure that RY, RM, and RC appear.

11 Select + or - to specify the values for RY, RM, and RC.

12 Select Next.

13 Ensure that PY, PM, and PC appear.

14 Select + or - to specify the values for PY, PM, and PC.

15 Select OK.

NOTE: 
• The registration values are always shown as 0 the next time you enter the menu.

16 Select Print Registration Chart.

17 Select Print.
The color registration chart is printed with the new values.

If the straightest line is not at the value of 0, adjust the values again. Checking the charts before and after the 
adjustments will help you to determine the values to enter.

After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer is 

turned off.
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Fax Problems

Problem Action
The printer is not working, there 
is no display and the buttons are 
not working.

Unplug the power cord and plug it in again.

Ensure that there is power to the electrical receptacle.

No dial tone sounds. Check that the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 258

Check that the phone socket in the wall is working by plugging in another phone.

The numbers stored in the 
memory do not dial correctly.

Ensure that the numbers are stored in the memory correctly.

Print an Address Book list.

The document does not feed into 
the printer.

Ensure that the document is not wrinkled and you are putting it in correctly. Check 
that the document is of the right size, not too thick or thin.

Ensure that the DADF cover is firmly closed.

Faxes are not received 
automatically.

Check that the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 258

The Fax mode should be selected.

Ensure that there is paper in the paper tray.

Check to see if the display shows Memory Full.

If the time interval specified for the following features is too long, change the time 
interval shorter such as 30 seconds.
• Auto Answer Fax
• Auto Ans. TEL/FAX
• Auto Ans. Ans/FAX

The printer does not send faxes. Sending Fax should show up on the display.

Check the other fax machine you are sending to, to see if it can receive your fax.

Check the Dialing Type for PB, DP(10PPS) or DP(20PPS).

Ensure that the document is loaded in the DADF or on the document glass.

The incoming fax has blank 
spaces or is received in poor 
quality.

Check your printer by making a copy.

The toner cartridge may be empty. Replace the toner cartridge.

See also: 
• "Replacing the Toner Cartridges" on page 433

A noisy phone line can cause line errors. Set the fax modem speed to a slower 
speed.

The fax machine sending you the fax may be faulty.

Some of the words on an 
incoming fax are stretched.

The fax machine sending you the fax had a temporary document jam.

There are lines on the documents 
you send.

Check the surface of the document glass and DADF glass for marks and clean it.

See also: 
• "Cleaning the Scanner" on page 420

The printer dials a number, but 
the connection with another fax 
machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming 
calls. Speak with the other machine operator and ask her/him to sort out the problem.

Documents are not stored in the 
memory.

There may not be enough memory to store the document. If the display shows a 
Memory Full message, delete any documents you no longer need from the 
memory and then restore the document, or wait for the job in progress (e.g., a fax 
transmission or reception) to complete.
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Blank areas appear at the bottom 
of each page or on other pages, 
with a small strip of text at the 
top.

You may have chosen the wrong paper settings in the user option setting.

See also: 
• "Supported Print Media" on page 145

The printer will not send or 
receive faxes.

Ensure that the region code is set correctly under  (System) → Tools → Admin 
Settings → Fax Settings → Fax Line Settings → Region.

Check the Dialing Type for PB, DP(10PPS) or DP(20PPS).

Check that the cables are connected properly.

If the telephone line cord is connected to the printer via any device such as an 
answering machine and a computer, remove the device and directly connect the 
telephone line cord to the printer.

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed under  (System) → Tools → Admin Settings → 
Fax Settings → Transmission Defaults → Modem Speed.

The printer receive faxes, but it 
does not print.

Check the toner level.

Ensure that there is paper in the paper tray.

Ensure that Forward Settings is set to Off.

Ensure that Junk Fax Filter is set to Off.

Ensure that Secure Receive Set is set to Disable.

Execute Initialize NVM.
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Scanning Problems

Problem Action
The scanner does not work. Ensure that you place the document to be scanned facing down from the document 

glass, or facing up in the DADF. 

There may not be enough available memory to hold the document you want to scan. 
Try the Preview function to see if that works. Try lowering the scan resolution rate. 

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

Ensure that the USB cable, Ethernet cable or wireless printer adapter is not defective. 
Switch the cable or adapter with a known good cable or adapter. If necessary, replace 
it.

If using the network TWAIN (WIA) driver, check that the Ethernet cable or wireless 
printer adapter is connected properly and the IP address of the printer is set correctly. 
To check the IP address, see "Verifying the IP Settings" on page 99.

Check that the scanner is configured correctly. Check the application you want to use 
to make certain that the scanner job is being sent to the correct port.

Ensure that the scanner sharing feature is disabled when you use Mac OS® X before 
you scan documents via an ICA compatible application such as Image Capture. The 
printer does not support the scanner sharing feature of Mac OS X. Select a printer 
which is directly connected to the computer via USB or wired / wireless LAN and scan 
documents.

The printer scans very slowly. Graphics are scanned more slowly than text when you use the E-mail or Scan To 
Network feature.

Communication speed becomes slow in scan mode because of the large amount of 
memory required to analyze and reproduce the scanned image.

Scanning images at a high resolution takes more time than scanning at a low 
resolution.

Document misfeeds or multiple 
feeds occur in the DADF.

Check whether the DADF feed roller assembly is installed properly.

Ensure the document’s paper type meets the specifications for the printer.

See also: 
• "Duplex Automatic Document Feeder (DADF) Guidelines" on page 144

Check whether the document is properly loaded in the DADF.

Ensure that the document guides are adjusted properly.

Ensure that the number of document sheets do not exceed the maximum capacity of 
the DADF.

Ensure that the document is not curled.

Fan the document well before loading it in the DADF.

Vertical stripes appear on the 
output when scanned using the 
DADF.

Clean the DADF glass.

See also: 
• "Cleaning the Scanner" on page 420

Clean inside the printer by using the cleaning rod.

See also: 
• "Cleaning the Raster Optical Scanner (ROS) Window" on page 428

A smear appears at the same 
location on the output when 
scanned using the document 
glass.

Clean the document glass.

See also: 
• "Cleaning the Scanner" on page 420

Images are skewed. Ensure that the document is loaded straight in the DADF or on the document glass.

Diagonal lines appear jagged 
when scanned using the DADF.

If the document uses thick media, try scanning it from the document glass.
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Message appears on your 
computer screen: 
• Device can’t be set to the 

H/W mode you want.
• Port is being used by 

another program.
• Port is Disabled.
• Scanner is busy receiving or 

printing data. When the 
current job is completed, try 
again.

• Invalid handle.
• Scanning has failed.

There may be a copying or printing job in progress. When the current job is complete, 
try the job again.

The selected port is currently being used. Restart your computer and try again.

The cable may be improperly connected or the power may be off.

The scan driver is not installed or an operating environment is not set up properly.

Ensure that the port is properly connected and the power is turned on. Then restart 
your computer.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

The printer does not properly 
transfer scan data to a specified 
destination via the Scan to Email 
or Scan To Network feature.

Check if the following settings have been set correctly on the CentreWare Internet 
Services.

Scan To Network
Check the following settings under Address Book → Computer/Server Address 
Book → Edit Network Scan Address:
• Server Address
• Login Name
• Login Password
• Share Name (Displays only when Server Type is set to SMB)
• Server Path

Scan to Email
Check the following setting under Address Book → Email Address Book:
• Address

Cannot scan using WIA on a 
Microsoft® Windows Server® 
2003 computer.

Enable WIA on the computer.

To enable WIA:
1 Click Start, point to Administrative Tools, and then click Services.

2 Right-click Windows Image Acquisition (WIA), and then click Start.
Cannot scan using TWAIN or 
WIA on a Windows Server 2008 
or Windows Server 2008 R2 
computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Start, point to Administrative Tools, and then click Server Manager.
2 Under Features Summary, click Add Features.

3 Select the Desktop Experience check box, click Next, and then click Install.
4 Restart the computer.

Cannot scan using TWAIN or 
WIA on a Windows Server 2012 
computer. 

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Server Manager from the Start screen.

The Server Manager screen appears.

2 Under Manage, click Add Roles and Features.
Add Roles and Features Wizard appears.

3 Click Next to skip the Before you begin page.

4 Ensure that Role-based or feature-based installation is selected, and then click 
Next.

5 Ensure that Select a server from the server pool is selected, select the server 
under Server Pool, and then click Next.

6 Click Next to skip the Select server roles page.

7 Select the Desktop Experience check box under User Interfaces and 
Infrastructure, and then click Next.

8 Click Confirmation from the list on the left.

9 Select the Restart the destination server automatically if required check box, 
and then click Install.

10  Restart the computer.
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Digital Certificate Problem

Problem Action
The LDAP-SSL/TLS 
Communication setting and the 
Upload Signed Certificate 
button are not displayed.

Confirm whether the optional hard disk unit is connected correctly, and confirm 
whether data encryption is enabled from the operator panel.

The certificate import button is 
disabled.

Create a self-signed certificate and enable SSL.

 The Certificate Management 
button is disabled.

The certificate cannot be 
imported.

Confirm validity period of the certificate as well as the time setting of the device.

Confirm whether the password is correct.

Confirm whether the file type is PKCS#7/#12 or x509CACert (extension: 
p7b/p12/pfx/cer/crt).

Confirm whether the attribute information (key Usage/Extended key usage) of the 
certificate to be imported is set correctly.

Use Internet Explorer.

016-404 is displayed when 
setting the encryption of the 
optional hard disk unit to off.

After initializing, import the certificate and enable the security settings again. The 
action is the same when formatting the optional hard disk unit.

016-404 is displayed when 
formatting the optional hard disk 
unit.

Security is set to off when setting 
encryption of the optional hard 
disk unit to off.

Security is set to off when 
formatting the optional hard disk 
unit.

A certificate is deleted when 
setting encryption of the optional 
hard disk unit to off.

A certificate is deleted when 
formatting the optional hard disk 
unit.

A certificate cannot be set in 
Certificate Details page.

The validity period of the certificate is invalid.

Confirm whether the time setting of the machine is correct, and whether the validity 
period of the certificate has expired.

The certificate chain (path validation) of the imported certificate may not be correctly 
validated.

Confirm whether all of the high-level certificates (Trusted/Intermediate) have been 
imported and are not deleted, and whether the validity period has expired.

Although a certificate was 
imported, it is not displayed when 
selecting Local Device for 
Category in Certificate 
Management page.

To import a certificate for use with the device (own device), import the secret key and 
a certificate of the PKCS#12 (p12/pfx) format as a pair.

Server validation is not operating 
correctly.

Although importing a root certificate (Trusted) to use for server authentication, an 
Intermediate certificate may be required when validating the path.

When executing a certificate file with the certification authority, create the certificate 
with a format including all paths and then import that certificate.

Digital Signature cannot be 
selected with the IPsec setting.

Either the certificate has not been imported or the certificate has not been associated 
for use with Digital Signature mode of IPsec. See "Using Digital Certificates" on 
page 181 to set a certificate of IPsec.
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Problems With Installed Optional Accessories
If an option does not operate correctly following installation or stops working:
• Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the printer, and 

check the connection between the option and the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer is 

turned off.
• Ensure the option is selected in the print driver you are using.
• Print the System Settings page to see if the option is listed in the Printer Options list. If the option is not listed, re-install it.

See also: 
• "Report / List" on page 290

The following table lists printer's option and corrective action for related problem. If the suggested corrective action 
does not correct the problem, contact the Fuji Xerox local representative office or an authorised dealer.

Problem Action
The optional 550 sheet feeder 
does not work correctly.

Ensure that the optional 550 sheet feeder is correctly installed on the printer. 
Re-install the optional 550 sheet feeder. 

See also: 
• "Removing the Optional 550 Sheet Feeder (without the Cabinet)" on page 475
• "Installing the Optional 550 Sheet Feeder (without the Cabinet)" on page 64

If the problem persists, contact customer support.

Ensure that the print media is loaded correctly.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet 

Feeder" on page 150

If the problem persists, contact customer support.

The optional 512MB memory 
does not work correctly.

Ensure that the optional 512MB memory is securely connected to the memory 
connector.

If the problem persists, contact customer support.

The optional hard disk unit does 
not work correctly.

Ensure that the optional hard disk unit is securely inserted to the correct slot.

The optional wireless printer 
adapter does not work correctly.

Ensure that the optional wireless printer adapter is securely inserted to the correct 
slot.
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Scan Driver/Printer Utility Problems

Problem Action
Unable to retrieve the Address 
Book data from the printer on the 
Address Book Editor.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

Ensure that the printer is turned on.

Ensure that the scan driver is installed on your computer. (The Address Book Editor 
retrieves the Address Book data via the scan driver when the printer is connected 
using a USB cable.)

The TWAIN driver cannot 
connect to the printer.

Check that the USB cable, Ethernet cable or wireless printer adapter is connected 
properly.

If using the network connection, check that IP address of the printer is set correctly. 
To check the IP address, see "Scanning Using the TWAIN Driver" on page 220.

Check whether the printer is on. If the printer is on, reboot it by turning the power 
switch off and then on again.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in 

the memory are cleared when the printer is turned off.

If a scan application is running, close the application once, restart the application, and 
then try scanning again.

The scan driver has not been 
registered on your computer and 
cannot be accessed from 
Express Scan Manager. 

Install the scan driver. If the scan driver is installed, uninstalled it and then re-install it. 
After the installation of the scan driver is completed, re-install the Express Scan 
Manager.

Failed to scan your document on 
the printer via Express Scan 
Manager.

Ensure that your computer and the printer is properly connected with the USB cable.

Check whether the printer is on. If the printer is on, reboot it by turning the power 
switch off and then on again.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in 

the memory are cleared when the printer is turned off.

If a scan application is running, close the application once, restart the application, and 
then try scanning again.

Network connection cannot be used. Connect with the USB cable.

Uninstall Express Scan Manager on your computer and then re-install it.

Failed to create an image file via 
Express Scan Manager.

Ensure there is sufficient space in your hard disk.

Uninstall Express Scan Manager on your computer and then re-install it.

Failed to initialize Express Scan 
Manager.

Uninstall Express Scan Manager on your computer and then re-install it.

Failed to execute Express Scan 
Manager.

Uninstall Express Scan Manager on your computer and then re-install it.

An unexpected error occurred on 
Express Scan Manager.

Uninstall Express Scan Manager on your computer and then re-install it.
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Other Problems

Problem Action
Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in winter. This also 
occurs when the printer is operating in a location where relative humidity reaches 
85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment.
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Understanding Printer Messages
The printer LCD panel displays messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This section describes messages, their meanings, and how to clear the messages.
When you contact the customer support about an error, have the error codes and messages ready.

IMPORTANT: 
• When an error code is displayed, the print data remaining on the printer and the information accumulated in the memory of the 

printer are not secured.
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer is 

turned off.

NOTE: 
• An error code is listed in an error message.
• For error messages that are not listed in this chapter, refer to instructions in each error messages.

Error-Code What You Can Do
010-317 Turn off the printer and wait for 30 minutes. Open the rear cover and make sure that the fusing unit is 

fully installed, and turn on the printer.

010-397 Turn off the printer. Confirm that the fusing unit is correctly installed, and turn on the printer. Contact 
customer support if this failure is repeated.

016-404 Contact your system administrator.

016-405

016-500 Turn off the printer, and turn it on again.

016-501

016-502

016-503 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if SMTP 
server and DNS server are set correctly on CentreWare Internet Services.

016-504 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if POP 
server and DNS server are set correctly on CentreWare Internet Services.

016-505 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if user name 
and password used for POP3 server are set correctly on CentreWare Internet Services.

016-506 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if SMTP 
server or POP server is set on CentreWare Internet Services.

016-507 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if user name 
and password used for SMTP server are set correctly on CentreWare Internet Services.

016-520 Contact your system administrator.

016-521

016-522

016-523

016-524

016-527

016-570 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

016-571

016-572

016-573

016-718 Select Close, or wait for the time set in Fault Timeout for the printer to recover. The file size 
exceeds the maximum for the printer to process. Print the file from your computer.

016-720 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

016-737 Turn off the printer, and turn it on again.

016-741

016-744

016-746 Select Close to recover the printer.
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016-750 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

016-753

016-755

016-757 Contact your server administrator.

016-758

016-759

016-764 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Contact SMTP 
server administrator.016-765

016-766

016-767 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check e-mail 
address, and try scanning again.016-768

016-786 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the 
network cable is connected properly. If there is no problem with the network cable, contact server 
administrator.

016-790

016-791 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

016-799 Select Close or wait for the time set in Fault Timeout for the printer to recover.

016-920 Select Close, or wait for the time set in Fault Timeout for the printer to recover. And try it again.

016-921

016-922

016-923 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Modify the setting of 
WEP key or WPA pass phrase.

016-930 The device is not supported. Remove it from the USB port.

016-931 The USB hub is not supported. Remove it from the USB port.

016-982 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

016-985 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Retry scanning by 
lowering the resolution setting or changing the file format of the scanned image.016-986

026-720 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

Check your USB storage device:
• If the file size or the number of files exceeds the limit of your USB storage device.
• If your USB storage device is write-protected.

026-721

031-521 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Confirm login-able 
computer with your system administrator.

031-522 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if login name 
(domain name and user name) and password are correct.

031-523 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the share 
name you specified.

031-524 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the number 
of users who use the server at the same time is not exceeding the upper limit.

031-525 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the 
specified user can read and write file at the storage location.

031-526 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check DNS 
connection, or check if forwarding destination server is registered with DNS.

031-527 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Set DNS address, 
or set forwarding destination server address as IP address.

031-528 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the printer 
can communicate via network with the forwarding destination SMB server. For example, check the 
following:
• Connection of a network cable
• TCP/IP setting
• Communication with Port 137 (UDP), 138 (UDP), and 139 (TCP)

For communication beyond the subnet, check setting of the WINS server and if server name can be 
resolved correctly.

031-529 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if password 
is correct.
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031-530 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if storage 
location is correct. Storage location you specified is DFS setting, and check if it is linked to other server. 
Specify directly linked server, share name, and storage location.

031-531 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check access right 
of the folder you specified.

031-532 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Change file name 
and forwarding destination folder, or move or delete file in forwarding destination folder. 

031-533 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the 
following:
• If the file name you specified can be created in the storage location.
• If the file name you specified is not used by other users.
• If file or folder that has the same name as the one you specified already exists.

031-534 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the 
following:
• If the file name you specified can be created in the storage location.
• If file or folder that has the same name as the one you specified already exists.

031-535 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if other user 
is not operating file in storage location you specified. 031-536

031-537 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if storage 
location has free space.

031-539 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if server 
name is correct.

031-540 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if domain 
name is correct.

031-541 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if login name 
(user name) is correct.

031-542 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Wait for a while and 
try the same operation again. Contact customer support if this failure is repeated.

031-543 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check login 
permitted time with your system administrator.

031-544 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the 
password valid period with your system administrator.

031-545 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check necessity of 
password change with your system administrator.

031-546 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check user invalid 
setting with your system administrator.

031-547 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check user lock-out 
status with your system administrator.

031-548 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check user valid 
period with your system administrator.

031-549 Select Close, or wait for the time set in Fault Timeout for the printer to recover. On server security 
settings, check access permission of null password user.

031-550 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check append 
access right to the file. Check if server supports the SMB append command.

031-551 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check rename 
access right to the file. Check if server supports SMB rename command.

031-552 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Set other than 
"Cancel" for processing in the case of file name duplication, or change/delete file name the same as the 
one specified in sending destination folder.

031-574 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check DNS 
connection, or check if name of forwarding destination server is registered with DNS.

031-575 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Set DNS address, 
or set forwarding destination server address as IP address.

031-576 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the printer 
communicates with forwarding destination FTP server. For example, check connection of network cable 
and if the IP address of the server is correct.
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031-578 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if login name 
(user name) and password are correct. 

031-579 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if storage 
location is correct.

031-580 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check server 
access right.

031-581 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Change file name 
and forwarding destination folder, or move or delete file in forwarding destination folder.

031-582 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the file 
name you specified can be created in storage location. Check if storage location has free space.

031-584 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the folder 
name you specified can be created in storage location. Check if the folder that has the same name as 
the one you specified already exists.

031-585 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check server 
access rights.031-587

031-588 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if storage 
location has free space.

031-590 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Set other than 
"Cancel" for processing in the case of file name duplication, or change/delete file name the same as the 
one specified in sending destination folder.

031-594 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Try the same 
operation again. Contact customer support if this failure is repeated.031-595

031-598 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check append 
access right to the file and if server supports the FTP append command.

031-599 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check rename 
access right to the file. Check if server supports the FTP rename command.

033-513 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Try the following:
• Print the received fax, or wait for a while until sending a fax is completed.
• Print the fax job stored using the Secure Receive feature.

NOTE: 
• For more information on the Secure Receive feature, see "Using the Secure Receiving Mode" on 

page 280.
033-762 Select Close, or wait for the time set in Fault Timeout for the printer to recover. The printer rejects 

faxes sent from unwanted numbers.

See also: 
• "Junk Fax Filter" on page 310

033-788 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Try the following:
• Remove the received fax, or wait for a while until sending a fax is completed.
• Print the fax job stored using the Secure Receive feature.

NOTE: 
• For more information on the Secure Receive feature, see "Using the Secure Receiving Mode" on 

page 280.
034-515 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Try the following:

• Try the same operation.
• Check the printer or remote machine if the memory is full. 

034-791 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the 
telephone line cord is connected properly. If the line connection is correct, check the following:
• If tone/pulse setting is correct.

NOTE: 
• For more information on tone/pulse setting, see "Dial Type" on page 312.

If tone/pulse setting is correct, check the following:
• If the remote machine can receive a fax.
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035-701 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the 
following:
• Status of the remote machine
• tone/pulse setting

NOTE: 
• For more information on tone/pulse setting, see "Dial Type" on page 312.

035-702 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Try the same 
operation.

035-708 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Try the following:
• Try the same operation.
• Reduce the modem speed.

NOTE: 
• For more information on modem speed, see "Modem Speed" on page 313.

035-717 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Reduce the modem 
speed.

NOTE: 
• For more information on modem speed, see "Modem Speed" on page 313.

035-718 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the status of 
the remote machine.

035-720 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check the features 
of the remote machine.

035-781 Select Close, or wait for the time set in Fault Timeout for the printer to recover. Check if the remote 
machine is busy. 

042-700 Wait for a while until the printer cools down.

077-215 Turn off the printer. Confirm that the duplexer is correctly installed, and turn on the printer. Contact 
customer support if this failure is repeated.

093-925 Turn off the printer. Confirm the black toner cartridge is correctly installed, and turn on the printer.

093-950 Turn off the printer. Confirm the yellow toner cartridge is correctly installed, and turn on the printer.

093-951 Turn off the printer. Confirm the magenta toner cartridge is correctly installed, and turn on the printer.

093-952 Turn off the printer. Confirm the cyan toner cartridge is correctly installed, and turn on the printer.

116-316 Turn off the printer. Remove the optional 512MB memory from the slot, and then reattach it firmly. Turn 
on the printer. Contact customer support if this failure is repeated.

116-317 Turn off the printer, and turn it on again. Contact customer support if this failure is repeated.

116-320 Remove the unsupported additional memory module. Contact customer support if this failure is 
repeated.

116-721 Select Close, or wait for the time set in Fault Timeout for the printer to recover.

116-722

117-361 Turn off the printer, and turn it on again. Contact customer support if this failure is repeated.
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the error message on 
the LCD panel.
You need to know the model type and service tag of your printer. See the label located on the rear of your printer.
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Getting Help
This section includes:

• "LCD Panel Messages" on page 416
• "SimpleMonitor Alerts" on page 416
• "Obtaining the Product Information" on page 416

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning condition occurs, 
the LCD panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 410

SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Driver CD Kit. It automatically checks the printer status when you 
send a print job. If the printer is unable to print your job, the SimpleMonitor automatically displays an alert on your 
computer screen to let you know that the printer needs attention.

Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.
The following procedure uses the PCL 6 driver as an example.

NOTE: 
• The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, select the Advanced tab and then click About.

2 Click Fuji Xerox Web Site.
Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 
• You can browse our web site also on the Driver CD Kit included with the printer. To access the web site, click Fuji Xerox Web 

Site on the installation startup window of the CD-ROM.
• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/
• For the latest information about the print driver features, refer to the Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded within the 
printer) from your computer.
The latest firmware and updating tool can be downloaded from the following URL.
Follow the instructions on the web site and download the correct firmware update.
http://www.fujixeroxprinters.com/

NOTE: 
• The communication fee shall be borne by users.

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/
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Non-Genuine Mode
When toner within a toner cartridge is empty, the Out of Toner message appears.
When you want to use the printer in Non-Genuine mode, program the mode and replace the toner cartridge.

IMPORTANT: 
• If you use the printer in the Non-Genuine mode, the performance of the printer may not be at its optimum. And any problems 

that may arise from the use of the Non-Genuine mode are not covered by our quality guarantee. The continuous use of the 
Non-Genuine mode can also cause the printer to break down, and any repair charges for such break down will be incurred by 
users.

NOTE: 
• Before starting the operation described below, confirm that Ready is displayed on the LCD panel.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Non-Genuine Toner.

6 Select On, and then select OK.
The printer switches to the Non-Genuine mode.
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Maintenance

This chapter includes:
• "Cleaning the Printer" on page 420
• "Replacing Consumables" on page 432
• "Ordering Supplies" on page 457
• "Storing Print Media" on page 459
• "Storing Consumables" on page 460
• "Managing the Printer" on page 461
• "Conserving Supplies" on page 464
• "Checking Page Counts" on page 465
• "Moving the Printer" on page 466
• "Removing Options" on page 468
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Cleaning the Printer
This section describes how to clean the printer in order to maintain it in good condition and print clean printouts all 
the time.

This section includes:
• "Cleaning the Scanner" on page 420
• "Cleaning the DADF Feed Roller" on page 422
• "Cleaning Inside the Printer" on page 423
• "Cleaning the Color Toner Density (CTD) Sensor" on page 423

Cleaning the Scanner
Keep the scanner clean to ensure the best possible copies. Clean the scanner at the start of each day and during 
the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.

2 Open the document cover.

WARNING:
• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning materials may 

result in poor performance of the product. Never use aerosol cleaners to avoid catching fire and explosion.

CAUTION:
• When cleaning this product, always switch off and unplug it. Access to a live machine interior may cause electric 

shock.
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3 Wipe the surface of the document glass and Duplex Automatic Document Feeder (DADF) glass until they are 
clean and dry.

4 Wipe the underside of the white document cover and white sheet until they are clean and dry.

5 Close the document cover.

1 White Sheet

NOTE: 
• Handle with care.

2 White Document Cover

3 Document Glass

4 DADF Glass

1

2

3

4
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Cleaning the DADF Feed Roller
Keep the DADF feed roller clean to ensure the best possible copies. Clean the DADF feed roller regularly.

1 Open the DADF cover.

2 Wipe the DADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.
If the DADF feed roller gets soiled with ink stains, paper from the DADF may also be soiled. In this case, slightly 
dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the 
contamination from the DADF feed roller until it is clean and dry.



Maintenance 423

Cleaning Inside the Printer

Cleaning the Color Toner Density (CTD) Sensor
Clean the Color Toner Density (CTD) sensor only when an alert for the CTD sensor is shown on the Printer Status 
window or operator panel.

1 Turn off the printer and disconnect the power cord.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Push down the latch to open the rear cover.

3 Open the side cover.
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4 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.

5 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner 
does not spill out.

NOTE: 
• Take care not to drop the waste toner box while you are removing it.
• After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain your hands.

6 Place the removed waste toner box on a level surface.

IMPORTANT: 
• Never lay the waste toner box on its side as this may cause its malfunction or toner spills.
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7 Lift the operator panel.

8 Open the top cover.

9 Put your fingers through the loops on both sides of the belt unit, and then pull it out.

10 At the rear of inside the printer, clean the CTD sensor with a clean dry cotton swab.
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11 Reinsert the belt unit into the printer.

12 Close the top cover.

13 Lower the operator panel back in place.

14 Reinsert the removed waste toner box.

NOTE: 
• If the waste toner box does not fit into place properly, make sure that the belt unit is fully inserted.
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15 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

16 Close the side cover.

17 Close the rear cover.



428 Maintenance

Cleaning the Raster Optical Scanner (ROS) Window
To prevent deterioration of printing quality due to stains inside the printer, clean inside the printer regularly by using 
the cleaning rod whenever you replace drum cartridges.

1 Open the side cover.

2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.

3 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner 
does not spill out.

NOTE: 
• Take care not to drop the waste toner box while you are removing it.
• After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 

your hands.
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4 Place the removed waste toner box on a level surface.

IMPORTANT: 
• Never lay the waste toner box on its side as this may cause its malfunction or toner spills.

5 Remove the cleaning rod from inside the printer.

6 Insert the cleaning rod fully into one of the four holes until it clicks into the interior of the printer as illustrated 
below, and then pull it out.
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7 Repeat step 6 also on the other three holes. One time insertion is enough for each hole.

8 Return the cleaning rod to its original location.

9 Reinsert the removed waste toner box.

NOTE: 
• If the waste toner box does not fit into place properly, make sure that the belt unit is fully inserted.

10 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.
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11 Close the side cover.
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Replacing Consumables
This section describes how to replace consumables.
The following comsumables are supplied as the replacable items.

• Toner cartridge
• Drum cartridge
• Fusing unit
• Belt unit
• 2nd BTR
• Retard Roller
• Waste toner box

WARNING:
• Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.

It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

• Never throw a waste toner bottle into an open flame. Toner may catch fire and cause burn injuries or 
explosion.
If you have a used waste toner bottle no longer needed, contact your local Fuji Xerox representative 
for its disposal.

CAUTION:
• Keep drum cartridges and toner cartridges out of the reach of children. If a child accidentally 

swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.
• When replacing drum cartridges and toner cartridges, be careful not to spill the toner. In case of any 

toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.
• If toner spills onto your skin or clothing, wash it off with soap and water. 

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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Replacing the Toner Cartridges
Fuji Xerox toner cartridges are available only through Fuji Xerox. 
It is recommended that you use Fuji Xerox toner cartridges for your printer. Fuji Xerox does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Fuji Xerox.

IMPORTANT: 
• Do not shake the used toner cartridge to avoid spilling of the toner.

This section includes:
• "Overview" on page 433
• "Removing the Toner Cartridge" on page 434
• "Installing a Toner Cartridge" on page 434

Overview
The printer has toner cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).
When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel.

*1: This warning appears only when Fuji Xerox toner cartridge is used (Non-Genuine Toner mode is set to Off).
*2: When a high capacity toner cartridge is set, the remaining page yield is approx. 2,200 pages. The remaining page yield differs 

depending on printing conditions, contents of the documents, and frequency of turning on/off the printer. For more information, see 
IMPORTANT of "Consumables" on page 457.

IMPORTANT: 
• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner cartridge to catch 

any toner that may spill.
• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.
• Do not shake or pound the used toner cartridges. The remaining toner may spill.
• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

Message Remaining Page Yield Printer Status and Action
Order Toner: XXXX*1 1,400 pages (K)

1,000 pages (Y/M/C)*2
The toner cartridge has become low. Prepare a new 
one.

Out of Toner

Open the Front Cover.

Then, Replace the XXXX 
Cartridge.

- The toner cartridge has become empty. Replace the 
old toner cartridge with a new one.
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Removing the Toner Cartridge
1 Grasp the grips on both sides of the front cover, and then pull it down to open.

2 Grasp the handle on the toner cartridge that you want to replace as shown in the following illustration, and then 
pull it out.

IMPORTANT: 
• Do not shake the toner cartridge as it may cause toner spills.

Installing a Toner Cartridge
1 Unpack a new toner cartridge of the desired color.

NOTE: 
• Ensure that the color of the new toner cartridge matches that on the handle before replacing it.
• Handle the toner cartridge carefully to avoid spilling of the toner.

2  Shake the new toner cartridge five or six times to distribute the toner evenly.
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3 Insert the toner cartridge into the associated cartridge slot, and then push until it stops.

4 Close the front cover.
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Replacing the Drum Cartridges
This section describes how to replace the drum cartridges.
You need to replace all drum cartridges (yellow, magenta, cyan, and black) at a time.

IMPORTANT: 
• Protect the drums of the drum cartridges against bright light. If the side cover remains open for more than 3 minutes, print 

quality may deteriorate.

This section includes:
• "Removing the Drum Cartridges" on page 437
• "Installing the Drum Cartridges" on page 439

Overview
The printer has drum cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).
When a drum cartridge reaches its usable life-span, the following messages appear on the LCD panel.

Message Remaining Page Yield Printer Status and Action
Order Drum Cartridge 
Kit

12,000 pages The drum cartridge is near the end of its life. Prepare a 
new one.

Drum Cartridge Life 
Over

Open the Right Side 
Door.

Then, replace the Drum 
Cartridge Kit.

- The drum cartridge has reached the end of its life. 
Replace the old drum cartridge with a new one.
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Removing the Drum Cartridges
1 Open the side cover.

2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.

3 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner 
does not spill out.

NOTE: 
• Take care not to drop the waste toner box while you are removing it.
• After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 

your hands.
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4 Place the removed waste toner box on a level surface.

IMPORTANT: 
• Never lay the waste toner box on its side as this may cause its malfunction or toner spills.

5 Slightly pressing down the tab on the drum cartridge that you want to replace, pull it out halfway with one hand.

6 Support the drum cartridge with the other hand from underneath, and then pull it out completely.

7 Repeat the steps 5 and 6 to remove the other three cartridges.
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Installing the Drum Cartridges
1 Unpack a new drum cartridge of the desired color.

2 Remove the orange protective cover from the drum cartridge.

3 Insert the drum cartridge into the associated cartridge slot, and then push until it stops.

4 Repeat the steps 1 to 3 to insert the other three cartridges.

5 Remove the cleaning rod from inside the printer.

6 Remove the cleaning pad by pressing the white tabs between your thumb and index finger.



440 Maintenance

7 Unpack a new cleaning pad.

8 Attach the new cleaning pad to the cleaning rod.

9 Insert the cleaning rod fully into one of the four holes until it clicks into the interior of the printer as illustrated 
below, and then pull it out.

10 Repeat step 9 also on the other three holes. One time insertion is enough for each hole.

11 Return the cleaning rod to its original location.
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12 Reinsert the removed waste toner box.

NOTE: 
• If the waste toner box does not fit into place properly, make sure that the drum cartridges are fully inserted in 

the previous steps.

13 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

14 Close the side cover.
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Replacing the Fusing Unit
This section describes how to replace the fusing unit.

IMPORTANT: 
• Before performing any of the following procedures, read and follow the safety instructions in "Safety Notes" on page 15.

This section includes:
• "Removing the Fusing Unit" on page 443
• "Installing a Fusing Unit" on page 444

Overview
When a fusing unit reaches its usable life-span, the following messages appear on the LCD panel.

Message Remaining Page Yield Printer Status and Action
Replace Fusing Unit 
Soon

5,000 pages The fusing unit is near the end of its life. Prepare a 
new one.

Replace Fusing Unit - The fusing unit has reached the end of its life. Replace 
the old fusing unit with a new one.
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Removing the Fusing Unit
1 Turn off the printer, and wait for 30 minutes.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Push down the latch to open the rear cover.

3 Grasp the grips on both sides of the fusing unit with the lever under the left side grip squeezed, and then pull 
out the unit.
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Installing a Fusing Unit
1 Unpack a new fusing unit.

2 Remove the packing material from the fusing unit.

3 Make sure that the two tabs of the fusing unit align with the grooves on the printer, and then insert it into the 
printer until it clicks.

NOTE: 
• Hold both sides of the fusing unit with your hands.
• Make sure that the fusing unit is firmly set in the slots and cannot be moved easily.

4 Close the rear cover.

5 Reconnect the power cord to the power connector and turn on the printer.
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Replacing the Belt Unit, the 2nd BTR, and the Retard 
Roller

You need to replace three parts (belt unit, 2nd BTR, and retard roller) at a time. Both the 2nd BTR and the retard 
roller for replacement come with a new belt unit.
Fuji Xerox belt unit, 2nd BTR, and retard roller are available only through Fuji Xerox. To order by phone, see also 
"Online Services" on page 485.
It is recommended that you use Fuji Xerox 2nd BTR, belt unit, and retard roller for your printer. Fuji Xerox does not 
provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Fuji 
Xerox.

IMPORTANT: 
• Ensure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on 

the film of the belt unit may reduce print quality.

This section includes:
• "Removing the Belt Unit" on page 446
• "Installing a Belt Unit" on page 449
• "Removing the 2nd BTR" on page 451
• "Installing a 2nd BTR" on page 451
• "Removing the Retard Roller Unit in the Standard 550 Sheet Tray" on page 452
• "Installing a Retard Roller in the Standard 550 Sheet Tray" on page 453

Overview
When a belt unit reaches its usable life-span, the following messages appear on the LCD panel.

Message Remaining Page Yield Printer Status and Action
Replace Transfer Unit 
Soon

5,000 pages The belt unit is near the end of its life. Prepare a new 
one.

Replace Transfer Unit - The belt unit has reached the end of its life. Replace 
the old belt unit with a new one.

Select OK to reset the belt unit counter.
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Removing the Belt Unit
1 Push down the latch to open the rear cover.

2 Open the side cover.

3 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.
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4 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner 
does not spill out.

NOTE: 
• Take care not to drop the waste toner box while you are removing it.
• After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain your hands.

5 Place the removed waste toner box on a level surface.

IMPORTANT: 
• Never lay the waste toner box on its side as this may cause its malfunction or toner spills.

6 Lift the operator panel.
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7 Open the top cover.

8 Put your fingers through the loops on both sides of the belt unit, and then pull it out.

IMPORTANT: 
• If you cannot pull out the unit from the printer, make sure that all of the above procedures are performed properly.

9 At the rear of inside the printer, clean the CTD sensor with a clean dry cotton swab.
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Installing a Belt Unit
1 Unpack a new belt unit.

2 Remove the two orange packing materials first, and then the protective sheet from the belt unit.

3 Make sure that the arrow marks on the belt unit, and the printer face each other, and then insert the unit into the 
printer until it clicks.

4 Close the top cover.

5 Lower the operator panel back in place.
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6 Reinsert the removed waste toner box.

NOTE: 
• If the waste toner box does not fit into place properly, make sure that the belt unit is fully inserted.

7 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

8 Close the side cover.

NOTE: 
• After replacing the belt unit, be sure to initialize its life counter. For details, see "Reset Transfer Unit" on page 325.
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Removing the 2nd BTR
1 Pinching the tabs on both sides of the 2nd BTR, lift it out of the printer.

Installing a 2nd BTR
1 Unpack a new 2nd BTR.

2 Hold the 2nd BTR by its both ends.

3 Make sure that the arrow marks on the 2nd BTR and the printer face each other, and then press down the 2nd 
BTR until it clicks.

4 Close the rear cover.
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Removing the Retard Roller Unit in the Standard 550 Sheet Tray
1 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

NOTE: 
• Ensure that you remove all the paper from the standard 550 sheet tray before removing the retard roller unit.

2 Slightly pressing down the lock lever on the standard 550 sheet tray to the right with one hand, raise the retard 
roller with the other hand.

3 Slide the retard roller to the left to remove it from the standard 550 sheet tray.
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Installing a Retard Roller in the Standard 550 Sheet Tray
1 Slide the two axles of the retard roller into the holes on the standard 550 sheet tray.

2 Press down the retard roller until it snaps.

3 Load paper in the standard 550 sheet tray, and then insert the tray into the printer and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Replacing the Waste Toner Box
IMPORTANT: 
• Before performing any of the following procedures, read and follow the safety instructions in "Safety Notes" on page 15.

Overview
When a waste toner box reaches its usable life-span, the following messages appear on the LCD panel.

Message Remaining Page Yield Printer Status and Action
Order Waste Toner Box 3,000 pages The waste toner box is near the end of its life.  

Prepare a new one.

Waste Toner Box Life 
Over

Open the Right Side 
Door.

Then, replace the 
Waste Toner Box.

- The waste toner box has reached the end of its life. 
Replace the old waste toner box with a new one.
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Removing the Waste Toner Box
1 Open the side cover.

2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.

3 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner 
does not spill out.

NOTE: 
• Take care not to drop the waste toner box while you are removing it.
• After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 

your hands.

4 Insert the used waste toner box into the plastic bag that came with the new waste toner box and seal the bag.
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Installing a Waste Toner Box
1 Unpack a new waste toner box.

2 Insert the waste toner box.

NOTE: 
• If the waste toner box does not fit into place properly, make sure that the belt unit is fully inserted.

3 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

4 Close the side cover.
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Ordering Supplies
This section includes:

• "Consumables" on page 457
• "When to Order Supplies" on page 458
• "Recycling Supplies" on page 458

Certain consumables and routine maintenance items need to be ordered occasionally. Each supply includes 
installation instructions on the box.

Consumables
IMPORTANT: 
• Use of consumables/periodical replacement parts not recommended by Fuji Xerox can impair machine quality and 

performance. Use only consumables/periodical replacement parts recommended by Fuji Xerox.

IMPORTANT: 
• Toner

Reference values are measured based on ISO/IEC19798. Actual replacement cycles depend on printing 
conditions, output contents, paper size and type, and environment.

• Drum
The number of printed pages is a reference value based on A4-size one-sided printing of an average of three 
continuous sheets per print job. The actual number of printable pages depends on the conditions defined 
above, in addition to the number of continuous prints, paper size, paper type, paper feed direction, paper tray 
and output tray settings, monochrome/color auto selection*, other mode selections, the initialization operation 
performed when the printer power is turned on or off, adjustments to maintain print quality, and other operating 
environment conditions. Certain conditions may result in actual values that are half those shown in the table. 
The values presented here are for reference only.

* When [Color] is selected on the printer, certain data may use the color drum even when printing a monochrome page.

• The life of the fusing unit is affected greatly by the length of time the printer is turned on. If you set a longer time until entering 
the energy saver mode, the power on time of the printer is increased, and the fusing unit may need to be replaced sooner. For 
details, contact the Fuji Xerox local representative.

Product Name Product Code Printable number of pages
Toner Cartridge Std (K) CT202018 7,000 pages

Toner Cartridge Std (C) CT202019 5,000 pages

Toner Cartridge Std (M) CT202020 5,000 pages

Toner Cartridge Std (Y) CT202021 5,000 pages

Toner Cartridge Hi (K) CT202033 11,000 pages

Toner Cartridge Hi (C) CT202034 11,000 pages

Toner Cartridge Hi (M) CT202035 11,000 pages

Toner Cartridge Hi (Y) CT202036 11,000 pages

Drum Cartridge kit CT350983 60,000 pages

Fusing Unit (220V) EL500270 100,000 pages

Fusing Unit (110V) EL500269 100,000 pages

100K Maintenance Kit EL500267 100,000 pages

Waste Toner Cartridge EL500268 30,000 pages
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When to Order Supplies
The LCD panel displays a warning when the supply nears its replacement time. Verify that you have replacements 
on hand. It is important to order these supplies when the messages first appear to avoid interruptions to your 
printing. The LCD panel displays an error message when the supply must be replaced.
For details on error message about replacing the toner cartridge, drum cartridge, fusing unit, belt unit, or waste toner 
box, see "Replacing Consumables" on page 432.
To order supplies, contact the Fuji Xerox local representative office or an authorised dealer.

IMPORTANT: 
• This printer is designed to provide the most stable performance and print quality when used with the recommended 

consumables. Not using consumables recommended for this machine degrades the performance and printing quality of the 
printer. You could also incur charges if the machine breaks down. To receive customer support and achieve the optimum 
performance of the printer, be sure to use recommended consumables.

Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 

drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.
• Proper disposal is required for toner cartridges and drums (photoreceptors) no longer needed. Do not open 

toner cartridges and drums (photoreceptors). Return them to your local Fuji Xerox representative.
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Storing Print Media
To avoid potential paper feeding problems and uneven print quality, there are several things you can do:

• To achieve the best possible print quality, store print media in an environment where the temperature is 
approximately 70 °F/21 °C and the relative humidity is 40%.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor.
• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface 

so the edges do not buckle or curl.
• Do not place anything on top of the print media packages.
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables in:

• Temperatures greater than 104 °F/40 °C.
• An environment with extreme changes in humidity or temperature.
• Direct sunlight.
• Dusty places.
• A car for a long period of time.
• An environment where corrosive gases are present.
• A humid environment.
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Managing the Printer
This section includes:

• "Checking or Managing the Printer with CentreWare Internet Services" on page 461
• "Checking Printer Status with SimpleMonitor (Windows Only)" on page 461
• "Checking Printer Status Through E-mail" on page 462

Checking or Managing the Printer with CentreWare 
Internet Services

When the printer is installed in a TCP/IP environment, you can use CentreWare Internet Services to check the 
printer status, the remaining volume of consumables, and the paper loaded in this printer. You can also use 
CentreWare Internet Services to configure printer settings.

NOTE: 
• When using the printer as a local printer, you cannot use CentreWare Internet Services. For details about checking the status 

of a local printer, refer to "Checking Printer Status with SimpleMonitor (Windows Only)" on page 461.

Starting CentreWare Internet Services
Use the following procedure to start CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.
The CentreWare Internet Services screen appears.

• Using Online Help
For details regarding the items that can be set in each CentreWare Internet Services screen, click the Help button to 
display the online Help.

Checking Printer Status with SimpleMonitor (Windows 
Only)

SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the printer status 
when you send a print job. SimpleMonitor can also check the status of the tray and remaining amount of 
consumables, such as the toner cartridge.

Starting SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Select Printer.
If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the Start menu:
The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate SimpleMonitor.
The Select Printer window appears.

2 Click the name of the desired printer from the list.

3 The Status Monitor window appears.
For details about the functions of SimpleMonitor, refer to the online Help.
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Checking Printer Status Through E-mail
When connected in a network environment where sending and receiving of e-mail is possible, the printer can send 
an e-mail report to specified e-mail addresses containing the following information:

• The network settings and the printer status
• The error status which has occurred on the printer

Setting the E-mail Environment
Activate CentreWare Internet Services. On the Properties tab, configure the following settings according to your 
e-mail environment. After configuring the settings on each screen, always click Apply and then turn off/on the printer 
to reboot. For details about each item, refer to the online help for CentreWare Internet Services.

Checking the Printer Status with E-mail
This section describes cautions when sending e-mail to the printer to check the printer status.

• You can specify any title for the e-mail when checking the printer status or changing the printer settings.
• Use the commands described in the next section to create the text of the e-mail.

Item Item to be configured Description
StatusMessenger Recipient's E-mail 

Address
Set the e-mail address to which notices about 
changes in printer status or errors are sent.

Notification Items Set the contents of the notices to send in the e-mail.

Port Status StatusMessenger Select Enabled.

Protocol Settings > 
E-mail

Machine's E-mail 
Address, 

SMTP Server Address, 

SMTP Server Port 
Number, 

E-mail Send 
Authentication, 

Login Name, 

Password, 

SMTP Server Connection 
Status, 

POP3 Server Address, 

POP3 Server Port 
Number, 

Login Name, 

Password, 

POP3 Server Check 
Interval, 

APOP Settings, 

POP3 Server Connection 
Status

Select appropriate settings for sending and 
receiving e-mail.

Permitted E-mail Address When setting the permission for checking 
information and changing the settings for an e-mail 
address, enter the e-mail address that is permitted 
to receive the e-mail. If no address is entered here, 
the printer receives e-mails from all users.

StatusMessenger 
Password

When setting the password for access to the printer 
(both read only and read/write), enter the password 
in the Password field.
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• Commands That Can Be Used in E-mail Text
Use each command according to the following rules:

• Prefix all commands with “#”, and specify the #Password command at the top of the e-mail.
• Command lines without “#” are ignored.
• Write one command on each line and separate each command and parameter with a space or a tab.

When the same command is written two or more times in one e-mail, the second and subsequent commands are 
ignored.

• Example of Commands
• When the read only password is “ronly”, and to check the printer status:

#Password ronly

#Status

#NetworkInfo

Command Parameter Description
#Password Password Use this command at the top of the e-mail when a 

password for read only is set. You can omit this 
command when the password is not set.

#NetworkInfo Set this when you want to check information on the 
network settings list.

#Status Set this when you want to check the printer status.
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Conserving Supplies
You can change several settings in your print driver to conserve toner cartridge and paper.
The following descriptions use the PCL 6 driver as an example.

Supply Setting Function
Toner cartridge Toner Saver in the Image 

Options tab
This check box allows the users to select a print mode 
that uses less toner. The image quality will be lower 
when this feature is used.

Print media Pages Per Sheet (N-Up) 
in the Layout/Watermark 
tab

The printer prints two or more pages on one side of a 
sheet. Values for Pages Per Sheet (N-Up) are 1-Up, 
2-Up, 4-Up, 8-Up, 16-Up, 32-Up. Combined with the 
duplex setting, Pages Per Sheet (N-Up) allows you to 
print up to 64 pages on one sheet of paper. (32 images 
on the front and 32 on the back)
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Checking Page Counts
The total number of printed pages can be checked on the operator panel. Four meters are available: Meter1, 
Meter2, Meter3, and Meter4.
The Billing Meters counts the number of pages printed properly. Single side color print (including Pages Per 
Sheet (N-Up)) is counted as one job, and 2-sided print (including Pages Per Sheet (N-Up)) is counted as two. During 
2-sided printing, if an error occurs after one side is printed properly, it is counted as one.
When printing color data, which has been converted by using ICC profile on an application, with the Color (Auto) 
setting, the data is printed by color even if it seems to be black and white data on the monitor. In that case, Meter1 
and Meter4 are increased.
When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of the 
application. In this case, the blank page is counted as one page.
For information about the individual meter, see "Billing Meters" on page 292.
Use the following procedure to check a meter:

1 Press the  (System) button.

2 Select Billing Meters.

3 Check the number of pages.
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Moving the Printer
This section describes how to move the printer.

NOTE: 
• If the optional 550 sheet feeder has been installed, uninstall the optional 550 sheet feeder before moving the printer. If the 

optional 550 sheet feeder is not fixed securely to the printer, it may fall to the ground and cause injuries. For details on how to 
uninstall the optional 550 sheet feeder, see "Removing the Optional 550 Sheet Feeder (without the Cabinet)" on page 475.

1 Turn off the printer and disconnect the power cord, interface cable, and any other cables.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Remove any paper in the document output tray and slide the document stopper inside the DADF.

3 Remove any paper in the output tray and return the output tray extension.
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4 Lift the printer and move it gently.

IMPORTANT: 
• When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18.

NOTE: 
• If you move the printer over a long distance, remove the toner cartridges from the printer to prevent toner 

from spilling, and pack the printer inside a box.

5 Adjust the color registration before using your printer.

See also: 
• "Adjusting Color Registration" on page 398
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Removing Options
If the printer location needs to be changed or the printer and print media handling options need to be shipped to a 
new location, all print media handling options must be removed from the printer. For shipping, pack the printer and 
print media handling options securely to avoid damage.
This section includes:

• "Removing the Optional 512MB Memory" on page 468
• "Removing the Optional 550 Sheet Feeder and the Cabinet" on page 471
• "Removing the Optional 550 Sheet Feeder (without the Cabinet)" on page 475
• "Removing the Optional Wireless Printer Adapter" on page 477
• "Removing the Optional Hard Disk Unit" on page 480

Removing the Optional 512MB Memory
IMPORTANT: 
• When you remove the optional 512MB memory, be sure to turn off the printer, unplug the power code, and disconnect all 

cables from the rear of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 
• Loosen the screw. You do not need to remove the screw.
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3 Slide the control board cover towards the rear of the printer.

4 Open the control board cover completely.

5 Push the clips on both sides of the slot outward to raise the optional 512MB memory up.

6 Hold the optional 512MB memory and pull it straight out.
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7 Close the control board cover, and slide it towards the front of the printer.

8 Turn the screw clockwise.

9 Turn on the printer.
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Removing the Optional 550 Sheet Feeder and the Cabinet
IMPORTANT: 
• If you remove the optional 550 sheet feeder and the cabinet, be sure to turn off the printer, unplug the power cord, and 

disconnect all cables from the rear of the printer before removing the feeder and the cabinet.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Disconnect the power cord from the power source.

3 Unhook the power cord from the cable hook.

4 Disconnect the power cord and all other cables from the rear of the printer.
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5 Loosen the two screws holding the cable hook, and remove the hook from the cabinet.

6 Pull the standard 550 sheet tray out of the printer about 200 mm. Hold the standard 550 sheet tray with both 
hands, and remove it from the printer.

7 Remove the two screws joining the printer and the optional 550 sheet feeder by unscrewing them with a coin or 
similar object.

NOTE: 
• The screw is located in 216 mm recess from the front of the printer.
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8 Gently lift the printer off the optional 550 sheet feeder, and place it on a level surface.

IMPORTANT: 
• When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18

9 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or inside of the printer.
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10 Pull the tray out of the optional 550 sheet feeder about 200 mm. Hold the tray with both hands, and remove it 
from the feeder.

11 Remove the two screws joining the optional 550 sheet feeder and the cabinet by unscrewing them with a coin 
or similar object.

12 Gently lift the optional 550 sheet feeder off the cabinet, and place it on a level surface.

13 Insert the tray into the optional 550 sheet feeder, and push until it stops.
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Removing the Optional 550 Sheet Feeder (without the 
Cabinet)

IMPORTANT: 
• When you remove the optional 550 sheet feeder (Tray2), be sure to turn off the printer, unplug the power code, and 

disconnect all cables from the back of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Disconnect the power cord from the power connector on the rear of the printer.

3 Pull the standard 550 sheet tray out of the printer about 200 mm. Hold the standard 550 sheet tray with both 
hands, and remove it from the printer.
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4 Remove the two screws joining the printer and the optional 550 sheet feeder by unscrewing them with a coin or 
similar object.

NOTE: 
• The screw hole is located in 216 mm recess from the front of the printer.

5 Gently lift the printer off the optional 550 sheet feeder, and place it on a level surface.

IMPORTANT: 
• When lifting the machine, make sure to follow the precautions stated in "Machine Installation" on page 18

6 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 
• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

7 Reconnect all cables into the rear of the printer and turn on the printer.
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Removing the Optional Wireless Printer Adapter
IMPORTANT: 
• If you remove the optional wireless printer adapter, be sure to turn off the printer, unplug the power cord, and disconnect all 

cables from the rear of the printer before removing the adapter.

1 Turn off the printer.

IMPORTANT: 
• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 

is turned off.

2 Disconnect all cables from the rear of the printer.

3 Turn the screw on the control board cover counterclockwise.
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4 Slide the control board cover towards the rear of the printer.

5 Open the control board cover completely.

6 Remove the wireless printer adapter from the printer by releasing the adapter's hook while pushing the wireless 
printer adapter towards the front of the printer.
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7 Close the control board cover, and then slide it towards the front of the printer.

8 Turn the screw clockwise.

9 Turn on the printer.
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Removing the Optional Hard Disk Unit
IMPORTANT: 
• If you remove the optional hard disk unit, be sure to turn off the printer, unplug the power cord, and disconnect all cables from 

the rear of the printer before removing the hard disk unit.

1 Turn off the printer.

2 Disconnect the power cord from the power source.

3 Turn the screw on the control board counterclockwise.
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4 Slide the control board cover towards the rear of the printer.

5 Open the control board cover completely.

6 Remove the hard disk unit from the printer by releasing the hook of hard disk unit.
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7 Close the control board cover, and then slide it towards the front of the printer.

8 Turn the screw clockwise.

9 Turn on the printer.
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Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 484
• "Online Services" on page 485
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Technical Support
Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product diagnostics, 
information contained on the Web, and email support. If unsuccessful, to obtain service under product warranty the 
Customer must notify Fuji Xerox Telephone Support or its authorized service representative of the defect before the 
expiration of the warranty period. Customer will provide appropriate assistance to Telephone Support personnel to 
resolve issues, such as restoration of the operating system, software program and drivers to their default 
configuration and settings, verification of functionality of Fuji Xerox supplied products, replacement of customer 
replaceable units, clearing paper misfeeds and cleaning the unit and other prescribed routine and preventative 
maintenance.
If the Customer’s product contains features that enable Fuji Xerox or its authorised service representative to 
diagnose and repair problems with the product remotely, Fuji Xerox may request that the Customer allow such 
remote access to the product.
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Online Services
You can find detail Product and Consumable warranty information and activate your warranty by registering your 
details on our website at http://www.fujixerox.com/support/docuprint/
Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your printer 
problems. It is an easy-to-use, searchable online help. To find out more, please visit our online support at 
http://www.fujixerox.com/support/docuprint/

http://www.fujixerox.com/support/docuprint/
http://www.fujixerox.com/support/docuprint/
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